Technical Support
For technical support, call (603) 448-3841 between 9:00 AM and 6:00 PM EST or send an e-mail message to support@centricsoftware.com.

Copyright
Copyright © 2005 – 2009 by Centric Software, Inc.

All rights reserved.

Under the copyright laws, neither the documentation nor the software may be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without the prior written consent of Centric Software, Inc, except in the manner described in the documentation.

Centric Software, Inc.
655 Campbell Technology Parkway, Suite 200
Campbell, CA 95008
USA
Printed in the United States of America

Trademarks
Centric Software ®, Product Intelligence™, Centric Project™, Centric Charter™, Centric Portfolio™, Centric Process™, Centric Resource™, Centric InSight™, Centric MultiSight™, Centric Connection™, Centric Decision Center Web™ are trademarks or registered trademarks of Centric Software, Inc.

Microsoft, Internet Explorer and Outlook are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Other product or company names mentioned herein may be trademarks of their respective owners.
# Contents

**Introduction** ........................................................................................................... 11  
What is Centric Project? .............................................................................................. 12  
Centric Project ............................................................................................................. 12  
Centric Resource ......................................................................................................... 13  
Centric Process ............................................................................................................ 13  
Cross-Project Analytics ............................................................................................. 13  
Centric Portfolio .......................................................................................................... 14  
Portfolio Planning ....................................................................................................... 14  
Centric Charter ............................................................................................................ 14  
Using this guide ........................................................................................................... 15  
Getting help ................................................................................................................ 16  

**Project Workspace User Guide** .............................................................................. 17  

**Welcome to the project workspace** ...................................................................... 19  
What is a project workspace? ...................................................................................... 20  
What are Information Items? ...................................................................................... 20  
What are Project Elements? ...................................................................................... 20  
What are Tracked Activities? ..................................................................................... 21  
What are comments and markups? .......................................................................... 22  
What are Parameters? ................................................................................................. 23  
Understanding project workspace concepts ............................................................ 24  
Understanding your project permissions .................................................................. 26  
Permissions for standard two-frame and three-frame tabs ...................................... 26  
Permissions for the Parameters page ....................................................................... 27  
Streamlined Notifications ......................................................................................... 27  
Using this guide ........................................................................................................... 28  

**Setting up your browser and e-mail** ..................................................................... 29  
Overview ..................................................................................................................... 30  
Supported browsers .................................................................................................... 31  
To check your browser's version .............................................................................. 31  
Configuring your browser and e-mail ..................................................................... 32  
Configuring Internet Explorer .................................................................................. 32  
Configuring Microsoft Outlook to send project e-mail .......................................... 33  
Installing User Tools ................................................................................................. 34  
To install User Tools .................................................................................................. 35  

**Navigating in your project workspace** .................................................................. 37  
Logging in to your project workspace ...................................................................... 38  
To log in to your project workspace for the first time .............................................. 38  

---

Introduction  3
To log in to your project workspace after the first time ................................................ 39
Accessing your project from a direct URL .................................................................. 40
Requesting project login information ......................................................................... 40
The My Dashboard window ......................................................................................... 42
Exiting from projects or the ProjectArea ..................................................................... 46
To exit from a project by closing the browser window ................................................ 46
To exit from a project and return to My Dashboard .................................................... 46
To log out from the ProjectArea .................................................................................. 46
The project workspace window .................................................................................... 47
Project toolbar ............................................................................................................. 48
To navigate to specific information in the project workspace ..................................... 49

Using your project workspace .................................................................................... 50
Setting your user preferences ...................................................................................... 51
To set user preferences ............................................................................................... 51
Viewing or editing your user information ..................................................................... 52
To view or edit your user information ......................................................................... 52
Creating your Favorite Projects list ........................................................................... 54
To add a project to your Favorite Projects list ........................................................... 54
To add multiple projects to your Favorite Projects list .............................................. 54
To view your Favorite Projects list ................................................................................ 54
To view all of your projects .......................................................................................... 54
To remove projects from your Favorite Projects list .................................................. 55
Information Item User Fields ....................................................................................... 56
Viewing Information Items ......................................................................................... 58
Opening Information Items ......................................................................................... 59
Publishing Information Items ........................................................................................ 61
Publishing by dragging and dropping .......................................................................... 61
Publishing with Project menu bar commands ............................................................ 63
Viewing and adding comments to Information Items .................................................. 65
To view an Information Item’s comments .................................................................. 65
To add comments to an Information Item .................................................................... 65
Searching for project information ................................................................................ 67
To perform a basic search for project information ...................................................... 67
Creating, viewing, and responding to Tracked Activities ............................................. 68
Creating Activities ........................................................................................................ 68
To open an Activity for viewing ................................................................................... 70
Updating or responding to Activities ......................................................................... 71
Using the project calendar ............................................................................................ 75
To view the project calendar ..................................................................................... 77
To navigate in the monthly view .................................................................................. 77
To navigate in the daily view ....................................................................................... 78
Using Connector hub ..................................................................................................... 79
Overview of Connector Hub ....................................................................................... 79

4 Centric Project Platform User Guide
Using Centric Portfolio ................................................................. 187

Creating portfolios........................................................................ 188
Business Units and portfolios......................................................... 188
Task 1: Create Business Units......................................................... 189
Task 2: Create ProjectArea Metrics.............................................. 189
Task 3: Create a portfolio.............................................................. 190
Task 4: Select projects for the portfolio........................................ 190
Task 5: Create Strategic Objectives for the portfolio.................... 191
Task 6: Select Strategic Metrics for the portfolio......................... 192
Task 7: Give users access to the portfolio..................................... 193
Creating portfolio reports............................................................ 194
Task 1: Add Metrics to your project processes............................ 194
Task 2: Define portfolio reports................................................. 194
To define a private portfolio report............................................. 195
Viewing portfolio reports.......................................................... 197
To view a portfolio report.......................................................... 197
To print, download, filter, or open a report in a different format........ 197

Centric Portfolio™ User Guide ..................................................... 163

Welcome to Centric Portfolio....................................................... 165
What is Centric Portfolio?........................................................... 166
What is Portfolio Planning?......................................................... 166
What is a product portfolio?....................................................... 167
Portfolio report examples.......................................................... 168
The benefits of using Centric Portfolio........................................ 173
The benefits of using Portfolio Planning with Centric Portfolio...... 174
Who uses Centric Portfolio?....................................................... 175
System requirements............................................................... 176
Using this guide......................................................................... 177

Designing your portfolio reports............................................... 179
Planning your portfolio reports.................................................. 180
Portfolio report design considerations......................................... 180
The components of a Centric Portfolio portfolio report................ 182
Report types and styles............................................................. 182
Report variables....................................................................... 182
Report filters............................................................................. 185
Crystal Reports......................................................................... 186

Introduction 7
Welcome to Centric Charter

Using Centric Charter

Centric Charter™ User Guide
To enable a charter template to make it available to projects ........................................ 239
To disable a charter template ............................................................................................ 239
Adding a charter to your project ...................................................................................... 240
Viewing a project charter ................................................................................................. 243
Viewing different charter versions .................................................................................. 245
Printing a project charter ................................................................................................. 246

Appendix A: Mapped data capabilities and restrictions ..................................................... 247

Appendix B: Excel compatibility ........................................................................................ 249

Appendix C: Charter cell properties and formatting ......................................................... 251

Appendix D: Charter built-in functions ............................................................................. 253
Mathematical functions ................................................................................................. 254
Statistical functions ....................................................................................................... 256
Conditional statistical functions .................................................................................... 259
String functions .............................................................................................................. 260
Logic functions ............................................................................................................... 262
Financial functions ........................................................................................................ 263
Date and time functions .................................................................................................. 266
Miscellaneous functions ................................................................................................. 268

Glossary of terms ............................................................................................................ 269

Glossary of terms ............................................................................................................ 271
Centric Project Server ...................................................................................................... 271
Centric Project Server Administration ............................................................................ 271
Activity ............................................................................................................................. 271
Assistant .......................................................................................................................... 271
Authentication ................................................................................................................ 271
Author ............................................................................................................................. 271
Browser ............................................................................................................................ 272
Business Unit .................................................................................................................. 272
Charter ............................................................................................................................. 272
Client computer .............................................................................................................. 272
Decision Criterion .......................................................................................................... 272
Decision Maker .............................................................................................................. 272
Decision Point ................................................................................................................ 272
Definition ....................................................................................................................... 273
Deliverable ....................................................................................................................... 273
Demand (resource) ....................................................................................................... 273
Host ................................................................................................................................. 273
Information Item ............................................................................................................ 273
Linked process ................................................................................................................. 274
<table>
<thead>
<tr>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapped information</td>
</tr>
<tr>
<td>Metric</td>
</tr>
<tr>
<td>Network</td>
</tr>
<tr>
<td>Ownership</td>
</tr>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>Portfolio</td>
</tr>
<tr>
<td>Project Administration</td>
</tr>
<tr>
<td>Project category</td>
</tr>
<tr>
<td>Project Element</td>
</tr>
<tr>
<td>Project workspace</td>
</tr>
<tr>
<td>ProjectArea</td>
</tr>
<tr>
<td>ProjectArea Administration</td>
</tr>
<tr>
<td>Publisher</td>
</tr>
<tr>
<td>Publishing</td>
</tr>
<tr>
<td>Resource</td>
</tr>
<tr>
<td>Resource category</td>
</tr>
<tr>
<td>Resource summary</td>
</tr>
<tr>
<td>Resource type</td>
</tr>
<tr>
<td>Resource unit</td>
</tr>
<tr>
<td>Reviewer</td>
</tr>
<tr>
<td>Server computer</td>
</tr>
<tr>
<td>Snapshot</td>
</tr>
<tr>
<td>Standard planning unit</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Strategic Metric</td>
</tr>
<tr>
<td>Strategic Objective</td>
</tr>
<tr>
<td>Subscribing</td>
</tr>
<tr>
<td>Supply (resource)</td>
</tr>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>Template (Activity, process, charter)</td>
</tr>
<tr>
<td>Tracked Activity (Activity)</td>
</tr>
<tr>
<td>Transition</td>
</tr>
<tr>
<td>User Field</td>
</tr>
<tr>
<td>Viewer</td>
</tr>
<tr>
<td>Work Period</td>
</tr>
<tr>
<td>Web conference</td>
</tr>
<tr>
<td>WebEx</td>
</tr>
</tbody>
</table>

**Index**

281

**Index**

283
Introduction

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is Centric Project?</td>
<td>12</td>
</tr>
<tr>
<td>Using this guide</td>
<td>15</td>
</tr>
<tr>
<td>Getting help</td>
<td>16</td>
</tr>
</tbody>
</table>
What is Centric Project?

Centric Project™ is an integrated business solution suite that addresses the challenges of project selection and project execution for product development. Centric Project share a three-tiered architecture based on the Centric Project™ Server platform that supports the distinct needs of business executives, project and product managers, and project team members. The following figure illustrates the three tiers of the Centric Project and shows how the individual solution offerings fit in this hierarchy.

An overview of each module is provided below, but the key to their collective power is the tight module-to-module integration provided by the Centric Project Server platform. Information created by project team members is instantly available to project managers and executives for analysis and decision-making. At the same time, work is easily accomplished with the tools and software most companies already employ. Native support is provided for Microsoft® Office documents, CAD applications, and many other standard document formats. The Centric Project suite is designed to support existing work-methods rather than impose new ones. Finally, Centric Project Server is a robust and scalable environment that emphasizes flexibility, ease of deployment, and ease of use.

Centric Project

Centric Project™ is the collaboration tool at the heart of Centric Project. Centric Project supports the quick creation of secure, access-controlled project workspaces, where project team members come together to work, regardless of their physical locations, to publish and share information, to be notified when information changes, and to comment and mark up the work of others. Centric Project collaboration capabilities are seamlessly integrated with standard business tools such as Microsoft Office and Outlook®, as well as with a variety of engineering tools such as AutoCAD. The Advanced 3D option adds 3D...
viewing and markup for major CAD formats such as Pro/ENGINEER®, SolidWorks®, and CATIA®.

Centric Project includes integrated Web-based tools to configure workspace layouts; to configure processes that support team activities such as RFIs, approvals, and assignments; and to establish team access privileges.

**Centric Resource**

Centric Resource™ is a resource planning and decision support tool that helps project managers, program managers, and executives make better decisions regarding the allocation of resources across a portfolio of projects. Centric Resource provides a set of analysis tools that gives you insight into the supply and demand of scarce resources, measured in both quantity and cost, and in terms of supply and demand time frames and locations.

**Centric Process**

Centric Process™ automates and formalizes an organization’s product introduction process. By guiding team members towards providing key information from development, marketing, and manufacturing activities, Centric Process aligns their efforts with company process standards and shortens product introduction cycles.

With Centric Process, companies define a series of Work Periods (phases) and Decision Points (reviews) within templates following their internal process and terminology. These templates ensure that a common language and company’s best practice approaches are applied consistently to each project. In addition, Centric Process allows innovative team leaders to leverage their own unique style in delivering a higher quality product ahead of schedule.

**Cross-Project Analytics**

Cross-Project Analytics™ (CPA) is an option module that can be added to Centric Project or Centric Process. Its functionality is included with Centric Portfolio. CPA gives project managers and other project team members to the ability to analyze Tracked Activities across multiple projects. With CPA, team leaders can quickly analyze open issues across all projects and, in turn, prioritize and resolve those issues before they affect the schedule. CPA also helps team leaders more efficiently cope with the sheer number of ad-hoc activities that characterize projects.
Centric Portfolio

Centric Portfolio™ gives executives the tools they need to tackle one of their most pressing issues: timely access to project information to support managing a complex, constantly changing product portfolio.

With key information – such as the cost of projects under development, projected profitability, and the likelihood of customer acceptance – executives can effectively manage the growth and risk of their entire product portfolio. Centric Portfolio doesn’t just accelerate the rate of product introduction; it ensures that the right products are quickly brought to market by allowing executives to make well-informed decisions based on real time, project-driven data.

With Centric Portfolio, executives are able to manage the product portfolio to ensure the projects with the highest value are receiving human and capital resource priority.

Portfolio Planning

Portfolio Planning™ extends the capabilities of Centric Portfolio by including the ability to perform advanced strategic analysis based on portfolio objectives. Portfolio Planning gives you the tools to understand the alignment of each project with regard to portfolio strategies.

Centric Charter

Centric Charter™ is a software-based project charter, designed to support your entire project and product lifecycle from initial proposal through product release or project completion. Centric Charter helps you make better decisions in initial project selection, and then do a better job executing projects against those objectives. Centric Charter is based on a spreadsheet that supports formulas, easy charter design, and integration of live project data. Centric Charter supports standardization of the project proposal process through the use of charter templates.
Using this guide

The *Centric Project Platform User Guide* is divided into the following sections:

*Project Workspace User Guide* introduces you to project workspace concepts, including project permissions, setting up your browser and e-mail to use a project, and logging in to and navigating in your project. The *Project Workspace User Guide* also includes a chapter on using the basic project functions, such as setting user preferences, viewing and publishing Information Items, working with Tracked Activities, and using the project calendar.

*Centric Process User Guide* describes how to use the Centric Process module to organize and manage a gated process in your project workspace. The guide covers the benefits, concepts, and requirements of Centric Process. It includes guidelines for designing your gated process, and gives step-by-step procedures for creating process templates and running a process in your project.

*Centric Resource User Guide* provides an overview to using the Centric Resource module. It includes information about analyzing resources, configuring your resource standards, creating resources, and defining demand and supply information for your projects.

*Centric Portfolio User Guide* explains how to use Centric Portfolio to design and generate portfolio reports. The guide includes an introduction to the benefits and requirements for Centric Portfolio, information on planning your portfolio reports, and procedures for creating and viewing portfolio reports.

*Centric Charter User Guide* explains how to use the Centric Charter module to create, maintain, and manage project charters. The guide begins with an overview of the benefits of using Centric Charter, key Centric Charter concepts, and required charter user permissions levels. It also includes instructions for creating and editing charter templates, adding a charter to a project, and viewing a charter. The guide also includes several appendixes with detailed information about charter design functions.

The *Glossary* provides definitions of many of the terms used in this guide.
Getting help

Complete project workspace and application module documentation is contained in the Project Workspace Help and ProjectArea Administration Help. Use any of these methods to view the Help:

- Click a Help link on the ProjectArea Login page
- Choose a Help topic from the Help menu in My Dashboard or in the project workspace window
- Click the button in the My Dashboard or Project toolbar
- Click a Help button in project workspace windows and dialog boxes

If you have any questions about using Centric Project that are not answered in the documentation, contact Centric Software, Inc Technical Support at the following phone number or e-mail address:

- Phone: (603) 448-3841 – Calls are accepted between 9:00 AM and 6:00 PM EST
- E-mail: support@centricsoftware.com
Project Workspace User Guide
Welcome to the project workspace

<table>
<thead>
<tr>
<th>In this chapter</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>What is a project workspace?</td>
<td>20</td>
</tr>
<tr>
<td>Understanding project workspace concepts</td>
<td>24</td>
</tr>
<tr>
<td>Understanding your project permissions</td>
<td>26</td>
</tr>
<tr>
<td>Using this guide</td>
<td>28</td>
</tr>
</tbody>
</table>
What is a project workspace?

A Centric Project™ project workspace gives project users access to all project-related information in a single place. The project workspace centralizes project information, provides structure for managing that information, and allows users to easily share that information with other team members, both inside and outside your organization. In the project workspace, project users can view documents, add comments and markups to documents, send e-mail communications to team members, and track progress on project activities.

In a project workspace, the data that you view and maintain are Information Items (files), Tracked Activities (Activities), comments, markups, and Parameters. Each of these is described below.

What are Information Items?

Information Items are the files and information that you publish, view, and maintain with your Centric Project project workspace. Information Items can be documents, links to web pages, CAD drawings, pictures, video files, sound files, or any other data files that are published to the project workspace.

What are Project Elements?

You can think of a Project Element as a container for Information Items. Each Information Item published to the project workspace is associated with a Project Element in the workspace. You use Project Elements to help you organize, structure, and navigate to Information Items.

For example, a project workspace for a construction project might contain a Project Element for each building in the project. A Project Element can contain Information Items (files), and it can contain other Project Elements. This allows you to create a hierarchy of information that makes sense to your project users. In the construction project example, each building Project Element might contain a Project Element for each floor of the building. Within those Project Elements might be specific Information Items (documents and drawings) that describe the design of each floor.

In the project workspace, Project Elements appear as buttons in a standard tab’s Outline frame. This outline allows you to easily see the hierarchical structure of the information on the tab and allows you to navigate to the specific information that you want to view. If you are
viewing a three-frame standard tab, Project Elements also appear as buttons, graphics, and links in the tab’s Graphic frame.

**What are Tracked Activities?**

Tracked Activities (also called Activities) are customized online forms that allow project users to request and communicate information about a project. For example, your project might use Activities to communicate the following information:

- Requests for information (RFIs)
- Engineering change orders (ECOs)
- Submittals
- Memos
- Change orders
- Action items
- Assignments
- Approvals
- Purchase orders
- Polls or surveys
- Distribution

You can use Activities to communicate information about your project to all other project users. You can also use Activities to define and enforce a formal process for completing a particular task or project. For example, if you are working on a project that requires specific information to be routed to certain project users in a pre-defined order, you can create an Approval Activity to define the approval steps and associated project users through which the information must pass (and be approved) in order to complete the process.

The My Activities tab in My Dashboard shows you the Activities that you are involved with, either as the creator (originator) or a recipient. The At-A-Glance tab in My Dashboard also shows your Activities that have due dates and that are due to in the date range you select. You have access to your Activities via My Dashboard even if you do not have access to any project workspaces.

In addition, if you have access to any Activity Logs in a project workspace, you can see overview information about each Activity that has been sent for each type, including the names of the participants, its current state, when it was submitted, and when it is due.
If you have access to the Project Reports page, you can see the Project Statistics report, which gives statistical information about the Activities for which you can view Logs. Project users with permission to create new project reports can create custom reports based on Activity data for the current project.

Activities differ from ordinary e-mail in several important ways:

- They are tracked within the project workspace rather than through a separate e-mail application (project users also receive e-mail notification about Activities).
- Since Activities are part of a project workspace, they stay with and relate directly to the project data and are archived along with project data.
- You can create links between Activities and other project information. For example, you can link Information Items or Project Elements to Activities and you can link one Activity to another.
- Activities appear in My Dashboard so that you can see all project-related tasks and messages in one location.
- If you have access, you can view the status and other information about Activities on the Dashboard tab’s Activity log pages and on the Project Reports page.

Your project’s Author creates Activity types for your project. When creating a new Activity type, the Author decides what information is included in each Activity, which information project users are required to enter for the Activity, and which project users can participate in the Activity.

What are comments and markups?

A comment is text that is attached to an Information Item or Parameter. You enter and view comments in a separate Comment window. You can search the project workspace for text contained in an Information Item comment.

A markup is a type of comment that is made directly on a copy of an Information Item. Markups can contain both graphics and text. You can draw various shapes as well as add text that is overlaid on an image of the item. You cannot perform a search on text contained in a markup.

If you have Reviewer, Publisher, or Editor access to a tab, you can view and add comments and markups to Information Items on that tab. If you have Review or Publish access to the Parameters page, you can view and add comments to Parameters. If you are a project Author, you
Welcome to the project workspace

Can view and add comments for all Information Items and Parameters in the project workspace.

**What are Parameters?**

A project Parameter is any piece of data that needs to be shared by members of a project. It can be a number, a dollar amount, a date, or a piece of text. If it is a number, you can specify a unit, such as pounds, feet, or liters.

For example, you can use Parameters to communicate the following information to project team members:

- The most recent price for a part
- The earliest possible date for delivery of a part
- The maximum building height
- The current labor rate for a type of service

If you have access to the Parameters page on the Dashboard tab, you can view Parameters and subscribe to the Parameters page or to specific Parameters to be notified of changes. Project users with the proper access can also add comments to Parameters and publish or modify Parameters.

**Note:** Parameters stored with a project are displayed for your information only. Centric Project does not perform any calculations with Parameter values or use the Parameter data in any other way.
Understanding project workspace concepts

There are three important concepts to understand about how information is used and shared on project workspaces:

- Publishing information
- Subscribing to project information
- Ownership of information

Publishing information

When you add content to the project workspace, you publish it. This published content is available to all team members. Project users can view, download, markup, and comment on it using a browser (given the appropriate level of access to the tab on which the information is published).

Subscribing to project information

Certain project information is important to specific project users. To make sure that you are notified when information you care about is changed, you can subscribe to the information. You can subscribe to Project Elements, Information Items, the Parameters page, and Parameters.

When you subscribe to a Project Element or the Parameters page, you are notified when new information is published to that area and you are automatically subscribed to that new information. When you subscribe to an Information Item or Parameter, you are notified if any changes are made to the item or if it is deleted.

Note: Your project Author can also subscribe you to project information, either by subscribing you as an individual or by subscribing a group to which you belong. You can unsubscribe from any information that the Author subscribes you to.

You can subscribe to one area at a time, or you can use the Subscription Map dialog box to view all your subscriptions and to make changes to several subscriptions at once. The Subscription Map also allows you to select to subscribe (or unsubscribe) to all sub Elements under a Project Element and all of their Information Items.

You can also send an e-mail message to all users who are subscribed to a particular piece of project information so that you can easily communicate about the project information.
Ownership of information

When you own information in a project workspace, you can perform maintenance tasks on the information that other project users cannot. For example, if you own an Information Item, you can republish it, edit its properties (display name and description), remove it, and move it to a new location. You can also transfer the ownership to a user or user group. If the user group has publishing rights, all the members of the group have publishing rights.

You become an owner of information if you create or publish the information to the project workspace. You can also become an owner of information if the previous owner transfers ownership to you. For example, the project user who added a Parameter can transfer that Parameter to you so that you can maintain it in the future.

Notes: All existing references to the All Tab Publishers pseudo-group are retired in Centric Project 10.8 and replaced with a project specific user group called ### ATPReplacement ###. This group is populated with anyone having an Author privilege in the project.

All documents currently assigned to All Tab Publishers have been transferred to ### ATPReplacement ###. Only one group is created per project. We recommend the Project Author to review the contents of this project user group and rename it appropriately.
Understanding your project permissions

Project permissions determine which project workspace features and tabs are available to you for the current project. Depending on your needs and your role in the project, you may have no access to some tabs, view-only access to information on other tabs, and full publishing access to other tabs.

Your project’s Author determines your access levels for the project workspace. The project Author sets permissions for each tab in the project and each feature on the Dashboard tab (if available in your project).

For two-frame and three-frame standard tabs and for the Parameters page on the Dashboard tab, your current permission level appears in the upper-right corner of the tab.

Each of the possible permission levels you might see displayed is described below.

Note: If you do not have access to a tab, you cannot navigate to the tab. If you have been given access to a project but have not been given access to any of its tabs, you can still be included in project Activities and meetings and can view your project-information in the My Dashboard window.

Permissions for standard two-frame and three-frame tabs

- **Viewer** – As a Viewer, you can view or download the current version of any Information Item on the tab. You can also subscribe to Project Elements on the tab.

- **Reviewer** – As a Reviewer, you can view or download the current or previous versions of Information Items on the tab, and you can subscribe to Project Elements on the tab. You can also view and add comments and markups to Information Items on the tab.

- **Publisher** – As a Publisher, you can view or download the current or previous versions of Information Items on the tab, you can subscribe to Project Elements on the tab, and you can view and add comments and markups to Information Items on the tab. You can also add new file or URL Information Items to the tab and then modify those Information Items that you publish and own.

- **Editor** – As an Editor, you have access to all project workspace features and information on this tab. You also have permission to add, delete, and rename Project Elements on this tab. You can also perform owner functions (for example, republish, transfer, or edit properties) for all Information Items published on the tab.
for which you are an Editor contains a Structured Data Publishing Project Element, you can publish structured data (for example, Microsoft® Project schedules and SolidWorks assembly files) to the tab.

- **Author** – As an Author, you have access to all project workspace features and information, as well as permission to add and delete projects tabs and Project Elements throughout the project workspace and the ability to publish structured data to any Structured Data Project Element in the workspace.

**Permissions for the Parameters page**

- **Viewer** – As a Viewer, you can view the current version of any Parameter. You can also subscribe to the Parameters page or to individual Parameters on the page.

- **Reviewer** – As a Reviewer, you can view the current or previous versions of any Parameter, and you can subscribe to the Parameters page or to individual Parameters on the page. You can also view and add comments for Parameters.

- **Publisher** – As a Publisher, you can view Parameters, you can subscribe to the Parameters page or to individual Parameters on the page, and you can view and add comments for Parameters. You can also add new Parameters to the page and then modify Parameters that you publish and own.

- **Author** – As an Author, you have access to all project workspace features and information, as well as permission to add and remove projects tabs and Project Elements throughout the project workspace.

**Streamlined Notifications**

As a Project Author you can control how notifications are sent to the relevant people in your project. You can now configure a setting on the project as to whether notifications are to be sent whenever an end user updates a Tracked Activity or changes/publishes an Information Item or not. You can also configure whether each end user will be faced with the decision to send the notification or will it be sent automatically.
Using this guide

The Project Workspace User Guide includes the following chapters:

**Welcome to Centric Project** provides an overview to the project workspace, including definitions of project workspace concepts and answers to frequently asked questions.

**Setting up your browser and e-mail** lists the browsers and browser versions that you can use to view your project workspace. It explains how to configure your browser so that you have access to the project’s features, and gives instructions for installing User Tools, which provide additional project functionality.

**Navigating in your project workspace** explains how to log in to your project workspace. It also provides an overview of the features of My Dashboard and the project workspace window.

**Learning to use your project workspace** gives procedures for the most commonly used project workspace features, including viewing Information Items, publishing Information Items, viewing and sending Activities, and using the project calendar.
Setting up your browser and e-mail

<table>
<thead>
<tr>
<th>In this chapter</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>30</td>
</tr>
<tr>
<td>Supported browsers</td>
<td>31</td>
</tr>
<tr>
<td>Configuring your browser and e-mail</td>
<td>32</td>
</tr>
<tr>
<td>Installing User Tools</td>
<td>34</td>
</tr>
</tbody>
</table>
Overview

You can use the Centric Project project workspace with any supported web browser. To use Centric Project project workspaces to their fullest extent, however, you need to configure your browser’s options and install Centric Project User Tools, which provide additional functionality such as synchronization with Microsoft Outlook.

In addition, if you want to be able to send project e-mail with Microsoft® Outlook®, you need to make sure that your client e-mail program is set up correctly.

**Note:** You can use the Centric Project workspace with any level of Internet access; however, if you expect to be uploading or downloading large files to or from a Centric Project workspace, you should have a faster connection.

Depending on your needs and your role in your projects, you may also want to install one or more of the Centric Project User Tools.

Use the following sections to make sure that you have a supported browser version installed, to configure your browser and e-mail correctly, and to install User Tools.
Supported browsers

Centric Software supports the following browsers for Microsoft® Windows®:

- Microsoft Internet Explorer 6.0 SP1, 6.0 SP2, or 7.0

Centric Software supports the following operating systems:

- Microsoft Windows 2000 SP4, Windows XP SP1 or XP SP2

To check your browser's version

From Internet Explorer’s Help menu, choose About Internet Explorer.
Configuring your browser and e-mail

Before you log in to a Centric Project project workspace, you should make sure that the following browser options are set:

- **Cookies must be turned on.** Otherwise, you will not be able to log in to your Project Area or a project workspace. By default, cookies are turned on (unless you have turned them off).

- **JavaScript must be enabled in your browser.** By default, JavaScript is enabled unless you have disabled it yourself. This is usually set in your preferences or the options for your particular browser.

- **Caching should be set to check for a new version only when you start Internet Explorer.** This allows your browser to use the local cache of project workspace files whenever possible, which makes viewing and using the project workspace more efficient.

- **Make Centric Project a trusted site.** Windows XP Service Pack 2 blocks the download and installation of ActiveX controls due to which you might get various error messages.

- **Script-initiated windows should be enabled.** This allows you to view all the buttons on dialog boxes.

The following procedures describe how to set these browser options for Internet Explorer to use with your Centric Project workspace.

**Configuring Internet Explorer**

Use this procedure to configure Internet Explorer to use with your Centric Project workspace:

1. From the Internet Explorer’s Tools menu, choose **Internet Options.** The Internet Options dialog box appears.
2. Click the **General** tab.
3. Under Temporary Internet files, click the **Settings** button. The Settings dialog box appears.
4. Under “Check for newer versions of stored pages”, select the **Automatically** option.
5. Click **OK**.
6. Click the **Security** tab.
7. Click on the **Trusted Sites** icon.
8. Click the Sites button.
9. In the Add this Web site to the zone: field, enter the address of your Centric Project site, click the Add button and then click OK.
10. In the “Select a Web content zone to specify its security settings” box, select Internet.
11. Under “Security level for this zone,” select Medium or lower. You can drag the scroll bar to change the setting.
12. Click the Custom level button.
   This will bring up the Security Settings dialog box.
13. In the Miscellaneous section, navigate to Allow script initiated windows without size or position constraints.
14. Select Enable and Click OK.
15. Click the Advanced tab.
16. Scroll down the list until you see Microsoft VM.
17. Select the JIT compiler for virtual machine enabled check box.
18. Click OK to close the Internet Options dialog box.
19. From Internet Explorer’s File menu, choose Close.
   Note: You must exit Internet Explorer for these changes to take effect.

You can now install the User Tools for additional functionality. For instructions, see “Installing User Tools,” on page 34.

Configuring Microsoft Outlook to send project e-mail

If you are using Microsoft Outlook as your mail program for sending e-mail from your project workspaces, you need to make sure that the Allow comma as address separator option is selected.

1. From Microsoft Outlook’s Tools menu, choose Options. The Options dialog box appears.
2. On the Preferences tab, click the E-mail Options button. The E-mail Options dialog box appears.
3. Click the Advanced E-mail Options button. The Advanced E-mail Options dialog box appears.
4. Under the “When sending a message” section, select the Allow comma as address separator check box.
5. Click OK to exit from each of the Options dialog boxes.
Installing User Tools

Centric Project User Tools provide additional functionality and features for your project workspace. Centric Project provides these User Tools:

**Note:** To install any of the User Tools (except the Information Item Publishing Extensions), you must have Administrator privileges on the computer on which you are installing them.

- **Centric Project Add-in for Microsoft Outlook** – Installing the Add-in for Microsoft Outlook allows you to synchronize meetings, milestones, and Activities in the Centric Project projects that you select with Microsoft Outlook. You choose which projects and which data you want to synchronize and how you want Centric Project items to appear in Outlook (for example, you can choose to have Activities appear in Outlook as flagged messages or as tasks). Complete Help for this Add-in is available from the Centric Project menu in Outlook after you install the Add-in.

  **Note:** This feature is available only if you use Microsoft Outlook 2000 or XP.

- **Centric Project Add-in for Microsoft Office** – Allows you to publish information directly from Microsoft Word, Excel, and PowerPoint to your project workspaces. Complete Help for this Add-in is available from the Centric Project menu in Word, Excel, and PowerPoint after you install the Add-in.

- **Centric Project Extensions for Windows Explorer** – Allows you to access and publish Centric Project information directly from Windows Explorer. Complete Help for this Add-in is available by right-clicking a Centric Project item (under the icon) in Windows Explorer after you install the Add-in.

- **Information Item Publishing Extensions** – Provides extended functionality so that you can publish certain file types to your project workspaces. Includes automatic packaging and un-packaging of CAD files and their reference files for convenient publishing and downloading. Also includes extensions to support structured data publishing for Pro/ENGINEER, SolidWorks, Microsoft Project, and Microsoft Visio files.

- **Centric Project Add-in for Microsoft Project** – Allows you to map tasks and fields in a Microsoft Project schedule to your project process. When you publish a mapped schedule to the process page, the process is automatically updated with any changes made in the schedule to mapped information.
Setting up your browser and e-mail

**Note:** This feature is available only if your company has purchased and enabled the Centric Process module. To install this Add-in, you must be the Project Manager (or an Assistant), and you must have Microsoft Project 2000 or XP installed on your local computer.

**Other tools**

In addition to the above tools, one or both of the following sections may appear at the bottom of the User Tools dialog box:

- **Centric Project ePrint** – Click the **Install** button to install the ePrint driver, which provides enhanced Microsoft Word, Excel, PowerPoint and PDF viewing and markup capabilities.

**To install User Tools**

The first time that you log in to your project workspace, a message appears that tells you that the latest User Tools are not installed for the ProjectArea and gives you the option to install them.

You can also install and check the status for User Tools at any time from the User Tools dialog box by using the following procedure.

1. On the ProjectArea Login page, click the **User Tools** link in the upper-left corner of the page.
   
   *Or*
   
   From the My Dashboard or project workspace Help menu, choose **User Tools**.
   
   The User Tools dialog box appears.

2. In the “General” section, click the **Install** button. The File Download dialog box appears.

3. Select the **Open** option. The Centric Project User Tools InstallShield wizard starts and displays the Welcome page.

4. Before continuing with the installation, close the User Tools page and any other open browser windows. You should also close any other open applications (including Microsoft Outlook).

5. Click **Next**. The Customer Information page appears and displays your user name and organization.

6. If necessary, make changes to your user name or organization.

   **Note:** At any time during the installation process, you can click **Back** to change information.
7. Click Next. The Destination Folder page appears and displays the default path for the folder in which the User Tools will be installed.

8. Click Next. The Custom Setup page appears.

9. Select which User Tools you want to install:
   - To install all listed User Tools, leave the icons for each as.
   - To select not to install a User Tool, click its icon and then choose This feature will not be available. Its icon changes to.

10. Click Next. The Ready to Install the Program page appears and displays the settings you’ve chosen.

11. Click Install to being the installation. The Installing Centric Project User Tools page appears and displays the status of the installation.

   **Note:** If, during the installation, the wizard finds files that are currently in use that need to be updated as part of the installation, the Files In Use dialog box appears and lists the files and their associated applications. Close the listed applications and then click Retry to continue the installation.

   When the installation is complete, the Installshield Wizard Completed page appears.

12. Click Finish.
Navigating in your project workspace

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logging in to your project workspace</td>
<td>38</td>
</tr>
<tr>
<td>The My Dashboard window</td>
<td>42</td>
</tr>
<tr>
<td>Exiting from projects or the ProjectArea</td>
<td>46</td>
</tr>
<tr>
<td>The project workspace window</td>
<td>47</td>
</tr>
</tbody>
</table>
Logging in to your project workspace

If your Centric Project server administrator has turned on the NT Authentication feature for your ProjectArea and for you, the first time that you log in to a ProjectArea, you need to provide your login name and password and associate your Centric Project login information with your NT domain login information. Thereafter, you can log in directly by just specifying your ProjectArea address in your browser window.

If the NT Authentication feature is not turned on, you will need to specify your Centric Project login name and password each time that you log in to the ProjectArea.

To log in to your project workspace for the first time

Use this procedure to log in to your project workspace:

1. Open a browser window.
2. Navigate to the ProjectArea that contains your project by specifying its address (for example, http://server1.yourdomain.com/ProjectAreaName).

   Note: If you don’t know the address for your ProjectArea, contact your Centric Project system administrator.

The ProjectArea Login page appears.
3. Enter your login name and password.

4. Click **Login**.

   If the NT Authentication feature is turned on for the ProjectArea and for you, and if the login name you entered is different from your NT login name, a message appears that asks you to confirm that you want to associate this Centric Project user account with this NT login.

5. To associate your Centric Project user account with the NT login, click **OK**. Subsequent logins will take you directly to My Dashboard.

   **Note:** If you associate your Centric Project user account with the NT login, you will be automatically logged in to the ProjectArea regardless of the computer you use to log in.

My Dashboard appears and displays the Projects tab, which lists the projects you have access to. For a description of the features in My Dashboard and the Projects tab, see “The My Dashboard,” on page 42.

6. On the **Projects tab**, click the name of the project that you want to use. Your project opens in the project workspace window.

To log in to your project workspace after the first time

1. Open a browser window.
2. Navigate to the ProjectArea that contains your project by specifying its address (for example, http://server1.yourdomain.com/ProjectArea

Note: If you don’t know the address for your ProjectArea, contact your Centric Project system administrator.

The ProjectArea Login page appears.

Note: If the NT Authentication option is turned on for your ProjectArea and for you (by your ProjectArea Administrator) and you have already logged in to the NT domain, you will go directly to My Dashboard (see step 5).

3. Enter your login name and password.

4. Click Login. My Dashboard appears and displays the Projects tab, which lists the projects you have access to. For a description of the features in My Dashboard and the Projects tab, see “The My Dashboard,” on page 42.

5. On the Projects tab, click the name of the project that you want to use. Your project opens in the project workspace window.

Accessing your project from a direct URL

In addition to being able to access your projects by the ProjectArea’s URL (http://<server>/<ProjectArea>/), you can also go directly to your project by using this direct URL:

- http://<server>/<ProjectAreaName>/<ProjectName>

As when you use the ProjectArea URL, if you have not already logged in to the ProjectArea (or to the NT domain if you are using the NT Authentication feature), the ProjectArea Login page appears so that you can enter your user name and password before you are taken to the page that you specified.

Requesting project login information

If you forget your login information (your password, login name, or both), you can request that this information be sent to you so that you can log in to your ProjectArea or project.

Notes: This feature is available only if your Centric Project Administrator has turned it on for this ProjectArea. For security reasons, this feature is not available to all users. If you
Navigating in your project workspace

are unable to use this feature, contact your Centric Project Administrator for more information.

The following procedures describe how to request your login information and how to log in to the ProjectArea with the temporary password that you receive.

To request login information

1. On the ProjectArea Login page, click the **Forgot your login info?** link. The Login Information Request dialog box appears.

2. Enter the appropriate identifying information:
   - If you know your Centric Project login name, select **Login name** and then type your login name in the box.
   - If you don’t know your Centric Project login name, select **E-mail address** and then type your full e-mail address in the box.

3. Click **OK**. Centric Project sends an e-mail message to the e-mail address associated with the login name or e-mail address that you entered. The e-mail message contains your login name and a temporary password.

Once you have received your new password, you can log in to the ProjectArea. When you log in, you will be asked to create a new permanent password. For more information, see “To log in with your temporary password,” below.

To log in with your temporary password

1. On the ProjectArea Login page, enter the login name and password that were sent to you by e-mail from Centric Project.

2. Click **Login**. The Change Password page appears.

3. In the New Password box, type your new password.

4. In the Confirm Password box, retype the new password.

5. Click **Change Password**. Centric Project accepts your new password and logs you in to the ProjectArea.
The My Dashboard window

My Dashboard is your at-a-glance view of your ProjectArea information. My Dashboard contains up to six tabs that allow you to:

- See your project list and navigate to your projects.
- Quickly see the Tracked Activities, Deliverables, meetings, and milestones that require your attention as well as new Information Items and comments added to your Information Items.
- View and respond to all Activities you're involved with.
- View and manage your Information Items.
- View and manage portfolio and Cross-Project Analytics reports (if you have access to these features).

As long as you are a project user, you have access to the My Dashboard window, even if you don’t have access to any tab or feature in the project.

As long as you are a project user, you have access to the My Dashboard window, even if you don’t have access to any tab or feature in the project.

If you have new, updated, or unread Activities (or Deliverables), the My Activities tab, the in the toolbar, and the icon on the Projects tab turn bold. If you have overdue Activities (or Deliverables), the indicators turn red.
The information in My Dashboard is automatically updated when you perform an action on a listed item (for example, when you open or respond to a Tracked Activity). You can also manually refresh the information in My Dashboard.

My Dashboard also gives you access to many other ProjectArea features, such as Project Workspace Help, the User Tools installation page, Project Administration commands (for project Authors) and ProjectArea Administration commands (for ProjectArea Administrators).

Each of My Dashboard’s features is briefly described below. Detailed information about each feature is available in Project Workspace Help.

**Menu bar**

Choose commands from the menu bar to access features for the selected tab or project. My Dashboard’s menu bar contains the following menus:

- **File** – Use this menu to perform ProjectArea-wide functions (for example, specifying your user information and preferences, exiting from the ProjectArea, or creating new projects, if you have permission).
- **View** – Use this menu to refresh My Dashboard with the most current information.
- **Actions** – Use this menu to perform actions for the selected tab in My Dashboard
- **Help** – Use this menu to view Centric Project Help, to install User Tools, to provide feedback to Centric Software, and to see information about your Centric Project version.

**Toolbar**

Use the buttons on the My Dashboard toolbar (at the top-right of the My Dashboard) to exit from this page and to use other project workspace features:

- Click ![ProjectArea Administration command](image) to select a ProjectArea Administration command.

  **Note:** This button appears only if you are an Administrator for the ProjectArea.

- Click ![Create new project workspace based on a project workspace template](image) to create a new project workspace based on a project workspace template.
Note: To create a project from a web template, you must have Creator or Administrator privileges for the ProjectArea.

- Click ⚒ to create a new Tracked Activity for the selected project.
- Click  to exit from My Dashboard and return to the ProjectArea’s Login page.
- Click  to add My Dashboard to your browser’s Favorites list.
- Click  to view Project Workspace Help.

Search
Use the Search box to search for project information.

- To quickly search for project information, enter the text or value that you are searching for and then click Go.
- To use more advanced options for searching project information, click the Advanced link.

Tabs
My Dashboard contains up to six tabs:

- **Projects** – Use this tab to see the list of projects that you have access to and to create and view a list of favorite projects. You use the Projects tab to navigate to the project in which you want to work. The icons on the Projects tab indicate whether a project contains any Activities (or Deliverables) that require your attention and whether the project has a charter that you have access to view.

  If you are a project Author, the Projects tab gives you access to Project Administration commands.

  The Projects tab appears for all project users.

- **At-A-Glance** – Use this tab to see an overview of project data that is most relevant to you, sorted with the most urgent items at the top of the lists.

  This tab lists the total number of Activities (and process Deliverables) that require your attention, lists Information Items added to Project Elements that you have subscribed to, lists comments that have been added to Information Items that you own (and still have access to) or to which you are
subscribed, and important upcoming events in your Centric Project calendar.

The At-A-Glance tab appears for all project users.

- **My Activities** – Use this tab to see and work with all Activities that require your attention, including those that require a response from you and those that have been updated for which you are a listed recipient. If your project includes a process, this tab also lists any process Deliverables that are assigned to you for the current Work Period and have not yet been accepted or skipped. This tab also lists all Activities that meet your specified filter criteria.

  The My Activities tab appears for all project users.

- **My Info Items** – Use this tab to see and manage the Information Items that you own.

  The My Info Items tab appears for all project users.

- **Portfolio Analysis** – Use this tab to view public portfolio reports for their portfolios and to create private portfolio reports. Users with permission to manage portfolios can also edit the properties of your portfolios from this tab.

  The Portfolio Analysis tab appears if you have access to one or more portfolios in this ProjectArea.

- **Cross-Project Analysis** – Use this tab to view public Cross-Project Analytics reports for their projects and to create private Cross-Project Analytics reports.

  The Cross-Project Analysis tab appears for Project Managers, project Assistants, and project users with access to one or more Activity logs in the ProjectArea.

For more information about each of these tabs, refer to Centric Project Project Workspace Help.
Exiting from projects or the ProjectArea

Your User Preferences determine whether My Dashboard and each project opens in a separate browser window or reuses the same browser window.

If you have chosen to have your projects open in a separate window from My Dashboard, you can exit from the project by just closing the project’s browser window. You can also navigate back to My Dashboard without closing the project window.

If you have chosen to reuse a single browser window, you can exit from the project by navigating back to My Dashboard.

When you are finished working with projects, you can exit from the entire ProjectArea by logging out of the ProjectArea.

To exit from a project by closing the browser window

- From the browser’s File menu, choose Close (or click the X button in the upper-right corner of the window).

  Note: If you have chosen to reuse a single window for all project windows, when you close the browser window, you are automatically logged out of the ProjectArea.

To exit from a project and return to My Dashboard

- In the Project toolbar, click . Centric Project displays My Dashboard.

  Note: If you have chosen to open projects in separate browser windows, My Dashboard appears in a separate window. To exit from the project, you need to close the project’s browser window (see above).

To log out from the ProjectArea

- From the File menu, choose Exit (or click in the Project or My Dashboard toolbar). All project windows are closed and the ProjectArea Login page appears.

  Note: You have an option to close the window automatically when you exit from ProjectArea. For details contact your Centric Project administrator.

46 Project Workspace User Guide
The project workspace window

Your project workspace appears in your browser window, just like any other workspace; however, you navigate through the project workspace by using the Centric Project’s navigation tools rather than the browser’s buttons.

**Note:** Some standard browser features, in particular the **Favorites** features and the **Back** and **Forward** buttons do not work as expected in workspaces that have frames (like Centric Project). Centric Software recommends that you do not use these browser features when viewing a project workspace.

The top of the project workspace window contains the tools that you use to navigate to different areas of the project workspace:

- **Menu bar** – Choose commands from the menu bar to navigate in the project and to access project workspace features.
- **Project title bar** – The title bar displays your name and the project’s name.
- **Project tab bar** – Click a tab’s name on the tab bar to navigate to a tab and to view or work the information on the tab. If you cannot see all of the tabs in your project, use the
Tab Scroll toolbar to scroll through the tabs on the Project tab bar.

- **Search box** – Enter a value in the search box and then click **Go** to search for the value in project workspace information. For more advanced search options, click the **Advanced** link.

- **Project toolbar** – Use the icons on the Project toolbar to navigate to My Dashboard, create a new Tracked Activity, exit from the ProjectArea, add the current page to your browser’s Favorites, and view Project Workspace Help. If you are a project Author, you can also use the toolbar to access Project Administration commands.

- **Tab scroll toolbar** – If your project has more tabs than will fit in the Project tab bar at one time, use the buttons on the Tab Scroll toolbar to scroll through the tabs, one at a time or one bank of tabs at a time.

- **Project tabs** – The project tabs contain the contents (Project Elements and Information Items) of each tab in your project workspace, as well as buttons and features that let you view and modify project information.

**Project toolbar**

Use the buttons on the Project toolbar (at the top-right of the project window page) to exit from this page and access project workspace features:

- Click 📝 to select a Project Administration command.
  
  **Note:** This button appears only if you are an Author for the ProjectArea.

- Click 🏡 to navigate to My Dashboard.

- Click 🌟 to create a new Tracked Activity.

- Click 💼 to exit from the ProjectArea and return to the ProjectArea’s Login page.

- Click 🔗 to add the current page to your browser’s Favorites list.

- Click 📚 to view Project Workspace Help.
To navigate to specific information in the project workspace

- To navigate to a tab, click the tab’s name in the Project tab bar (or, from the View menu, choose Tab and then choose the tab’s name).
- To navigate to a Project Element, click the Project Element’s name on a tab.
- To navigate to a cross-referenced Project Element on another tab, click the Actions button in the Project Element’s Information frame, choose Go To, and then choose the tab to which you want to navigate.
- To navigate to project information described in a Centric Project e-mail notification, click the information’s link in the e-mail message.
- To navigate to an Information Item from an Activity or other location in the project, right-click the Information Item and then choose Go To.
- To view contact information (name, e-mail address, address, phone number, etc.) about any project user, click the project user’s name anywhere that you see it in the project workspace.
- To see a list of the project users who are members of any group, click the group’s name anywhere that you see it in the project workspace.
- To navigate to My Dashboard, click My Dashboard in the project toolbar (or, from the View menu, choose My Dashboard).
Using your project workspace

<table>
<thead>
<tr>
<th>In this chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting your user preferences</td>
<td>51</td>
</tr>
<tr>
<td>Viewing and editing your user information</td>
<td>52</td>
</tr>
<tr>
<td>Creating your Favorite Projects list</td>
<td>54</td>
</tr>
<tr>
<td>Information Item User Field</td>
<td>56</td>
</tr>
<tr>
<td>Viewing Information Items</td>
<td>58</td>
</tr>
<tr>
<td>Publishing Information Items</td>
<td>61</td>
</tr>
<tr>
<td>Viewing and adding comments to Information Items</td>
<td>65</td>
</tr>
<tr>
<td>Searching for project information</td>
<td>67</td>
</tr>
<tr>
<td>Creating, viewing, and responding to Tracked Activities</td>
<td>68</td>
</tr>
<tr>
<td>Using the project calendar</td>
<td>75</td>
</tr>
<tr>
<td>Using Connector hub</td>
<td>79</td>
</tr>
</tbody>
</table>
Setting your user preferences

User preferences are options that allow you to customize some Centric Project features. For example, with user preferences, you can specify which project tab you want to be displayed every time you log into the project and which e-mail format you want to use to send project e-mail (Centric Project mail or your own client e-mail program).

To set user preferences

1. From the File menu, choose User Preferences. The User Preferences dialog box appears.
2. Select your user preferences. For help about the options available in this dialog box, click the dialog box’s Help button.
3. When you are finished selecting preferences, click OK.
Viewing or editing your user information

Your user information includes

- Your login name and password
- Your contact information (including your name, e-mail address, title, company name, address, phone numbers, and web conference address or account information)
- The list of groups of which you are a member
- The list of projects for which you are user
- The list of portfolios to which you have access (if the optional Centric Portfolio module is installed)

You can view and edit your own user information by choosing the User Information command from the File menu or by clicking your name anywhere in the project workspace.

You can view user information about other project users by clicking a user’s or group’s name anywhere in the project workspace.

Notes

- If your user information was imported from an LDAP database, you will not be able to edit the information that was imported from the LDAP database if your user account is still connected to the LDAP database. In this case, your user information is maintained in the LDAP database rather than the Centric Project database.

- If you are a project Author, you can view the contact information for project users in your project, and you can view and edit their group memberships, project subscriptions, and project permissions from their User Properties dialog box.

To view or edit your user information

1. From the File menu, choose User Information (or click your name anywhere in the project workspace). The User Properties dialog box appears and displays your user information.

2. Use the tabs for view or edit your user information:
   - Use the General tab to view or edit your ProjectArea login name or password.
   - Use the Contact tab to view or edit your contact information.
   - Use the Groups tab to view the groups of which you are member.
Using your project workspace

- Use the Projects tab to view the list of projects in this ProjectArea to which you have access.
- Use the Portfolios tab to view the portfolios to which you have access (if the optional Centric Portfolio module is installed).
  **Tip** For detailed information about the options available on each tab in the dialog box, click the Help button in the dialog box.

3. To edit your project subscriptions, click the Subscriptions button.

4. When you are finished viewing or editing your user information, click OK.
Creating your Favorite Projects list

The first time you log in to your ProjectArea, the Projects tab in My Dashboard automatically shows you the list of all projects you have been given access to. If you want to narrow the list of projects to only those you are currently working on, you can create a Favorite Projects list that contains a subset of all of your projects.

Once you have created a Favorite Projects list, you can remove projects or add projects as needed, and you can choose to view either the Favorites list or all of your projects on the Projects tab.

To add a project to your Favorite Projects list

1. On the Projects tab of My Dashboard, select the project you want to add to your Favorite Projects list.
   
   **Tip** If you don't see the project you want, make sure you are viewing the list of all of your projects by selecting the **Show All** option at the top of the tab.

2. From the Actions menu, choose **Favorite** (or right-click the project and then choose **Favorite**).

To add multiple projects to your Favorite Projects list

1. From the Actions menu in My Dashboard, choose **Add Favorite Projects**. The Select Projects dialog box appears and displays all of your projects that you have not yet added to the Favorite Projects list.

2. Select the projects you want to add to your Favorite Projects list.

3. Click **OK**.

To view your Favorite Projects list

- On the Projects tab of My Dashboard, select the **Show Favorite Projects** option. Your Favorite Projects list appears on the Projects tab.

To view all of your projects

- On the Projects tab of My Dashboard, select the **Show All** option. All of your projects are displayed on the Projects tab.
To remove projects from your Favorite Projects list

1. On the Projects tab of My Dashboard, view your Favorite Projects list.
2. Select the project you want to remove from your Favorite Projects list.
3. From the Actions menu, choose **Remove from Favorite Projects** (or right-click the project and then choose **Remove from Favorite Projects**).
Information Item User Fields

This section describes how to use the Information Item User Fields for Centric Project. This feature allows you to specify the User Field values for an Information Item to be published. Information Items will support an unlimited number of user fields and values. The tab will display the user fields in the order they are presented in the XML schema file. This tab will be visible only when the XML schema file is associated with the ProjectArea object.

Setting up Centric Project Server

Use the following procedure to setup the Centric Project Server.
1. Add an Export License to the Server
2. Customize Information Item User Field Dictionary
3. Instantiate the Information Item User Field template

Adding Export License to the Server

Follow these steps to add the export license to the server:
1. In the Console tree, right-click Centric Project Server and then choose Properties.
2. The Centric Project Server Properties dialog box appears.
3. Click the Licenses and Application Modules tab. A list of the installed licenses appears.
4. Click Add License.
5. The Add License dialog box appears.
6. Type the Export license number.
7. Click OK.
   Note: License numbers can be found on the inside cover of the Centric Project installation CD's jewel case, or on the License card.
8. Click Apply.

Customizing Information Item User Field Dictionary

The next step is to edit the Information Item User Field XML schema file. This XML schema file defines the valid User Fields and values for the Information Items User Fields functionality. In the absence of this file Information Items User Fields functionality will be turned off.

- The XML schema file will define a list of user field names, field data types, mandatory and optional field value descriptions.
- Field names will follow current conventions for parameters (No more than 50 characters, blanks are allowed, forward and back slash are not allowed).
- Field data types will utilize the same data types available for other definitions (e.g. yes/no, text, date, integer, number, etc).
- A field can be flagged as mandatory.
- A field value can be null.

In general, all properties are optional unless they are specifically defined to be required in the XML. Also all the properties are displayed in the User Fields dialog box unless they are specifically defined to be invisible in the XML.

All properties can have a default value assigned to them. For a list value, the default is specified by the attribute isDefault="1". For a simple, single value property, the default is typed directly into the XML SingleValue element. If the SingleValue element has no value assigned to it, then there is no default value. If none of the list values have the isDefault="1" attribute, then there is no default values for the list.

Instantiating the Information Item User Field template

Follow these steps to instantiate the Information Item User Field template:
1. Copy the User Fields XML schema file to the Centric Project Server.
2. From the DOS prompt, run AddUserFieldsTemplate.vbs located in <CP Install dir>/ApServer using the following syntax:
   ```
   AddUserFieldsTemplate.vbs /PA ProjectArea_Name (or ProjectArea ID) /T Template_Name
   ```
   
   **ProjectArea_Name**: The name of the ProjectArea or the ProjectArea identifier.
   
   **Template_Name**: The full path to the XML schema file.

**Note**: The /PA argument is optional. If it is not entered the template will be added to ProjectArea with the ID of 1.

For additional information about Information Item User Fields like editing, exporting and checking User Fields, refer to the *Setup Information Item User Fields in Centric Project.doc*
Viewing Information Items

Information Items are the files that you publish, view, and maintain with your Centric Project project workspace. Information Items can be documents, links to web pages, CAD drawings, pictures, video files, sound files, or any other data files that are published to the workspace.

If you have access to a tab, you can view any published Information Item on that tab. There are two ways to see the contents of an Information Item from the project workspace:

- **Viewing** lets you see and navigate through a full-sized copy of the item in the Centric Project Viewer window. The Viewer window lets you view any published Information Item, regardless of whether you have the Information Item’s native application installed on your computer. The Viewer window also lets you perform special viewing functions for the image, such as viewing and changing image properties and creating cutting planes.

- **Opening** allows you to open an item for viewing in its native application or viewer (this does not open the item for editing in its native application). This allows you to view the highest quality image of the item and to manipulate the image with the native application’s viewing options. You can open an item only if you have a native application or viewer installed on your computer for the Information Item.

Viewing Information Items

Viewing an Information Item lets you see and navigate through a full-sized copy of the item in the Centric Project Viewer window. The Viewer window lets you view any published Information Item, regardless of whether you have the Information Item’s native application installed on your computer.

The Viewer window lets you use Centric Project Viewing tools to perform special viewing functions for the image, such as zooming, panning, rotating, viewing and changing image properties, and creating cutting planes.

You can view an Information Item from the Information frame, from an Information Item attachment link (for example, in an Activity, comment, or meeting), from the Search Results dialog box, or from the My Dashboard window.

You can view Information Items on any project tab to which you have access.
Notes: URL and other links embedded in Information Items that you view in the Centric Project Viewer window do not work. To use a link in an Information Item, you need to view the Information Item with the Open command or download the Information Item and open it in its native application.

If the Centric Project Viewer plug-in (which is installed as part of the Centric Project User Tools) is installed on your computer, and a view of the Information Item exists, the Information Item appears in a browser window. Otherwise, the browser automatically attempts to launch the native viewer or application for the selected file type. If the viewer or application for that file type is not installed on your computer, you may not be able to view the Information Item.

To view an Information Item

1. Select the Information Item that you want to view.
2. From the Actions menu, choose Centric Project View (or right-click the Information Item and then choose Centric Project View).

The item appears in Centric Project Viewer window.

Note: If the Information Item is in a three-frame tab and the View Information Items in a separate browser window check box is not selected in your User Preferences, the Information Item appears in the tab’s Graphic frame.

Opening Information Items

Opening allows you to open an item for viewing in its native application or viewer (this does not open the item for editing in its native application). This allows you to view the highest quality image of the item and to manipulate it with the native application’s options. You can open an item only if you have a native application or viewer installed on your computer for the Information Item.

You can open an Information Item from the Information frame, from an Information Item attachment link (for example, in an Activity, comment, or meeting), from the Search Results dialog box, or from the My Dashboard window.

You can open Information Items on any project tab to which you have access.

Note: If you try to open an Information Item and you do not have a native viewer installed on your computer, Centric Project
displays a dialog box that allows you to download or save the Information Item on your computer.

To open an Information Item

1. Select the Information Item that you want to open.
2. From the Actions menu, choose Open (or right-click the Information Item and then choose Open). The item appears in the appropriate application’s viewer window.
Publishing Information Items

If you have Publisher or Editor access to a tab in the project workspace or Author access to the project, you can add new Information Items (CAD drawings, photos, documents, URLs, and other files) to the Project Elements in the tab. The process of adding an Information Item to a project workspace is called publishing.

Publishing an Information Item makes that Information Item available to other project workspace users who have the appropriate access to the tab so that they can view it, comment on it, mark it up, and download it.

Centric Project gives you two ways to publish an Information Item:

- By dragging and dropping files onto the (File Drop Box) icon for the Project Element, or anywhere in the Project Element’s Information Item list
- By using commands from the Projects menu

Note: To publish structured data files that create structure in the project workspace, you must be an Author for the project or an Editor for the tab and you must use the drag-and-drop method.

Both of these procedures are described below.

Publishing by dragging and dropping

If you have Author, Editor, or Publisher access to the tab, you can publish or republish up to 100 Information Items at once by dragging and dropping the items’ files on the Drop Box in a Project Element’s Information frame or by dragging and dropping it anywhere in the Project Element’s Information Item list.

You can use the drag-and-drop method to publish both non-structured and structured Information Items to the project workspace. Non-structured Information Items include most single-file Information Items (for example, Microsoft Word documents, PDF documents, and URLs from Internet Explorer). Structured Information Items are those that contain a set of structured files (for example, SolidWorks assemblies or Microsoft Project schedules).

Notes ■ For more information about publishing structured data Information Items, see “Publishing structured data files” in Project Workspace Help.

If you publish a new version of a file that you previously published with the same file name, Centric Project republishes the Information Item and gives it a new publication number.
The procedure for publishing an Information Item to a Project Element that has a policy associated with it (identified by a yellow dot on the Project Element’ name in the Outline frame) differs somewhat from the regular publication procedure. For more information, see “Publishing Information Items with policies” in Project Workspace Help.

**To publish non-structured Information Items by dragging and dropping**

1. Navigate to the Project Element where you want to publish the Information Items.
2. Select the files that you want to publish:
   - To publish one or more files, select the files in Windows Explorer or from your desktop.
   - To publish a URL from Internet Explorer, open an Internet Explorer window to the URL that you want to publish, then select the icon to the left of the URL in the browser’s Address box.
   - To publish one or more e-mails from Microsoft Outlook, open MS Outlook and select e-mails that you want to publish.
3. Drag and drop the files or e-mails URL icon onto the Project Element’s icon, or anywhere in the Information Item list.

**Tip**

When the mouse pointer changes to an arrow with a plus sign beneath it, you can release the mouse button to publish the files.

If you dropped one or more files, the Publish Information Items dialog box appears.

If you dropped a URL, the Publish Information Item dialog box appears. Click OK. The Confirm Publish Information Items dialog box appears.

**Note:** If you are publishing a Microsoft Office document and you have not yet installed the optional ePrint driver for enhanced viewing and markup, a message appears that asks if you want to install the driver. To install the driver, click Install ePrint. To publish without installing the driver, click Publish.

4. If necessary, edit the Information Items’ properties by clicking the button in the Properties column for the Information Item, making your changes, and then clicking OK. After you
change the Information Item’s properties, the button changes to

5. Click OK. Centric Project publishes the Information Items to the project workspace. The Send Notification E-mail dialog box appears.
6. Fill out the Send Notification E-mail dialog box.
7. Click Send.

To publish the Information Items to Centric Project
1. Login to the Windows server that Centric Project is installed on using a Windows Administrative account.
2. Open the command prompt and navigate to the folder that contains ConnectorInfoItemPublisher.exe.
   Note: Typically this will be located in the: <CP Install dir>/
   <ProjectArea name>/web/bin
3. From the command prompt run the following command:
   ConnectorInfoItemPublisher.exe /u <username> /p
   <password> /s <ProjectArea_ID>
   Note: ProjectArea_ID can be found in the Register Editor under
   HKEY_LOCAL_MACHINE\SOFTWARE\Framework
   Technologies Corporation \ApServer\ApSettings\3
   Any file in the mapped remote folder is automatically published to the
   CentricProject Project Element specified in the Data Feed mapping.

Publishing with Project menu bar commands

Use the following procedure to publish Information Items by using the commands available from your project’s menu bar.

To publish Information Items with Project menu commands
1. Navigate to the tab and Project Element where you want to publish the Information Item.
2. From the Actions menu (or Actions button in the Information frame), choose Add File or Add URL.
   --or--
   From the File menu, choose New File or New URL.
   The Publish Information Item dialog box appears.
3. Select the type of item that you want to publish and then specify its path (for file type Information Items) or URL (for URL type Information Items).

4. Click OK.
   
   **Note:** If you are publishing a Microsoft Office document and you have not yet installed the optional ePrint driver for enhanced viewing and markup, a message appears that asks if you want to install the driver. To install the driver, click Install ePrint. To publish without installing the driver, click **Publish**.

   The Publish Information Item dialog box appears.

5. If necessary, edit the Information Item’s properties by clicking the button in the Properties column for the Information Item, making your changes, and then clicking OK. After you change the Information Item's properties, the button changes to .

6. Click OK. Centric Project publishes the Information Item to the project workspace. The Send Notification E-mail dialog box appears.

7. Fill out the Send Notification E-mail dialog box.

8. Click Send.
Viewing and adding comments to Information Items

A comment is text that is attached to an Information Item. You enter and view comments in a separate Comment window. You can search the project workspace for text contained in an Information Item comment.

You can add text comments to the current version of an Information Item if you have Reviewer or higher access to the tab.

To view an Information Item’s comments

Use one of the following methods to open the Comment window for the Information Item:

- In the Information frame, click the icon for the Information Item.
- In the Information frame, select the Information Item and then choose Comments from the Actions menu (or right-click the Information Item and then choose Comments).
- On the At-A-Glance tab in My Dashboard, double-click the comment in the “Comments added in the past ___ days” list.
- In the e-mail notification that you receive about the comment, click the link to view the comment.

The Comment dialog box appears and lists the comments for the current version of the Information Item.

To add comments to an Information Item

When you add a comment, you can choose to add a new comment or to reply to an existing comment. Replies to comments automatically include the subject text of the comment to which you are replying and appear indented beneath the comment to which they reply in the Comment window.

1. Click the or icon next to the Information Item to which you want to add the comment.
   —or—
   Select the Information Item for which you want to add a comment, and then choose Comments from the Actions menu (or right-click the Information Item and then choose Comments).

The Comment dialog box appears.
2. Choose whether you want to add a new comment or reply to an existing comment:
   - To add a new comment, click **New Comment**. The Add New Comment dialog box appears.
   - To reply to an existing comment, click the + sign next to the comment to which you want to reply, click the **Reply** link under the comment, and then choose **Comment**. The Add Reply to Comment dialog box appears.

3. Fill out the Add Comment or Add Reply to Comment dialog box.

4. Click **OK**. The Add Comment Results dialog box appears, which tells you whether the comment was added successfully, then the Notification Message dialog box appears.

5. Select the recipients for the e-mail notification.

6. In the Notes box, type any note you want to include in the e-mail notification.

7. Click **Send**.

8. When you have finished adding comments, click **Done**.
Searching for project information

Centric Project gives you two ways to search for project information:

- **Basic** – The basic search allows you to quickly search for a value in all project information or in just the information you select. Use the basic search for most of your project information searches.

- **Advanced** – The advanced search allows you to enter detailed search criteria, tailored for the type of project information you are searching. Use the advanced search when you want to narrow your search down by providing detailed search criteria.

With either type of search, you can find Information Items, Project Elements, comments, Tracked Activities, and Parameters in the current project or across all projects to which you have access.

**Note:** If the optional Centric Process module is installed, you can also use the Tracked Activity search to find process Deliverables with which you are involved.

When you find information that you are searching for, you can perform actions on the items according to the items’ type and your access to the items. For example, if you find an Information Item that you do not own, you can view it, open it, download it, copy it as a link, or send an e-mail link to it. If you find an Information Item that you own, you can also republish, transfer, move, or remove it.

**Note:** To quickly see a list of your own Information Items, go to the My Info Items tab of My Dashboard.

To perform a basic search for project information

1. In My Dashboard or in a project workspace, enter the value for that you want to search for in the Search box to the left of the toolbar.

2. Click **Go** (or press ENTER).

   The results of your search appear in the Search Results dialog box.

3. To perform an action on one or more found items, select the items, click **Actions**, and then choose the command for the action that you want to perform.

4. To close the Search Results dialog box, click **Close**.
Creating, viewing, and responding to Tracked Activities

You can create any type of Activity to which you have been given Submit access. You can create an Activity by creating it from scratch or by copying an existing, submitted Activity.

Once an Activity has been submitted, its recipients can view it and respond to or update it from the My Activities tab of the My Dashboard window. The Activity also appears on the corresponding Activity Log page. If the Activity has a due date associated with it and your project includes a Calendar page, the Activity appears in the calendar on the corresponding date for the Responsible User.

The following sections describe how to create, view, and update or respond to Activities.

Creating Activities

You can create any type of Activity to which you have been given Submit access. You can create an Activity by:

- **Creating it from scratch** – You can create a new Activity from scratch from the My Dashboard or project's File > New > Activity menu or toolbar icon, or by creating a new Activity from within another Activity that you are creating. When you create an Activity from scratch, you specify all of the information for the Activity as you create it (aside from process step information for Approval type Activities). You can edit or delete any default information provided for the Activity you are creating. When you create an Activity from within another Activity, the Activities are automatically linked together.

- **Copying an existing, submitted Activity** – You can create a copy of an existing Activity by selecting an existing Activity in your project and then choosing to copy it or by using the Copy From command in the New Activity dialog box as you are creating a new Activity. You can copy a submitted Activity as long as you have access to submit that type of Activity, the Activity you want to copy is using the most current definition of the Activity type, and the Activity is not an ad hoc type of Activity. The copy contains all the data in the original Activity except for the names of the recipients and any links or attachments in the original.

You can also create a new Activity by first selecting an Information Item or Activity to which you want to link it and then choosing the
New Activity command. This method creates an automatic link to the selected project information in the Activity that you are creating.

Use the following procedures to create an Activity from My Dashboard or from within a project workspace.

**Note:** The following procedures explain how to create Activities from scratch. For information on how to create an Activity by copying another Activity from within another Activity, or with automatic links to project information, refer to “Creating Activities” in Project Workspace Help.

**To create an Activity from My Dashboard**

1. Use one of the following methods to select the project in which you want to create the Activity:
   - On the Projects tab, select the project from the list of displayed projects.
   - On the At-A-Glance, My Activities, or My Info Items tab, select the project in the For project box in the upper-right corner of the tab.

2. From the File menu, choose New ➤ Activity (or click in the toolbar). The Tracked Activity Browser dialog box appears.

3. Select the type of Activity that you want to create.

4. Click OK. The appropriate New Activity dialog box appears.

5. Fill out the information in the dialog box.

   **Note:** If you are creating an ad hoc Approval Activity, the Approval Activity dialog box appears so that you can define the approval process steps and User Fields (if any) for the Activity. After you fill out the dialog box and click OK, you need to fill out the New Activity dialog box to submit the Activity.

   **Tip** For detailed information about filling out any Activity dialog box, click the Help button in the dialog box.

6. From the Activity’s Actions menu, choose Submit (or choose Save for a Poll type Activity). The Send Notification E-mail dialog box appears.

   **Note:** If you are sending an Approval type Activity that requires authentication for each action, the Reauthenticate dialog box appears before the notification dialog box appears. Enter your
authentication information and then click OK to proceed.

7. Fill out the Send Notification E-mail dialog box.

8. Click Send.

Once you send the Activity, its recipients can view and respond to it from the My Activities tab of the My Dashboard window. The Activity also appears on the corresponding Activity Log page. If the Activity has a due date associated with it and your project includes a Calendar page, the Activity appears in the calendar on the corresponding date for the Responsible User.

To create an Activity from your project workspace

1. From the project’s File menu, choose New > Activity (or click in the toolbar) and then choose the type of Activity that you want to create. The appropriate New Activity dialog box appears.

2. Fill out the information in the dialog box.

3. From the Activity’s Actions menu, choose Submit (or choose Save for a Poll type Activity). The Send Notification E-mail dialog box appears.

4. Fill out the Send Notification E-mail dialog box.

5. Click Send.

To open an Activity for viewing

Once they have been created, Activities appear in the following places in your project workspaces:

- **At-A-Glance tab in My Dashboard** – Activities that have due dates appear in the Important events list on the At-A-Glance tab if the date range you have selected includes the due dates for the Activities.

- **My Activities tab in My Dashboard** – On the My Activities tab, you can choose to see only your current Activities (those that require an action from you or those that have been updated since the last time you viewed them) or all Activities in which you have been involved. You can also select the projects for which you want to see Activities and can use or create column filters to display any subset of your Activities (for example, only those with a status of In Process).
• **Activity Log pages on the project’s Dashboard tab** – If you have access to the Log page for the type of Activity you want to view, you can see a list of all Activities of that type that have been submitted. On the Activity Log page, you can choose to see only certain Activity (for example, only those that are open, or only those that are overdue). You can also use or create column filters to display any subset of the Activities of that type (for example, only those with a specific Responsible User).

• **Calendar page on the project’s Dashboard tab** – If you have access to your project’s Calendar page on the Dashboard tab, you can choose to see all of your Activities that have due dates (those for which you are a Responsible User) or all Activities that have due dates and whose Log pages you have access to (this includes Activities for which you are not the Responsible User).

In any location, you can view an Activity by opening it.

• To open an Activity in My Dashboard or an Activity Log page, select the Activity, and then choose **Open** from the Actions menu (or right-click the Activity and then choose **Open**, or double-click the Activity).

• To open an Activity on the Calendar page, click the link for the Activity (or right-click the Activity and then choose **Open**).

**Updating or responding to Activities**

When you receive a new or updated Activity, the project workspace lets you know by making the following changes to the project workspace:

• The **icon in the toolbar turns bold (this icon also turns red if any Activities are overdue).**

• The **icon next to the associated project on the Projects tab in My Dashboard turns bold (this icon also turns red if any of your Activities are overdue).**

• The **My Activities tab in My Dashboard turns bold (the tab also turns red if any of your Activities are overdue).**

• **New or updated Activities appear in bold on the My Activities tab in My Dashboard (overdue Activities also appear in red).**
Depending on the type of Activity and your involvement with it, these indicators may mean simply that the Activity is new and unread, or it may mean that you need to respond to the Activity.

The type of Activity and its current state determine what type of response is required. For example, if you are a recipient of a Request/Response Activity, you might need to send a text reply to the Activity. If you are the person who created that Activity and a confirmation is required after a response, you might need to confirm or reject the response.

When you are working on Activities, you can also update them rather than respond to them. Updating allows you to add or change some of the information in the Activity without causing it to be sent to another project user or moved to the next step in a process.

For example, if you are working on an Approval Activity, you may want to add a note to the Activity or add a link or attachment without yet approving or rejecting the Activity. You can approve or reject the Activity later by responding to it. If you are responsible for an Assignment Activity, you update it until you change its status to 100%, at which point it is removed from your worklist and it appears in the Originator’s worklist to update.

**To update an Activity**

1. View the Activity that you want to update. The Tracked Activity dialog box appears.
2. Update the Tracked Activity.
3. Save your changes:
   - To save your changes without adding your own note to the Tracked Activity's history, choose **Save** from the Activity's File menu. Your changes are saved and the Tracked Activity dialog box remains open so that you can make other changes. When you are finished making changes, close the Activity dialog box by choosing **Close** from the Activity’s File menu.
   - To save your changes and add a note to describe your change, choose **Save with Note** from the Activity’s File menu (or click the **Save w/Note** button on the Activity's toolbar). The Update Tracked Activity dialog box appears. Type the note you want to include in the Activity's history and add any attachments you want to include. Click **OK**. Your changes are saved and the Tracked Activity dialog box closes.
To respond to an Activity

1. View the Activity to which you want to respond. The Tracked Activity dialog box appears.

2. Update the Tracked Activity with any new information you need to add (for example, specify values for User Fields, add or remove links, etc.).

3. From the File or Actions menu, choose the transaction that you want to perform (for example, **Respond**, **Approve**, or **Reject**):
   - To perform a transaction that moves the responsibility for the Activity to another user (for example, responding to a Request/Response Activity or approving an Approval Activity), choose the transaction from the Activity’s Actions menu.
   - To save your updates to the Activity without moving the responsibility for the Activity to another user, choose **Save** or **Save with Note** from the Activity’s File menu.

   **Note:** If you are the Responsible User for an Assignment type Activity, the only type of transaction you can perform on the Activity is to update it and then choose Save or Save with Note from the File menu.

   If the transaction you chose allows you to enter a note into the Activity’s history, the appropriate transaction dialog box appears. Otherwise, the Tracked Activity dialog box closes.

4. Type the note that you want to include in the Activity’s history and add any attachments you want to include.

5. Click **OK**.

   The Send Notification E-mail dialog might be displayed depending on the email notification setup done by the Project Author.

   **Notes**  
   - If you are responding to an Approval type Activity that requires authentication for each action, the Re-authenticate dialog box appears before the notification dialog appears. Enter this information and then click **OK** to proceed.

   If your response to an Approval Activity would move the Activity to the next step in the approval process and one or more required fields have not yet been filled out for the Activity, a message appears that indicates which fields require a value. The Activity cannot proceed to the next state until the listed fields...
are updated by users who have access to edit those fields.

6. Type the note (if any) that you want to add to the notification about your response to the Activity.

7. Click Send.

**Bulk Update for Tracked Activities**

In some cases the same update needs to be made to many Tracked Activities at the same time. You can perform this transaction from My Activities tab in My Dashboard, Activity Log pages on the project's Dashboard tab or Search Result in My Dashboard.

To respond to Activities in bulk:

1. View the Activities to which you want to respond from My Activities tab or Activity log pages.

2. Select the tracked activities, right-click and then choose Transition.

3. Fill out the Tracked Activities Bulk Update dialog box.

4. Click Save/Quick Save/OK.

   One of these buttons is dynamically displayed depending on the email notification setup done by the Project Author. Accordingly, the Send Notification E-mail dialog might be displayed.

5. Fill out the Send Notification E-mail dialog box. Click Send All.
Using the project calendar

The project calendar is a tool for viewing and coordinating the work of Centric Project team members. It allows project participants who are based in different geographic locations and who use dissimilar calendar tools to go to one place to reference date-specific project information.

The project calendar is not intended to replace your personal or corporate calendar; instead, it shows you specific date-based events that are associated with your project such as meetings, project milestones, and Activities that have due dates. You can view and share calendar information with project team members even if they are using different calendar technologies than you are.

Note: If you use Microsoft Outlook and have installed the Centric Project Add-in for Microsoft Outlook, the items that appear in your Centric Project calendar can also appear automatically in your Outlook calendar. For more information, see, “Installing the User Tools” on page 34.

Use the project calendar to

- View events (meetings, milestones, and Activities with due dates) that affect your schedule.
- Schedule meetings, recurrence meetings, phone conferences, and web conferences.
- Review the meetings that are scheduled on particular days, weeks, or months.
- Set or review important project milestones.

The project calendar offers two views: a monthly view and a daily view. You can switch between these two views by clicking the Monthly View and Daily View tabs on the project calendar page.

The monthly view displays the calendar for an entire month at once. If a day in the month has an event (a meeting, milestone, or due Activity), the event appears as one line of information in the box for that day. When you view the current month, the currently selected day is highlighted in yellow. Today’s date (if different from the currently selected day) is highlighted in gray.
The daily view provides detailed project information for a single day. At the top of the Daily view page is a list of all events that are due on the current day for which there is not a specified time (for example, milestones and due Activities). Beneath that list is the area where meetings with scheduled times are listed. On the right side of the daily view is a date selector that lets you chose another date to view.
To view the project calendar

1. On the Dashboard tab, click the Calendar button (or, from the View menu, choose Tab ➤ Dashboard ➤ Calendar).
   The Project Calendar page appears in the right frame of the Dashboard tab.

2. Choose the calendar view that you want to see:
   - To see the monthly view, click the Monthly View tab.
   - To see the daily view, click the Daily View tab.

3. To view details about any meeting, milestone, or Activity that appears in the calendar, click the item’s link. Information for the item appears in a details dialog box.

To navigate in the monthly view

The project calendar’s monthly view displays meetings, milestones, and your Activities with due dates for the entire selected month. If you are viewing the current month, today’s date is highlighted in yellow. If you have a date other than today selected in the calendar’s daily view, the selected day is highlighted in yellow and today’s date is highlighted in gray.

You can select which month you want to see (in the current year, a previous year, or a future year), and you can navigate to the daily view for any day so that you can see more information about that day.

- To view a different month, click the name of the month that you want to see.
- To view the next or previous month, click the < or > buttons beside the month names at the top of the calendar.

   Note: If you are viewing the January calendar and you click the < button, the calendar displays December for the previous year. If you are viewing the December calendar and you click the > button, the calendar displays January for the next year.

- To view the same month in the previous or next year, click the year number at either end of the month selector. For example, if you are viewing the calendar for May 2001 and you click 2002 in the month selector, the calendar displays May 2002.
- To view the full name or description of an item, hover the pointer over the item’s link.
- To view the details for a specific calendar item, click the item’s link.
Note: If there are more items for a day than can fit in a monthly view day box, a More link appears at the bottom of the day box. Click the More link to navigate to the daily view for that day so that you can see all scheduled items for the day.

- To view the daily view for a specific day, click the date number link for the day that you want to view.

To navigate in the daily view

The project calendar’s daily view displays meetings, milestones, and your Activities with due dates for the selected day. You can select which day you want to view (in the current month, a previous month, or a future month), and you can view details about any calendar item (meeting, milestone, or Activity) that appears in the selected day’s calendar.

To view details about an item in the day’s calendar, click the item’s link.

Use the date selector on the right side of the page to navigate in the daily view.

<table>
<thead>
<tr>
<th>S</th>
<th>M</th>
<th>T</th>
<th>W</th>
<th>T</th>
<th>F</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>30</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
</tr>
</tbody>
</table>

In the date selector, today’s date is highlighted in yellow. If you click to select a day other than today, the selected day is highlighted in yellow and today’s date is highlighted in gray.

- To view a different day in the calendar, click the day link for the day that you want to view.
- To view the calendar for today, click the Today button.
- To view a day in a different month, click the < or > buttons next to the month name to move to the previous or next month, then click the day link for the day that you want to view.
Using Connector Hub

Overview of Connector Hub

Connector Hub provides a mechanism to link distant business and engineering information systems. It consists of various remote connectors that automatically upload business information as well as complete design information including product structure and 2D or 3D viewable files.

On a pre-scheduled, event driven, or user-initiated basis, remote Connectors check for changes in source data and automatically update "active" information.

The following diagram gives an overview of how Connector Hub Server, Remote Connectors and Centric Project are related.

Remote Connectors

Translates data from various CAD sources and make that data available for Centric Project users. All your product data can be translated into a single format, enabling users from diverse backgrounds and operating systems to share and access the same data.

Connector Hub Server

Scans and collects unique product data and makes this data available to Centric Project users through the Data Feeds. Working in conjunction...
with the Connector Hub, Remote Connectors collect file information that can be accessed across networks and brought together for product innovation inside Centric Project.

**Note:** For information about Connector Hub setup, please refer the Connector Hub Administrator’s Guide.

### Scenario

The following example explains how the Connector Hub provides a mechanism to link distant business and engineering information for Centric Project users.

Consider two locations A and B, located in two different countries. Location A is a manufacturing hub which has suppliers working on different types of 3D file formats, whereas location B is the design centre that uses Centric Project to manage the projects.

An engineer working for the supplier at location A, creates a CAD assembly for a product and transfers the resultant file to the shared drive as an Information Item Bundle. If the engineer works for a subsidiary company, he would require secure access to this shared drive via FTP or VPN, in order to transfer the file.

The Remote Connector at location A is periodically activated to collect information about any changed files from the shared drive. This would include the published files copied onto this drive in the previous step, among others. This data is then transferred as Information Items for later publication. The time and regularity at which the Remote Connector runs is configured from the Connection Hub.

Centric Project at location B periodically collects any changes exposed in the Centric Connection Hub. Centric Project will then request the Connector Hub to fetch the source file from the Remote Connector for
publication into the Centric Project. These files are then translated by
the Connector and published by the hub. The published data is
synchronized at periodic intervals. The Server makes these files
available to the Design Team and other Centric Project Users through
Data Feeds. Data Feeds provide a mechanism to transfer data from a
Connector Hub to the Centric Project.

Working with Data Feeds

Data Feeds provide a mechanism to transfer data from a Connector Hub
to Centric Project.

A Connector Hub can connect to various Remote Connectors which
expose folders that are attached to a specific Project Elements in a
ProjectArea. The Remote Connector transfers files from the exposed
folders to the Connector Hub which are then exposed as Information
Items and later published in the ProjectArea. The published data is
synchronized at regular intervals.

You can manage Data Feeds by adding, attaching, detaching, importing
and exporting them, attaching Connector files to a Project Element and
publishing Connector files.

Using the Project Browser

The Project Browser displays the current Project. The ProjectArea,
Project, Tabs, and Project Elements are displayed in a tree format.

Note: You can hide the Project Browser by clicking the header.

- Click the + sign adjacent to a ProjectArea to see the current
  project.
- Click the + sign adjacent to the project to see the list of all
  associated Tabs (2-Frame, 3-Frame).
- Click the + sign adjacent to a Tab to see the list of all
  associated Project Elements.

Using the Data Feeds Browser

The Data Feeds section displays the list of Remote Connectors. Click
the + sign to see the list of all Remote Connectors that are currently
being used in projects.

- To add a new Data Feed, right-click Data Feeds and choose
  New Data Feed.
- To delete a Data Feed, right-click Data Feeds and choose
  Delete.
- To export a Data Feed, right-click Data Feeds and choose Export Data Feed.
- To edit Data Feed properties, right-click Data Feeds and choose Properties.
- To export multiple Data Feeds, right-click Data Feeds and choose Export Data Feeds.
- To import Data Feeds, right-click Data Feeds and choose Import Data Feeds.

Adding a New Data Feed

Use the following procedure to add a new Data Feed.

1. Navigate to the Project for which you want to add the Data Feed.
2. From the File menu, choose Project Administration > Data Feeds.
   - or -
   Click Actions and then choose Attach Data Feed.
   The Data Feed dialog box appears.
3. Click Actions and then choose New Data Feed.
   The Add Data Feed dialog box appears.
4. Type the appropriate details and click OK.

Editing Data Feed Properties

Use the following procedure to change any of the properties of an existing Data Feed.

1. Navigate to the Project for which you want to edit the Data Feed.
2. From the File menu, choose Project Administration > Data Feeds.
   The Data Feed dialog box appears.
3. In the list of connectors, right-click the Data Feed and choose Properties.
   The Edit Data Feed dialog box appears.
4. Make the necessary changes to the Data Feed’s properties.
   When you have finished editing the Data Feed’s properties, click OK.
Attaching a Data Feed to a Project Element

Use the following procedure to attach a Data Feed to a Project Element.

1. From the File menu, choose Project Administration > Data Feeds.
   The Data Feed dialog box appears.
2. Select the Project Element from the Project Browser.
3. Select the Remote Connector folder from the Data Feeds Browser.
4. Click the Actions button and choose Attach Data Feed.
   The Project Element and Remote Connector folder icons change to 

Detaching a Data Feed from a Project Element

Use the following procedure to detach a Data Feed from the associated Project Element.

1. From the File menu, choose Project Administration > Data Feeds.
   The Data Feed dialog box appears.
2. Select the Remote Connector folder from the Data Feeds Browser.
3. Right-click (Remote Connector folder) or Project Element and choose Detach.

Importing a Data Feed

Use this procedure to create a new Data Feed by importing a Data Feed from an existing Data Feed export file.

1. If you are importing a Data Feed from another ProjectArea, use Windows Explorer to copy the appropriate Data Feed file (.dfa) to the procsstemplates directory in this ProjectArea.
2. From the File menu, choose Project Administration > Data Feeds.
   The Data Feed dialog box appears.
3. Click Actions and then choose Import.
   The Import Data Feeds dialog box appears.
4. Select the Data Feed that you want to import.
5. Click OK.
Exporting Data Feeds

Use this procedure to create an export file from an existing Data Feed. Data Feed export files are saved in the processtemplates directory in your ProjectArea (with a file extension of .dfa). Once you have created an export file, you can import it into another ProjectArea. You can export one or all Data Feeds depending on the menu option selected.

To export a single Data Feed
1. Navigate to the Project for which you want to export the Data Feed.
2. From the File menu, choose Project Administration > Data Feeds.
   The Data Feed dialog box appears.
3. Click Actions and then choose Export Data Feed.
   The Export Data Feed dialog box appears.
4. Type the name that you want to give the exported Data Feed file.
5. Click OK.
An export file from the Data Feed is created and placed in the processtemplates folder in your ProjectArea.

Manually Publishing Files from a Connector

This section explains how to manually publish the Information Items to Centric Project after attaching a Project Element to a Data Feed. You have to initiate the translation of the Connector Hub files before publishing the Information Items. The Connector Hub allows you to choose either incremental or full translations for each Remote Connector. An incremental translation only translates new or modified source data and is faster than a full translation. A full translation will purge your Connector Hub database and retranslate all data, but can take longer than an incremental translation.

You can also schedule the translation and publishing activities.

To publish the Information Items to Centric Project
1. Login to the Windows server that Centric Project is installed on using a Windows Administrative account.
2. Open the command prompt and navigate to the folder that contains ConnectorInfoItemPublisher.exe.
Note: Typically this will be located in the: <CP Install dir>/
<ProjectArea name>/web/bin

3. From the **command prompt** run the following command:

\[ \text{ConnectorInfoItemPublisher.exe /u <username> /p} \]
\[ \text{/s <ProjectArea_ID>} \]

**Note:** ProjectArea_ID can be found in the Register Editor under
HKEY_LOCAL_MACHINE\SOFTWARE\Framework Technologies Corporation \ApServer\ApSettings\3

Any file in the mapped remote folder is automatically published to
the CentricProject Project Element specified in the Data Feed mapping.

### Scheduling Publishing of Files from a Connector

This section explains how to schedule the publishing of Connector files.

1. Login to the Windows server that Centric Project is installed
on using a Windows Administrative account.

2. Click **Start**, click **All Programs**, point to **Accessories**, point
to **System Tools**, and then click **Scheduled Tasks**.

3. Double-click **Add Scheduled Task**.

4. Click **Next**.

5. Click **Browse** and navigate to the folder that contains
**ConnectorInfoItemPublisher.exe**.

**Note:** Typically this will be located in the: <CP Install
dir>/<ProjectArea name>/web/bin

Follow the instructions in the Scheduled Task Wizard to define the schedule.
Centric Process™ User Guide
Welcome to Centric Process

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is Centric Process?</td>
<td>90</td>
</tr>
<tr>
<td>The benefits of using Centric Process</td>
<td>92</td>
</tr>
<tr>
<td>Who uses Centric Process?</td>
<td>93</td>
</tr>
<tr>
<td>System requirements</td>
<td>94</td>
</tr>
<tr>
<td>Using this guide</td>
<td>95</td>
</tr>
</tbody>
</table>
What is Centric Process?

Centric Process™ supports gated process methodologies to help you organize and execute projects. Centric Process is fully configurable, letting you implement any variant of the widely adopted gated process methodologies.

With Centric Process, you build a roadmap (or template) of your project process, organizing key deliverables and decisions into a series of Work Periods and Decision Points, and then use this template as the top-level process for executing and monitoring your projects.

As one part of the Centric Project family, Centric Process seamlessly draws your team members into the coordinated project and minimizes the need for additional team training.

- Centric Project functions as the foundation, providing a collaborative workspace in which you share information and resolve issues.
- Centric Process provides an organizational Centric Software for running gated projects
- Centric Portfolio provides a high-level viewpoint for the evaluation and comparison of all project activity, based on real-time Centric Project and Centric Process data.

What is a gated process?

A gated process is a plan for executing your project that carefully lays out project tasks and review points in a way that wrings out project risk as early as possible, minimizing costly investment in dead-end projects, and that provides a logical sequence of tasks and reviews to ensure quality project execution and minimize project mistakes.

Gated processes are a fundamental business methodology for running any type of project. Project Managers recognize that it makes good business sense to break large projects into smaller well-defined units of work. There is nothing new about this “divide and conquer” approach. What is new in modern gated processes is the laser-focus on critical project review, with the goals of reducing project risk and increasing predictability and quality.

Gated project methodologies have been widely accepted as the best way to manage product introduction projects. As market pressures for speed and innovation have increased during the last decade, the majority of product development businesses have adopted gated project methodologies. The term “product” in this context applies equally to cars, televisions, boats, pharmaceuticals, and skyscrapers. Similarly,
gated project methodologies apply equally to all industries that develop products.

**An example of a gated process**

The components and concepts of gated processes are very simple. A gated process consists of a series of Work Periods (sometimes called Stages or Phases), where project work is assigned and completed. The major units of work are generally called Deliverables. Interspersed in the series of Work Periods are Decision Points (also known as Gates or Reviews) where specific questions must be answered before the project can proceed. These questions are often called Decision Criteria. This diagram shows a sample gated process, as it appears in a Centric Project workspace that is using the Centric Process module:

This sample gated process has five Work Periods (represented in the diagram by rectangles) that take a product from initial concept to completion, separated by Decision Points (represented by diamonds) where the project receives critical review. Each Work Period usually contains one or more Deliverables. Each Decision Point usually contains one or more Decision Criteria.

The first blue rectangle in this diagram represents the Initial Concept Work Period. Typical Deliverables of this early project phase might include high-level concept descriptions and research. The following diamond shape represents the Concept Evaluation Decision Point. At this point in the project, the Deliverables of the previous Work Period are evaluated and the concept is screened before further investment is made in the idea. The rest of the diagram represents the remaining Work Periods and Decision Points in the sample product introduction process.

As indicated by the arrows between Work Periods and Decision Points in the diagram, a gated process moves sequentially from left to right; however, certain project condition might require you to redo a previous state, skip a future state, put the project on hold, or terminate the project.
The benefits of using Centric Process

Companies frequently develop process standards, but often have difficulty getting those standards to be adopted. Centric Process is a highly effective vehicle for deploying your gated product introduction process, to ensure that you can fully enjoy the benefits of a standardized optimized process. Your gated project process is the embodiment of your company’s best practices and organizational knowledge. Adopting this process will help you repeat the successes of your best projects and avoid the mistakes of your worst.

Centric Process gives you the ability to share your project process with your entire team, which helps them understand your goals and increases your ability to keep the team “rowing in the same direction.”

Centric Process is a self-documenting system that fosters accountability among project team members and project managers, and makes apples-to-apples project comparisons and analysis possible in the Centric Portfolio module.

Finally, if you currently use Centric Project, Centric Process leverages your resource and educational investment. Centric Project, Centric Process, and Centric Portfolio together form a powerful vertically integrated system for improving your product introduction process.
Who uses Centric Process?

Project Managers are the primary day-to-day users of Centric Process. Centric Process helps Project Managers organize, coordinate, and track the work of their project team. Project Managers can also designate one or more Assistants who can act on their behalf.

The project team uses Centric Process every day. Team members work on Deliverables that appear in their My Dashboard worklists (just as any other Centric Project Tracked Activity).

Executives are responsible for evaluating and making critical decisions about projects. Centric Process provides accurate project information, facilitating better decision-making. Executives also function as Decision Makers at Decision Points in the process.

Administrators install and maintain Centric Process. Together with Project Managers and Assistants, Administrators configure process terminology, definitions, and templates.
System requirements

To be able to use Centric Process, Centric Project must be installed on your server and the Centric Process modules must be enabled on the Centric Project server. For more information about enabling application modules, refer to the Centric Project Platform Administrator Guide.

Complete Centric Project hardware and software requirements are included in the Centric Project Readme file (Readme.html), which is available on your Centric Project CD in the ProjectServer directory.
Using this guide

The *Centric Process User Guide* includes the following chapters:

**Welcome to Centric Process** provides an overview of the Centric Process module. It includes an example of a gated process designed with Centric Process, describes the benefits and users of Centric Process, and lists the requirements for using Centric Process.

**Designing your gated process** provides design guidelines and considerations to keep in mind when designing your gated process for Centric Process. It also includes descriptions of the component “building blocks” of a Centric Process gated process.

**Installing Centric Process** includes instructions for installing Centric Process on your Centric Project Server.

**Using Centric Process** describes how to use Centric Process once you’ve designed your gated process on paper. It also describes how to use Centric Process in your project workspaces once your process templates are built. It includes the procedures for adding a process to a Centric Project project workspace and setting user access for your team. It also gives an overview of how to work with a process, including making process transitions, accessing process-related commands, and updating process information.
Designing your gated process

In this chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning your gated process design</td>
<td>98</td>
</tr>
<tr>
<td>The components of a Centric Process gated process</td>
<td>100</td>
</tr>
</tbody>
</table>
Planning your gated process design

Before you can begin to use Centric Process, you need to record your current processes or design new processes that reflect your business needs. Most companies use a small number of processes, often one process for each type of project. For example, you might have one process for new product introductions, another for product enhancements, and a third for manufacturing infrastructure improvements. Typically, companies define and use from one to four formal gated processes.

Although the components of a gated process are easy to understand and Centric Process makes it easy to quickly set up and begin using a process template, taking the time now to thoroughly understand your current processes, make adjustments if necessary, or create new processes will give you the best results.

Designing your process requires great care to achieve its goals. Industry experts and business process consultants offer gated methodologies that are adapted for specific industries or that put emphasis on different factors contributing to product introduction success. Although the terminologies and process flows of these methodologies may differ, they are all built from the same components: Work Periods, Deliverables, Decision Points, and Decision Criteria.

Excellent books are available that describe these methodologies, and offer guidelines for adapting them to your company’s particular needs. Of course, each business has different needs; there is no one-size-fits-all gated process. We recommend these books and the use of business consultants to help develop and tune your product processes.

Once you have clear and complete definitions of your processes, it’s a simple matter to lay out your processes in Centric Process, using your own steps and terminology, to deploy it more effectively. The following section offers some design guidelines that will help you think about and lay out your process.

Design guidelines

Consider the following guidelines as you review your current processes or begin to plan new processes:

- Consider how your process flows and the states you need to create in Centric Process to best reflect your process. The typical layout of a gated process is Work Period, Decision Point, Work Period, Decision Point, etc.; however, Centric Process supports any combination of Work Periods and Decision Points.
Design your process to wring out project risk as early as possible. This will minimize continued investment in dead-end projects, allowing scarce resources to be allocated to efforts that are more promising.

In Work Periods that occur early in the process, assign as few Deliverables as necessary to provide the information needed to make critical decisions at the succeeding Decision Points. This limits the amount of investment you make in the project in its early stages while still giving you the information you need to assess the project’s value at each Decision Point.

Lay out a logical sequence of Work Periods and Decision Points that will ensure quality project execution and minimize project mistakes. Obviously, some tasks need to be completed before others are begun and some activities require collaborative execution and review to ensure results. Your gated process should reflect your company’s organizational knowledge and best practices.

At each Decision Point, ask questions that assess the quality and completeness of the work in the previous Work Period.

At each Decision Point, ask questions about the value of continuing the project. Always keep the big picture in mind. Market conditions may be changing, initial estimates may now be less optimistic, technical problems may be increasing the risk of your project, or other more promising projects may be short of resources. Even though your team is functioning flawlessly, it might be in your company’s best interest to put the project on hold, or terminate it.

At each Decision Point, consider how well the project supports key business objectives. You may also want to establish Metrics and Decision Criteria that support useful project comparisons.

Use these guidelines and your company’s existing process documentation (if any) to create an outline of your process with a word processor. This outline lets you see your process at a glance, share it with others for review, and easily make quick adjustments. Once you’re satisfied with the outline, you can begin to create a process template with Centric Process.
The components of a Centric Process gated process

This section describes the components of a gated process and the information that you will define and configure when you define your process with Centric Process. For the sake of explanation, this section uses the default Centric Process terminology for each component. You will be able to configure your own terminology for most of these components with Centric Process before you begin using it.

Process templates

Before using Centric Process, you must capture your process standards as process templates. You can create as many templates as you have types of processes.

Process templates provide a way for your company to standardize project execution methodologies by allowing you to create one or more standard process templates that can be used in any project in your company. Although project Authors can create their own processes in projects that include the Process feature, creating and using templates offers you these benefits:

- Encourages the standardization of project execution methodology throughout your company
- Encourages the use of standard reporting indicators (for those using the Centric Portfolio module)
- Allows you to more quickly and easily create new standard process templates by basing them on existing processes
- Makes it easier to change current standard processes and make those changes available to future projects

When you create a template, you can specify as much or as little information as you want to standardize, making the template as detailed as you need. For example, you can create a template that includes Work Periods, Decision Points, Deliverables, Metrics, Decision Criteria, and User Fields, or you can create a template that includes only Work Periods and Decision Points.

You create your process template on the Templates page of ProjectArea Administration. Lay out your gated process by inserting Work Periods and Decision Points, and then add as much detail as you want to each.

Work Periods

Work Periods are periods in a process during which one or more Deliverables must be completed. Work Periods are used to organize
Deliverables into a logical sequence of work. Work Periods are often called project “Steps,” “Phases,” or “Stages.”

A typical gated process contains four to eight Work Periods, each containing a number of Deliverables. Each Work Period and each Deliverable within the Work Period can have one or more User Fields that allow you to track the progress of the Work Period or Deliverable.

**Deliverables**

Deliverables are the top-level tasks in your gated process. Each Work Period typically contains two to eight Deliverables. In Work Periods that occur early in the process, Deliverables may be relatively small in scope and may be completed by one person. In later Work Periods, each Deliverable may represent a larger body of work, which is broken down into many smaller assignments that are completed in the course of satisfying the Deliverable. For example, the detailed design of a product may be a single Deliverable in a Work Period that is to be accomplished by a team of people.

Deliverables are often the responsibility of a discipline lead, like an engineering or manufacturing manager. This person is called the responsible user. The responsible user is responsible for updating the Deliverable status and attaching any supporting documents or information to the Deliverable.

**User Fields**

User Fields are used to report progress on a Work Period or Deliverable. The most common User Field for progress reporting is % Complete. This User Field is automatically included in each Work Period and Deliverable. You can define additional User Fields for Deliverables and Work Periods as a mechanism for reporting any type of information you wish to track. For example, if you create a “Person Hours Expended” User Field, you can add that User Field to each Work Period and/or Deliverable in your process. User Field values are not connected to each other, so updating the “Person Hours Expended” User Fields for one Deliverable in the process does not affect the value of that User Field in any other Deliverable or Work Period. You can create User Fields that accept Yes/No, list, text, currency, date, integer, or number values.

The process’ Project Manager or Assistants can update the value for each Work Period User Field for the current or future Work Periods. The Project Manager, Assistants, or the responsible user can update the value for each Deliverable User Field for Deliverables in the current or future Work Periods.
Decision Points

Decision Points are formal reviews in a gated process where the Deliverables of the previous Work Period are evaluated and the overall merits of the project are re-assessed to determine whether the project should continue as planned. Decision Points are also called project “Reviews,” or “Gates.” Each Decision Point can have one or more Decision Criteria.

Decision Criteria

Decision Criteria are the questions that you must answer at each Decision Point before your project can proceed to the next state in the process. These questions are the key to achieving your gated process goals and should be designed with care. The answers to these questions may take a number of different forms. For example, the criteria, “Does this project support our strategic objectives?” may be answered with a “Yes” or a “No”, whereas the question, “To what degree does this product support our strategic objectives?” may be answered as “High,” “Medium,” or “Low.” The most common types of Decision Criteria are Yes/No and List types, but you can also create Decision Criteria that accept text, currency, date, integer, or number values.

You can add Decision Criterion definitions to as many Decision Points in your process as you need. For example, if you create a “Strategic Importance” Decision Criterion, you can add that Decision Criterion to each Decision Point in your process.

Metrics

Metrics are project-level variables whose values are typically set and updated during the project at designated Work Periods and Decision Points. You can create Metrics that accept Yes/No, list, text, currency, date, integer, or number values.

Examples of Metrics include “Estimated Commercial Value,” “Cost to Complete,” and “Probability of Technical Success.” Each of these Metrics measures some aspect of the entire project rather than a technical characteristic of the product. For example, “Expected Commercial Value” (ECV) is used to describe the ultimate marketplace value of a project or product measured in dollars. ECV might have one value in an early Work Period in the project, but its value may be updated with better estimates over the course of the project. The Project Manager and Assistants can update the value for ECV at any point in the project, but the gated process indicates that the value should be updated in specific Work Periods and Decision Points.
If your company has purchased and installed the optional Centric Portfolio module, you can include Metrics in portfolio report definitions and project users with access to the Portfolio Analysis tab of the My Dashboard window can analyze current and past Metric values across a portfolio of projects.
Using Centric Process

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Centric Process</td>
<td>106</td>
</tr>
<tr>
<td>Specifying Centric Process terminology</td>
<td>107</td>
</tr>
<tr>
<td>Creating process definitions</td>
<td>108</td>
</tr>
<tr>
<td>Creating process templates</td>
<td>109</td>
</tr>
<tr>
<td>Adding a process to your project</td>
<td>112</td>
</tr>
<tr>
<td>Setting user permissions for your team</td>
<td>114</td>
</tr>
<tr>
<td>Running a process</td>
<td>115</td>
</tr>
<tr>
<td>Using the Process Journal</td>
<td>120</td>
</tr>
<tr>
<td>Understanding process transitions</td>
<td>121</td>
</tr>
<tr>
<td>Understanding process roles and permissions</td>
<td>124</td>
</tr>
<tr>
<td>Using Microsoft Project with Centric Process</td>
<td>126</td>
</tr>
</tbody>
</table>
Configuring Centric Process

Once you’ve designed your gated process on paper by creating an outline of the process, configuring Centric Process is straightforward. Using your outline as a guide, you define the Work Periods, Decision Points, Deliverables, and process definitions that you use in your process.

To configure Centric Process, you use ProjectArea Administration. Although there is a great deal of flexibility in how you can configure Centric Process, the following steps provide a typical sequence.

1. Define your process terminology
2. Create process definitions, including Metrics, Decision Criteria, and User Fields
3. Create process templates

Each of these steps is described in more in the following sections.
Specifying Centric Process terminology

You can configure Centric Process to use your company’s gated process terminology, including the terms your company uses for concepts such as Work Periods, Decision Points, Decision Makers, and process transitions.

The terminology you choose will replace the default terminology in Centric Process and in Centric Portfolio.

You specify process terminology on the Terminology page of ProjectArea Administration.

To specify the process terms

1. From the File menu, choose ProjectArea Administration ➤ Terminology.
   The Terminology dialog box appears.
2. Use the tabs to view the current terms and to modify the terms as needed.
3. When you are finished viewing or modifying the terms, click OK.
   ProjectArea Administration updates the project interfaces with the changes you made.

ProjectArea Administration updates the affected interfaces with the changes you have made. For more information about editing process terminology, refer to ProjectArea Administration Help.
Creating process definitions

Process definitions include the Decision Criteria, User Fields, and Metrics that you will apply to Work Periods, Decision Points, and Deliverables in your process templates.

Each process definition you add can be designated as a Decision Criterion, User Field, or Metric, or any combination of these types. For example, you can create a “Person Hours Expended” definition and select to use it as a process Metric and a User Field.

Once you create a definition, it is available to any process template in the ProjectArea, ensuring consistency of definitions across projects.

You create and maintain process definitions on the Definitions page of ProjectArea Administration.

To create process definitions

1. From the File menu, choose ProjectArea Administration  Definitions. The ProjectArea Definitions dialog box appears.
2. Click Actions and then choose New. The New Definition dialog box appears.
3. Specify the name, type, descriptions, and usage for the definition.
4. Click OK.

For more information about creating and editing process definitions, refer to ProjectArea Administration Help.
Creating process templates

You begin your template by giving it a name (such as “New Product Introduction”) and a description. You then begin adding Work Periods, Deliverables, Decision Points, Decision Criteria, Metrics, and User Fields. As you work, your changes are automatically saved, so you don’t have to worry about forgetting to save your changes.

While you are working on a template, the template is “disabled.” When you have completed the template and you are ready for Project Managers to use it on their projects, you “enable” the template to make it available to Project Managers. Once a template has been enabled, a Project Manager can use it to add a process to his or her Centric Project project workspace.

After a template has been associated with a project (instantiated), changes made to the template in ProjectArea Administration do not affect the instantiated process. Similarly, changes that the Project Manager or Assistants make to the process in a particular project do not affect other projects that are based on the same template and do not affect the original template itself.

You can import and export templates so that you can create them in one ProjectArea and use them in another.

You add and define process template on the Templates page of ProjectArea Administration.

Creating a process template involves many steps, as outlined below. You can create a template in a single sitting, or work on a template over the course of many days, weeks, or months. Although the outline below suggests a certain order for the steps, you can perform most of them in any order that works best for you. After you start the template (step 1), you can add and edit the rest of the information in any order in which you choose.

To add a process template

1. From the File menu, choose ProjectArea Administration > Process Templates. The Process Templates dialog box appears.
2. Click Actions and then choose New. The New Template dialog box appears.
3. Enter the name and description for the new template.
4. Click OK.
The new template appears in list of templates at the top of the page with a status of **Disabled**.

5. In the list of Process Templates, click the template you created to display it in the Template Editor at the bottom of the dialog box.

6. Edit the process’ properties (name, description, locks, and reference material link) by clicking the **Edit** button on the process’ General tab.

7. Add Work Periods and Decision Points by clicking the **Actions** button below the process flow diagram.

8. Edit Work Periods. For each Work Period, you can
   - Edit the Work Period properties.
   - Add, edit, or remove Deliverables.
   - Add or remove User Fields.
   - Select which Metrics apply.

9. Edit Decision Points. For each Decision Point, you can
   - Edit the Decision Point properties.
   - Add or remove Decision Criteria.
   - Select which Metrics apply.

10. When the template is complete, make it available to project Authors to use on projects.

For more information about creating and editing process templates, refer to ProjectArea Administration Help.

**Process template locks**

Process locks give you the ability to control how much flexibility a Project Manager has while running a project. You can lock or unlock Decision Criteria, Metrics, Deliverables, and the Process itself.

When you lock a portion of the template, the Project Manager of a project that is using a process based on the template cannot make certain changes to the locked portion. This provides a way for your company to enforce a certain level of consistency in instantiated processes.

Process locks are part of the process’ properties, which you can view and edit by clicking the **Edit** button on the process’ General tab in the Template Editor.

The following table describes the effects of each process template lock.
**Note:** If the Project Manager for a process that uses a template with locks is also a Project Area Administrator, the Project Manager can turn off these locks from within the project by editing the process’ properties.

<table>
<thead>
<tr>
<th>If you lock this part of the template</th>
<th>Project Managers cannot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>Edit the process’ name and description</td>
</tr>
<tr>
<td></td>
<td>Edit the names and descriptions of the process’ Work Periods and Decision Points</td>
</tr>
<tr>
<td></td>
<td>Change the order of Work Periods and Decision Points in the process</td>
</tr>
<tr>
<td></td>
<td>Add or remove Work Periods or Decision Points</td>
</tr>
<tr>
<td></td>
<td>Add or remove Work Period User Fields</td>
</tr>
<tr>
<td>Deliverables</td>
<td>Remove Deliverables that were defined as part of the template</td>
</tr>
<tr>
<td></td>
<td>Edit the name or description of any Deliverables that were defined as part of the template</td>
</tr>
<tr>
<td></td>
<td>Add or remove Deliverable User Fields for Deliverables that were defined as part of the template</td>
</tr>
<tr>
<td>Metrics</td>
<td>Remove Metrics that were defined as part of the template</td>
</tr>
<tr>
<td></td>
<td>Change at which Work Periods and Decision Points each Metric is applied</td>
</tr>
<tr>
<td>Decision Criteria</td>
<td>Remove Decision Criteria that were defined as part of the template</td>
</tr>
<tr>
<td></td>
<td>Change at which Decision Points each Decision Criterion is used</td>
</tr>
</tbody>
</table>
Adding a process to your project

After you’ve installed and configured Centric Process, you are ready to use gated processes on your Centric Project project workspaces. You add a process to a project workspace by adding the Process feature to your project’s Dashboard tab. If your project doesn’t already include a Dashboard tab, add it first, and then use the following procedure to add the Process feature to the Dashboard tab.

**Note:** To add a process to your project, you must have Author permission for the project.

To add the Process feature to the Dashboard tab

1. From the Layout menu, choose Dashboard Feature ➤ Insert Feature ➤ Process (or right-click the left-frame of the Dashboard tab and then choose Insert Feature ➤ Process).

   **Note:** To add the Process feature, the Dashboard tab must also include the Calendar feature. If the Dashboard tab does not already include the Calendar feature, a message appears that tells you that the Calendar feature will be automatically enabled. To add the Calendar and Process features, click OK.

   The Template Browser dialog box appears.

2. Select the template you want to use to create the process. If no process templates have been defined for the ProjectArea, or if you want to create a process from scratch, select **<Blank Process>**.

   **Note:** If the template you want doesn’t appear here, it may not have been enabled for project use. To have a template enabled, contact your ProjectArea Administrator.

3. Click OK. If the process template you chose is linked to one or more charter templates, the Template Browser dialog box appears again.

4. Choose whether you want to also add a charter to the project:
   - To add a linked charter, select the charter from the list of charter templates and then click OK.
   - To add the process without adding a charter, click Cancel.

   **Note:** If your project already has a charter and it contains cells that are mapped to process information (for
Using Centric Process

example, Metrics), Centric Project attempts to map those charter cells to information in the process you have added. If it is unable to map a cell to the process, the charter cell is displayed as an invalid mapping.

5. Click **OK**. Centric Project adds the Process feature to the Dashboard tab and displays the Set Permissions dialog box so that you can set user permissions for the new feature. For more information, see “Setting user permissions for your team,” on page 114.

   **Note:** The Set Permissions dialog box does not appear if you selected the **Don’t ask again in this browser session** check box in the Set Permissions dialog box anytime during this browser session.

6. The Process page displays a process based on the template you selected. By default, you are specified as the Project Manager for the process.

   Once you have added the Process feature, you can modify the process by editing, adding, removing, and moving process information. For more information, see Centric Project Workspace Help.

   **Note:** If the process is based on a template that has one or more locks, you may not be able to edit all parts of the template unless you have Administrator rights to the ProjectArea. For more information, see “Process template locks,” on page 110.

**Using web templates to add a process**

Another way to create a project with a gated process is to use a web template that already includes a process. Web templates store a project’s data organization and features for quick reuse. If you create a project that has a process and then archive the project as a web template, projects created from the Web Template will automatically include the process in the original project. For information about creating web templates, see ProjectArea Administration Help.

Your Web Template can also include a Microsoft Project schedule file that has been integrated with the gated process. For more information about using Microsoft Project schedules with your processes, see “Using Microsoft Project with Centric Process,” on page 126.
Setting user permissions for your team

When you add the Process feature to a Dashboard tab, you are given the opportunity to set user permissions for the Process feature. You can set permissions then, or later, using Project Administration. Here are some guidelines for setting permissions to process team members:

- Give team members View Process access if you want them to see the process and its data. Team members with View Process permission and who are not the Project Manager or an Assistant cannot edit the process.
  
  Note that team members do not need to have View Process permission in order to be responsible users for process Deliverables because Deliverables are available in each responsible user’s My Dashboard window.

- A Project Manager must first have Author permission on the project. There can only be one Project Manager per project.

- Assistants must have access to the project and have View Process permission for the Process page. If the Assistants are not project Authors, they cannot edit the process. There can be more than one Assistant on a project.

- Decision Makers must be project users, but do not need to have access to the Process page or even to any tabs within the project. Through e-mail notifications, they receive news about Decision Point meetings and access to the appropriate Decision Point report.
Running a process

Once you have added the process to your project and set access for your team, you are ready to begin running your process.

On the Process page, the process flow diagram at the top of the page gives you at-a-glance information about the status of your process. You also use the process flow diagram to navigate to a specific point in the process to view or edit process information.

We’ll use the following sample process flow diagram to describe the steps to execute a sample process:

![Sample Process Flow Diagram]

Begin at Start

When you first add a process to your project, the process is at Start. You can tell this because the label “Current” appears on the “Start” icon in the process flow diagram that appears at the top of the Process page.

As you move through your process, the “Current” label always indicates where you are in the process.

After you add a process from a process template, the process layout may be complete, but Decision Makers have not been specified and estimated dates have not been set. You can fill in this detail as you move through your process, or you can specify it now for future states in the process (you cannot make changes to past Work Periods or Decision Points). Once you have moved through a state in your process, Centric Process becomes a useful record of your project activities and decision-making.

Process selection

The dotted outline in the process flow diagram indicates the current selection. When you select a portion of the process in the process flow...
To select a Work Period or Decision Point, click its icon in the process flow diagram. The following process flow diagram shows a Work Period selected.

To select the entire process (as in the sample at the beginning of this section, on page 115), click the Start or End icons, or click anywhere outside of the Work Periods and Decision Points.

**Proceed to Work Period One**

Use the “Proceed” transition to move the process forward to the next Work Period or Decision Point in the process.

“Proceed” is the most common transition you will use to move through your process, but other process transitions are also available, including the options to skip over one or more states, recycle to a previous state, hold at the current state, resume at the current state, or kill the project. For a description of each transition, see “Understanding process transitions,” on page 121.

**Accessing Centric Process commands**

Transitions are some of the commands available for running and editing the process. To access these and other process-related commands, you can use menus on the Centric Project menu bar, the process shortcut menus, and the process tab buttons.

- **Centric Project menu bar** – First click to select an icon in the process flow diagram, then, from the Actions menu, choose Process and then choose the command you want.
- **Shortcut menus**—Right-click an icon in the process flow diagram and then choose the command you want.

- **Tab buttons**—Each Process page tab contains a button (often called Actions) that gives you access to commands available for the tab. Click the button and then choose the command you want.

**Set estimated dates**

Centric Process includes a simple system for managing your process dates. You can estimate the dates of future Work Periods and Deliverables and, as you make changes to these dates, the changes can be propagated forward, reducing the manual effort to keep your dates self-consistent. You can share estimated end dates for Work Periods with your entire team by selecting to include them on the project calendar.

Start and end dates are shown above each Work Period in the process flow diagram. Actual dates appear in black and estimated dates (if entered) appear in blue.

When you first add a process to your project workspace, there are no dates associated with your process. As you move through your process, actual dates appear above the corresponding icons in the process flow diagram. Use the Edit Estimated Dates dialog box to enter and modify estimated dates for some or all of the Work Periods in your process.

**Notes**

- Decision Points do not have actual dates only. The duration of a Decision Point is generally brief, usually based on the time it takes to pull the Decision Makers together for a meeting.
- Projects are generally planned around the larger periods of time dedicated to work, with the assumption that there will be little or no interruption between those periods.
- You can run a process without entering estimated dates. When you transition from state to state in the process, Centric Process records the actual start and end dates for each Work Period and Decision Point.
- If you use Microsoft Project to generate a schedule for the process, you can specify Work Period estimated dates by associating the Microsoft Project schedule with the process.
When you enter estimated dates for any Work Period, Deliverables in that Work Period that do not already have a due date specified assume the Work Period’s estimated date as their due date. You can edit Deliverable due dates separately.

Assign and track Deliverables
Deliverables are the key component of each Work Period. Before work begins in a Work Period, you will typically assign each Deliverable to a responsible user. Responsible users see and work on their Deliverables from their My Dashboard window. They can update the Deliverable status, and add notes and attachments to Centric Project information or external files.

When the responsible user sets the % Complete User Field for the Deliverable to 100%, the Deliverable appears in the Project Manager’s worklist. The Project Manager can then accept the Deliverable or reduce the % Complete value, add a note, and send the Deliverable back for more work.

You can transition out of a Work Period before all Deliverables in the Work Period have been accepted. Any Deliverables that have not been accepted at the time of the transition are carried over to the next Work Period.

Note: You can also explicitly skip any Deliverable in a Work Period. Deliverables skipped this way do not carry over to the next Work Period.

Proceed to Decision Point One
After completing the Deliverables in Work Period One (in the example above), you use a Proceed transition to move to Decision Point One.

The purpose of a Decision Point is to decide how or whether to proceed with the project. The Project Manager and the Decision Makers typically make this decision together in one or more Decision Point meetings, where they come to agreement on the Decision Point’s Decision Criteria. After the Decision Point meeting, the Project
Manager updates the Decision Criteria for the Decision Point in Centric Process to record the conclusions of the Decision Makers.

The list of Decision Makers is part of the Decision Point’s properties. You can add or change the list of Decision Makers for the current or a future Decision Point by editing the properties for the Decision Point.

- **Note:** Decision Makers don’t need to be Centric Project users, but if they are, they will have access to the project information that supports and describes the Deliverables and process. In either case, they receive news about Decision Point meetings and access to the appropriate Decision Point report through e-mail notifications.

You can schedule one or more Decision Point meetings for each Decision Point with Centric Process. When you use Centric Process to schedule a Decision Point meeting, the meeting appears on the Meetings tab for the Decision Point on the Process page, in the Centric Project calendar, and in the Important Events list in the My Dashboard window for all meeting attendees that are Centric process users. For meeting attendees who are using the Centric Project Add-in for Microsoft Outlook, the meeting also appears in their Outlook calendar.

### Proceed through the process to End

Continue moving through Work Periods and Decision Points by using process transitions and updating process information as you proceed. During Work Periods, update Deliverables and Metric and User Field values. During Decision Points, attend Decision Point meetings and update Metric and Decision Criteria values.

Depending on the status of this and other projects in your company, you may proceed sequentially through each Work Period and Decision Point to the end, or you may need to use a different transition to skip, recycle, put on hold, or even kill the project.

Regardless of when you stop the process, if you archive your project, all of your process (and project) information is preserved.
Using the Process Journal

The Process Journal is a record of important process events and notes added by the Project Manager or an Assistant.

Whenever the Project Manager or Assistants make a process transition, enter or edit process dates, or update Metrics, Centric Process automatically adds an entry to the journal that describes the action that was taken.

The Journal tabs on the Process page display the journal entries that apply to the selected portion of the process. For example, when the entire process is selected, the Journal tab shows all entries for the process. When a specific Work Period is selected, the Journal tab automatically shows only those journal entries that were entered at that Work Period. Although the Journal tab for a specific Work Period or Decision Point automatically shows you only those entries that were entered at that state, you can always select to see all Journal entries by clicking the Actions button and then choosing Whole Process.

The Project Manager or Assistants can also add an extra text note to automatic journal entries to include information about why the change was made and can also add manual notes (indicated by the icon on the Journal tab) at any time to record significant events, decisions, or issues.
Understanding process transitions

You make process transitions to move from one state to the next in the process. For example, to start a process, you make a Proceed transition from the process Start to the process’ first Work Period or Decision Point. Each of the possible process transitions is described below.

**Proceed**

Use the Proceed transition to move the process from one state to another. For example, you use the Proceed transition to

- Start the process by moving it from the process’ Start to the first Work Period or Decision Point in the process.
- Move from the current Work Period or Decision Point to its following state.
- Move from the last Work Period or Decision Point to the process’ End.

When you use the Proceed transition, the “Current” label in the process flow diagram moves to the next state in the process and “In Process” appears above the current state in the process flow diagram.

When you Proceed to a process Work Period, any Deliverables from previous Work Periods that are not accepted or skipped are carried forward to the new Work Period.

If you Proceed to a process Work Period, e-mail notifications that you send include links to the Deliverables due in that Work Period. If you Proceed to a process Decision Point, e-mail notifications that you send include links to the corresponding Decision Point report and to any scheduled Decision Point meetings.

When you use the Proceed transition to move to the process End, the “Current” label moves to the End state and “Finished” appears above the End icon in the process flow diagram. You cannot resume the process if you Proceed to the process End.

**Kill**

Use the Kill transition to end the process at any time without completing it. Using the Kill transition leaves the process in its current state and prevents any further transitions (unless the process is restarted).

When you use the Kill transition, the “Current” label remains on the icon for the state at which you chose the Kill transition and “Killed” appears above the state’s icon.
When you end the process with the Kill transition, all process Deliverables are removed from the responsible users’ worklists, and all future Decision Point meetings are canceled.

To restart a process that is Killed, use the Resume transition.

**Hold**

Use the Hold transition to temporarily stop the process for any length of time. Using the Hold transition leaves the process in its current state but prevents any further transitions except the Resume and Kill transitions. You cannot edit a process that is On Hold, nor can you modify any of its data.

When you use the Hold transition, the “Current” label remains on the Work Period or Decision Point at which you made the Hold transition and “On Hold” appears above that state’s icon in the process flow diagram.

When you use the Hold transition, all process Deliverables are removed from the responsible users’ worklists, and all future Decision Point meetings are canceled.

To restart a process that is On Hold, use the Resume transition.

**Recycle**

Use the Recycle transition to move to a prior state in the process. For example, you may need to move from the current Decision Point to a prior Work Period because you have determined that more work needs to be done in the prior Work Period in order to be able to move forward.

When you use the Recycle transition, you choose the state to which you want to return. The “Current” label moves to the state you chose and “In Process” appears above the new current state.

**Skip**

Use the Skip transition to move to a future state in your process without completing the current state.

When you use the Skip transition, you choose the state to which you want to move. The “Current” label moves to the next state in your process and “In Process” appears above the new current state.

If you Skip while the current state is a process Work Period, or if you select to move past one or more Work Periods when you perform the Skip transition, any open Deliverables in those Work Periods are marked as skipped. Skipped Deliverables are removed from the worklists (in the My Dashboard window) of their responsible users.
**Note:** Deliverables that were carried over from a previous Work Period to the Work Period from which you perform the Skip are not marked as skipped. They are carried over to the next available Work Period (if any).

You cannot resume the process if you Skip to the process End.

**Resume**

Use the Resume transition to restart a process after you have used the Hold or Kill transition.

When you use the Resume transition, Deliverables are returned to responsible users’ worklists; however, removed Decision Point meetings are not re-added. You must re-add them manually.
Understanding process roles and permissions

The process team is made up of project workspace users who have different responsibilities and different levels of access to process-related information. The process team comprises the following types of project users.

**Project Managers**

The Project Manager is responsible for the execution of the project process. There is only one Project Manager for each project at one time. The Project Manager moves the process from state to state and acts as the originator of all Work Period Deliverables.

The Project Manager can edit the process if it is not locked (by adding and removing states, moving states, adding Deliverables, etc.), move the process from state to state, assign Deliverables, specify process estimated dates, and make any other necessary changes to the process.

A process cannot exist without a defined Project Manager. The Project Manager must have Author access to the project. If the Project Manager also has Administrator rights to the ProjectArea, he or she can change process lock values from within the process (otherwise, these locks must be changed in ProjectArea Administration).

**Assistants**

Assistants act on behalf of the Project Manager. Assistants can do everything that the Project Manager can do with the following differences:

- A process can have any number of Assistants (including none).
- Assistants can add, remove, or move process states only if they also have Author access to the project.

Assistants must be project users and must have View Process access to the Process feature.

**Decision Makers**

Decision Makers are process team members who help decide whether a process should continue at each Decision Point in the process. Each Decision Point can have a different set of Decision Makers.

Decision Makers must have access to the project, but do not need to have access to the Process page or even to any tabs within the project. Through e-mail notifications, they receive news about Decision Point meetings and access to the appropriate Decision Point report.
Deliverable Responsible Users and Contributors

Deliverable Responsible Users are the project users who are assigned each process Deliverable and who are responsible for completing the Deliverables. Responsible user is one of the key process roles, along with the Project Manager, Assistants, and Decision Makers.

**Note:** By default, all Deliverables added to a process via a process template are assigned to the Project Manager unless the Project Manager assigns the Deliverable to a different project user. Deliverables added to the process from the Process page are assigned to the Project Manager or Assistant who added it unless another user is specified.

Although Responsible Users do not need to have access to the Process page, they should have access to one or more tabs in the project so that they can publish Information Items and create references from project information to their Deliverables. Responsible Users receive news about Deliverable assignments and changes through e-mail notifications and their My Dashboard window.

Deliverable Contributors can update an in-process Deliverable by adding notes or adding or modifying attachments or links.

Process viewers

Process viewers are project users who have View Process permission for the Process page on the Dashboard tab but do not have any other role in the process. Process viewers can view but not edit any process information unless they also are assigned another process role that allows process information editing (Project Manager, Assistant, or Deliverable responsible user).

Project workspace users

All other project workspace users publish, comment on, and otherwise maintain project information that contributes to process Deliverables and other process data. For example, a project user may publish an Information Item or complete a Tracked Activity that can be referenced by a process Deliverable even though that project user does not have access to the Process page and is not responsible for the Deliverable.

Administrators

Centric Project Administrators install and configure Centric Process. Administrators also specify Centric Process terminology, create and maintain process templates, and define process definitions. Administrator privilege is set for users in ProjectArea Administration.
Using Microsoft Project with Centric Process

If you use Microsoft Project to generate and maintain a schedule for your project, you can map the schedule’s tasks and fields to your process’ Work Periods, Deliverables, and User Fields and then publish the mapped schedule to the Schedule tab on the Process page to update the process’ dates and User Fields. Publish the schedule by dropping it onto the file drop box in the Process schedule tab, or use the Centric Project menu in Microsoft Project.

Publishing the schedule automatically updates the mapped process data with the information in the published Microsoft Project schedule file. For mapped Work Periods and Deliverables, publishing the schedule updates mapped User Fields for the current Work Period and its Deliverables. Process dates for the entire process are updated with date changes made in the schedule file.

Once a mapped schedule has been associated with a process, Centric Process tracks changes made to Work Period and Deliverable dates and User Fields and includes them in the Change List. Use the Process Change List to update your Microsoft Project schedule with changes made to the process on the Process page.
Centric Resource™ User Guide
Welcome to Centric Resource

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is Centric Resource?</td>
<td>130</td>
</tr>
<tr>
<td>The benefits of using Centric Resource</td>
<td>131</td>
</tr>
<tr>
<td>Who uses Centric Resource?</td>
<td>133</td>
</tr>
<tr>
<td>Understanding Centric Resource concepts</td>
<td>134</td>
</tr>
<tr>
<td>Analyzing resources</td>
<td>141</td>
</tr>
<tr>
<td>System requirements</td>
<td>145</td>
</tr>
<tr>
<td>Using this guide</td>
<td>146</td>
</tr>
</tbody>
</table>
What is Centric Resource?

Centric Resource™ is a planning and decision support tool that helps project managers, program managers, and executives gain a clear understanding of the resource demands of their projects versus the supply of resources available for the projects’ Business Unit. Centric Resource helps you make accurate project staffing and planning decisions based on resource supply, demand, and associated costs.

Centric Resource allows you to plan the supply, demand, and costs for resources across multiple locations in a Business Unit. You can quickly define the supply of resources in India, Mexico, Canada, or the US as well as the unit costs of these resources at each of these locations.

If you are also using the optional Centric Portfolio module, Centric Resource integrates with Centric Portfolio to give you a rich set of reports that allow you to review:

- Resource supply versus demand for a single project
- Resource supply versus demand for a portfolio of projects
- Resource costs over the life cycle of a project
- Resource costs given different project location decisions for the whole team, or parts of the team

You can use Centric Resource to plan both human and non-human resources for a project. For example, you can plan for:

- People, such as engineers or administrators
- Raw resources, such as fuel or chemicals
- Capital equipment such as personal computers, oscilloscopes, or excavators
- Materials, such as sheet metal, bacteria cultures, or tin roofing

Resource planning can take into account both the units of the resource consumed as well as the unit cost associated with each unit. The unit cost of a personal computer or the labor rate of an employee can be captured and rolled up into a total cost for the project.
The benefits of using Centric Resource

Centric Resource forms the cornerstone of your resource usage, timing, and cost analysis in Centric Project.

Your resource usage analysis reflects resource supply at the Business Unit level and demand at the project level. You can consider a single project, or look at all of the demand placed by all projects in a portfolio. You can also look at total demand, or demand by resource type to determine isolated resource shortfalls.

Time to market can be critical to the success of your project, but a lack of resources can severely affect your ability to get to market. Centric Resource allows you to capture the phased timing of resources to better anticipate resource shortfalls that can have an impact on time to market.

Resource cost analysis allows you to consider the costs of the resource your projects will consume. You can roll up the costs by resource type, aggregate them for the project, or aggregate them for all projects in a portfolio.

Detailed resource planning may start with human resources, but needs to consider other resources as well. Some resources may have an infinite supply or minor cost. Other resources, such as equipment to test a drug manufacturing process, may have a limited supply, cost a considerable amount of money, and be on the critical path to product development. Centric Resource allows you to analyze the supply, demand, and cost of these resources exactly as you analyze the human resources that are critical to your project’s success.

Your company may run from multiple locations. Each location has its own pool of resources. The resources can be human, materials, or equipment. Some locations may have sufficient human resources, but lack equipment or materials available at other locations. Centric Resource can help you analyze where to run your projects to minimize cost while ensuring that a sufficient supply of the project’s necessary resources are available for your project.

Cost is a critical component of resource analysis. These costs can vary widely from location to location and provide one of the key benefits of using Centric Resource with the analysis provided by Centric Portfolio to make sound resource allocation decisions.

Business Units and their associated project portfolios are consistently leveraged by Centric Resource. Before you start to define resource supply, you create resource definitions. These definitions are then allocated a supply at each location in the Business Unit. By reusing the resource definition, you can ensure that all projects in a portfolio are
Centric Resource is built on the same integrated architecture as Centric Project and Centric Portfolio. You will enjoy the same consistent web interface when defining resource supply that you do with other ProjectArea definitions. The Centric Resource user interface is also simple to use. You can use copy and paste operations to quickly define resource supply and demand information.

Centric Resource data are secured by user role. Resource definitions and resource supply information for the ProjectArea can be specified and changed only by a ProjectArea Administrator. Resource demand information can be specified and changed only by the Project Manager or Assistant for the project. This ensures that your resource analysis data cannot inadvertently be changed by someone who isn’t authorized to make the change.

All resource information, including resource definitions, categories, types, supply, and demand information can be exported so that you can exchange information between multiple ProjectAreas to create consistent resource definitions across these areas. For example, if you run your IT projects from one ProjectArea, and your engineering projects from another ProjectArea, you can maintain consistency between the two ProjectAreas.
Who uses Centric Resource

The primary users of Centric Resource are Project Managers, who define project demand information for their projects. Project Area Administrators are responsible for defining resources and for specifying resource supply information for each Business Unit/location pair.

Portfolio Managers use Centric Resource to make resource tradeoff decisions between different projects within a portfolio. These decisions involve the timing and resource allocation of the projects within the portfolio.
Understanding Centric Resource concepts

There are several important concepts to understand about how resource information is created and used with Centric Resource:

- Business Units and locations
- Standard planning unit
- Resource types
- Resource categories
- Supply and demand information

Each of these concepts is described below.

Business Units and locations

Each project in a ProjectArea can be associated with one Business Unit. Business Units are the lowest level business entity in your corporation that you want to refer to for report analysis and resource management.

If you are using Centric Portfolio, Business Units allow you to organize projects into portfolios by associating each portfolio with one Business Unit. This allows you to generate reports across Business Units. If you are using the optional Centric Resource module, you define, manage, and report on resource capacity and consumption across Business Units.

Each Business Unit can be associated with one or more locations, resulting in a set of Business Unit/location pairs. For example, the Consumer Products Business Unit may have two locations (Boston and Chicago) while the Industrial Products Business Unit has one location (Boston).

Portfolios refer to Business Units, but they do not refer to locations. Resources, however, are managed by Business Unit/location pairs.

What are Business Units?

A Business Unit is a large organizational structure that has resources that can be applied to a set of projects. Each Business Unit may include hundreds of projects and even more resources. Projects and resources are used to meet the objectives of the Business Unit. These objectives are typically measured. In many cases, the measures are financial measures, such as internal rate of return or cost of goods sold. The measures can also be risk measures, such as risk of technical success or risk of commercial success.

Each Business Unit can have one or more projects associated with it.
Resource supply is defined at the Business Unit level. From this supply, all the projects in the portfolio make their resource allocations (called “demand” in Centric Resource). Centric Resource can be used to balance the resource supply as defined in the Business Unit with the resource demand specified for each project that is associated with the Business Unit.

If you are using the optional Centric Portfolio module, each portfolio is also associated with a Business Unit. Each project that is associated with the same Business Unit can be included in the portfolio (but does not have to be included in the portfolio). The portfolio’s managers make decisions about which projects to actively run in its portfolio, or which projects to leave outside the portfolio. Projects that lie outside the Business Unit’s portfolio may simply be in a holding state while waiting for resources to become available, or a business case to be developed that justifies starting the project.

The term “Business Unit” is a configurable term. Before you begin to set up Business Units, locations, and resources for your ProjectArea, you should carefully consider which term for “Business Unit” is most appropriate for the way you want to create portfolios and to define and report on resources. For example, you may decide to use the term “Division” instead because you want to focus project portfolios and resources at the division level of your company rather than at the Business Unit level.

The following guidelines might be helpful when you are deciding on the term you want to use:

- If it is at the “Business Segment” level that you decide if you have the correct mix of projects/products in development, then you might want to change the term “Business Unit” to “Business Segment”.
- If a “Division” can run the same project in Mexico, Tokyo, or Montreal, then you might want to change the term “Business Unit” to “Division”.

**What are locations?**

Locations are physical places that have a supply of resources with an associated cost. Locations are defined once in the ProjectArea. For example, you define the location “Mexico City” once. The single definition ensures that all projects that use resources from Mexico City refer to the same location by the exact same name.

Each location can be associated with a Business Unit. A Business Unit can be associated with multiple locations. Similarly, a location may support multiple Business Units. For example, many companies will
have multiple Business Units that all use resources from a single location in India.

In most cases, you will define locations that correspond to cities; however, it is possible to use location names that are actually facility names. For example, you may have both a research and manufacturing facility in the same city. You could name your locations “Mexico City Manufacturing”, and “Mexico City Research”. Making this distinction between manufacturing and research will help you focus on the resource supply at both facilities, which typically won’t overlap.

Each Business Unit/location pair can have resource demand and supply information entered for it.

**Standard planning unit**

The standard planning unit defines the minimum time span for which you want to allocate supply and demand for your resources. For example, a standard planning unit could be days, weeks, months, quarters, or years.

**Note:** The planning period you choose applies to all projects in the ProjectArea, regardless of their Business Unit.

If you are a Project Manager you probably use days as the planning unit to allocate your resources for your projects; however, with Centric Resource, resource planning is performed at a higher level in the organization (typically at a program or Business Unit level). In this case, you should select a planning unit such as weeks, months or quarters.

All resource supply and demand information entered for projects is based on the ProjectArea’s standard planning period. To decide which planning unit to use you should consider

- **The typical duration of your projects**
  
  If projects typically last a few months or less, you probably may want to use a planning unit of weeks or days. If projects generally take from a few months to a couple of years to complete, the planning unit should be set to months. If projects often take a year or more, you will probably use a planning unit of quarters or years.

- **The amount of information you know about the project**
  
  Even for a relatively short project, you may not have detailed resource information at the day-to-day level. If this is the case, you might choose a planning period such as weeks or months.

**Note:** It is very important to carefully consider which planning unit you will before entering any resource supply or demand
information. If you change the planning unit after you have entered supply or demand data, you need to go back and re-enter this data based on the new planning unit.

Resource types

Resource types define how resources are planned and allocated on projects. They describe very general classifications of resources. They also specify the units for the resource (for example, FTE, $, or Gallons) and whether or not there is an associated cost per unit for the resource definitions assigned to the type. For example, you may define a resource type of “Human”, which has a unit of “FTEs” and has an associated cost per unit (cost per FTE).

Resource types are created for a ProjectArea. Each resource in the ProjectArea is assigned to a resource type. This helps to ensure consistency between resources definitions.

We recommend creating the following resource types.

<table>
<thead>
<tr>
<th>Resource Type</th>
<th>Usage</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human</td>
<td>All staff resources used for your projects</td>
<td>Mechanical Engineer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of Marketing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Finance</td>
</tr>
<tr>
<td>Space</td>
<td>Any resource that requires floor space within a</td>
<td>Lab space</td>
</tr>
<tr>
<td></td>
<td>facility</td>
<td>Manufacturing space</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Testing space</td>
</tr>
<tr>
<td>Capital</td>
<td>A resource that is a specific amount of money</td>
<td>$50,000 for focus group studies</td>
</tr>
<tr>
<td></td>
<td>required for a project</td>
<td>$75,000 for UL compliance testing</td>
</tr>
<tr>
<td>Asset</td>
<td>Equipment, machines, computers or other fixed</td>
<td>Computer workstation</td>
</tr>
<tr>
<td></td>
<td>assets that need to be allocated to projects</td>
<td>Laptop computer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pickup-truck</td>
</tr>
</tbody>
</table>
Resource value types

For each resource type, you also need to specify the type of value that can be entered for demand and supply information for resources that use the resource type.

<table>
<thead>
<tr>
<th>Value Type</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Fractional values. For example 3.1 gallons</td>
</tr>
<tr>
<td>Integer</td>
<td>Discrete values. For example 5 NC grinders</td>
</tr>
<tr>
<td>Currency</td>
<td>US currency values, which includes two decimal places. Centric Project displays the $ sign when formatting “Currency” resource type values</td>
</tr>
</tbody>
</table>

Resource units

For each resource type, you can define the units used for the resource type. You use the unit to help ensure that resource supply and demand information is entered and compared consistently across all resources that use the resource type.

Units are simple text strings that describe the units for the resource type. For example, you could declare “mm” or “km” as units. You could also allocate resource salary expenses in thousands of dollars and use a unit of “K” on a currency resource type.

To ensure that resources are consistently used with other Parameters or Metrics in your project, carefully consider how units are used. In the proceeding case, if you represented $5,000 in salary expense as $5 with a unit of “K” (or thousands of dollars), you might introduce errors when this expense is combined with other project cash flows that do not use a “thousands of dollars” representation.

Resource categories

You further refine resource types by creating resource categories. Resource categories allow you to group resource types together so that project users can generate reports across sets of resources. For example, executives can generate portfolio reports that show demand versus supply for all resources in the “Manufacturing” resource category.

Each resource in the ProjectArea must be assigned to a resource category.
The following table indicates some of the resource categories you might create for the recommended resource types (described above):

<table>
<thead>
<tr>
<th>Resource type</th>
<th>Resource Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human</td>
<td>Mechanical Engineer</td>
</tr>
<tr>
<td></td>
<td>Project Marketing</td>
</tr>
<tr>
<td></td>
<td>Finance</td>
</tr>
<tr>
<td>Space</td>
<td>Lab</td>
</tr>
<tr>
<td></td>
<td>Manufacturing</td>
</tr>
<tr>
<td>Capital</td>
<td>Focus groups</td>
</tr>
<tr>
<td></td>
<td>UL compliance testing</td>
</tr>
<tr>
<td>Asset</td>
<td>3Axis NC grinder</td>
</tr>
<tr>
<td></td>
<td>Labs</td>
</tr>
</tbody>
</table>

Notice that the “Human” resources are aligned with the departments or skills from which the resources come. Alternatively, you could use resource location as a categorization for resources; however, this is not necessary as you will be able to allocate resources by location when you enter resource supply information for your resources.

In general, keep categories broad. By combining a resource type and a category, you will be able to create fine-grained resource definitions. For example, rather than creating a “HVAC Engineer” resource category, instead create a “HVAC Engineer” resource definition that has a type of “Human” and a category of “Engineering”. By keeping the category broad you can use it for more than one resource definition. For example, HVAC Engineer, Electrical Engineer, Engineering Capital, etc., can all use the category of Engineering.

Resources

A resource is a combination of a resource type, a resource category, and a Business Unit/location pair. For example, a Senior Engineer resource might have a resource type of “Human”, a resource category of “Development” and a Business Unit/location of “Industrial Products/Chicago”.

Resources are the units for which supply and demand information can be entered and analyzed.
Supply and demand information

Supply information indicates how much of each resource is available across the entire ProjectArea. Resources that have an associated cost per unit allow you to specify a cost per unit in addition to the supply amount. ProjectArea Administrators enter supply information per planning unit for resources in the ProjectArea.

Demand information indicates how much of each resource is needed for a particular project. Project Managers and Assistants enter the demand their projects require per planning unit.
Analyzing resources

Resource analysis is a planning tool that can be used to ensure the right execution of the right projects. Resource analysis ties proposed projects to the realities of your corporate resources. You can make proactive decisions when you combine the resource definitions of Centric Resource with the analysis tools of Centric Portfolio.

Note: To perform resource analysis, you need to have the optional Centric Portfolio module installed, and you need to have defined resources and entered supply and demand information for those resources.

Project/Portfolio supply versus demand versus time

Before you start to consider how much your project resources are going to cost, you need to determine if they are available. You can determine availability by running the Resource Timeline/Demand vs. Supply Line Chart report.

The above sample report shows that supply initially exceeds demand at the start of the project and then falls far short of the needed resources by the middle and end of the project.

By default, this report includes all resources and all projects in the portfolio; however, you can quickly rerun the report and filter by a particular resource to look at how different resource types contribute to the supply shortfall. For example, if the middle of the project needs a large number of engineers, you could filter by engineers to determine if there is a critical shortfall within this specific resource type.
**Note:** For a complete view of resource demand in your portfolio, you need to include all of the projects in the portfolio. If you start to exclude some projects, you will not have a complete picture of the portfolio’s resource demand.

**Project/Portfolio supply versus demand by resource type**

An alternate view of resource usage is to look at supply and demand versus resources type. You might be able to quickly find resource issues with the following approach:

1. Run a resource versus supply demand report as discussed in the previous section.
2. If there are resource shortfalls, run a resource supply versus demand by resource type report.
3. For each resource that has a shortfall, rerun the supply versus demand report and filter it by the resource type in question.

This procedure allows you to quickly determine where the resource issues are, and when they will occur.

To review your resource usage by resource type, you can run a Resource Usage report.

The above sample report shows resource usage by resource type. You can see that there will be a critical shortfall of Assistants and a minor shortfall of Managers, but there are sufficient Engineers and Salespeople to execute the portfolio.

Note that this report represents demand as the sum of all demand across all planning units. It doesn’t tell you when the demand will happen. For a thorough analysis, you should run the Demand versus Time reports for each resource type to ensure you have sufficient resources available that during each planning period.
Resource cost analysis

Resource cost analysis can be approached in several ways. You may simply want to compute the resource supply versus demand information just as you did for the above two cases, but instead of considering units available, you want to add up their costs. You can do this by selecting the “Cost” value type in the Report wizard instead of selecting “Units”.

You may also want to analyze the total resource cost versus budget values that you’ve established for your project. The best way to do that is to establish a charter for your project and then record the project resource costs through a resource summary in the charter. For more information about resource summaries, see the Centric Charter User Guide in this manual.

Resource versus location what-if analysis

You may want to consider running a project in different locations to determine the impact to cost and schedule based on the different locations. To perform this analysis, you manipulate the resources assigned to the project and then run the supply versus demand or cost analysis that have been discussed above to determine the impact of these changes.

For example, suppose you have a Business Unit in two locations: Montreal and Mexico City. Perform the following steps to compare the cost and schedule for running the project in one location versus the other:

1. Create a Business Unit that has two different locations (in this example, Montreal and Mexico City).
2. Create resource types and categories.
3. Define a resource of the same type and category for each location you created for the Business Unit.
4. Enter resource demand for the Montreal resources.
5. Run a supply/demand analysis for this scenario and save it by exporting the report.
6. Change the resource demand from Montreal to Mexico City.
7. Rerun the analysis.
8. Compare the results.
Capital and material resources

Resources don’t have to simply a focus on people. In many cases, the resources that are in short supply or cost a lot of money aren’t the people resources but the material and capital equipment resources. You may want to track these other costs.
System requirements

To be able to use Centric Resource, Centric Project must be installed on your server and the Centric Resource module must be enabled on the Centric Project server. For more information about enabling application modules, refer to the Centric Project Platform Administrator Guide.

Complete Centric Project hardware and software requirements are included in the Centric Project Readme file (Readme.html), which is available on your Centric Project CD in the ProjectServer directory.
Using this guide

The Centric Resource User Guide includes the following chapters:

**Welcome to Centric Resource** provides an overview of Centric Resource, its features, benefits, concepts, and users. It also includes examples of reports you can create with Centric Portfolio to analyze resource demand and supply information in your portfolios.

**Using Centric Resource** explains how to use Centric Resource to configure your ProjectArea resource standards, create resources, define resource supply and demand information, and export and import resource information.
## Using Centric Resource

### In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring your resource standards</td>
<td>148</td>
</tr>
<tr>
<td>Creating resources</td>
<td>153</td>
</tr>
<tr>
<td>Defining resource supply</td>
<td>154</td>
</tr>
<tr>
<td>Selecting resources for your project</td>
<td>156</td>
</tr>
<tr>
<td>Defining project resource demand</td>
<td>157</td>
</tr>
<tr>
<td>Exporting and importing resource information</td>
<td>159</td>
</tr>
</tbody>
</table>
Configuring your resource standards

Resource standards include the standard planning unit for the ProjectArea (for example, do you allocate resources by month, week, or day?), the types of resources you have (for example, “Human” or “Capital”), and the categories of resources you have (for example, “Development” or “Marketing”).

With Centric Resource, you create the resources you need for your projects by first creating the resource standards and then using these standards to create the resources for which supply and demand information can be specified.

For example, if you want to create a Senior Project Leader resource for which you can allocate supply and specify demand on projects, you might define the following resource standards:

- Resource type: Human (rather than Space or Capital)
- Resource category: Engineering (rather than Finance or Marketing)
- Units: Full-Time Equivalents (rather than Dollars or Gallons)
- Unit Cost: Yes, these resources have a cost per unit.

When you are planning your resource standards, keep these thoughts in mind:

- Plan your standards in advance. Once projects start to use resources, it is difficult to adopt new standards.
- Keep your resource definitions at a high level. You do want to track Mechanical Engineers, but probably not specific engineers by name.
- Make your standards consistent across locations.

The following sections describe the tasks you need to perform to configure resource standards for your ProjectArea.

Task 1: Specify the term for Business Unit

Use ProjectArea Administration to specify the term for “Business Units” in your ProjectArea. The term you use helps describe the level at which you will be defining resources. For more information, see “What are Business Units?” on page 134.

1. From the File menu, choose ProjectArea Administration ➤ Terminology. The Terminology dialog box appears.
2. On the Project tab, enter the term you want to use for the singular and plural versions of “Business Unit”.
3. Click OK.
For more information about customizing ProjectArea terminology, see ProjectArea Administration Help.

Task 2: Create locations

In the ProjectArea, create a location for each location that your company has resources.

1. From the File menu, choose ProjectArea Administration > Business Units and Locations. The ProjectArea Business Units and Locations dialog box appears.
2. On the Locations tab, click the Actions button and then choose New Location. The Location Properties dialog box appears.
3. Type a name for this location.
4. Click OK.
5. Repeat steps 2 through 4 until you have created all of the locations you need.

Task 3: Create Business Unit and location pairs

After you have created locations in the ProjectArea, you need to make associations between them and Business Units so that you can manage and allocate resources for each Business Unit/location pair. For example, if you have created the Consumer Products Business Unit, you need to associate it with one or more locations (for example, Boston and Chicago) so that you can allocate resources to that Business Unit/location by creating a resource that references the pair.

Note: This procedure assumes that Business Units have already been created for your ProjectArea. If they have not, you will have to create them first. For more information, see “Task 1: Create Business Units” in the Centric Portfolio User Guide on page 189 or refer to ProjectArea Administration Help.

You can associate Business Units and locations either by adding locations to a selected Business Unit or by adding Business Units to a selected location.

To associate locations with business units

1. From the File menu, choose ProjectArea Administration > Business Units and Locations. The ProjectArea Business Units and Locations dialog box appears.
2. On the Business Units tab, select the Business Unit to which you want to add one or more locations.

3. Click the Actions button and then choose **Properties**. The Business Unit Properties dialog box appears.

4. On the General tab, select the locations you want to associate with this Business Unit:
   - To add one or more locations, click the **Add** button and then select the locations that you want to associate with the Business Unit.
   - To remove one or more locations, select the locations that you want to remove and then click **Remove**.

5. When you are finished adding and removing locations for the Business Unit, click **OK**.

**To associate business units with locations**

1. From the File menu, choose **ProjectArea Administration > Business Units and Locations**. The ProjectArea Business Units and Locations dialog box appears.

2. On the Locations tab, select the Location to which you want to add one or more Business Units.

3. Click the **Actions** button and then choose **Properties**. The Location Properties dialog box appears.

4. On the General tab, select the Business Units you want to associate with this location:
   - To add one or more Business Units, click the **Add** button and then select the Business Units that you want to associate with the location.
   - To remove one or more Business Units, select the Business Units that you want to remove and then click **Remove**.

5. Click **OK**.
Task 4: Define the standard planning unit

Use the following procedure to define the standard planning unit for the ProjectArea’s resources.

1. From the File menu, choose **ProjectArea Administration ➤ Resource Management ➤ Configuration**. The Resource Configuration dialog box appears.
2. Click the General tab.
3. Click the **Select** button next to the Standard planning unit box. The Select Standard Planning Unit dialog box appears.
4. Select the standard planning unit for the ProjectArea.
5. Click **OK**.

Task 5: Define resource types

Each resource in the ProjectArea must be assigned to a resource type. Resource types define how resources are planned and allocated on projects. They specify the units for the resource (for example, FTE, $, or Gallons) and whether or not there is an associated cost per unit for the resource definitions assigned to the type. The following table indicates the recommended units and value types for common resource types:

<table>
<thead>
<tr>
<th>Resource Type</th>
<th>Units</th>
<th>Value Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human</td>
<td>FTEs</td>
<td>Number</td>
</tr>
<tr>
<td>Space</td>
<td>ft²</td>
<td>Number</td>
</tr>
<tr>
<td>Capital</td>
<td>None, The “$” is automatically added to resource types that have a Currency value type.</td>
<td>Currency</td>
</tr>
<tr>
<td>Asset</td>
<td>Item</td>
<td>Number</td>
</tr>
</tbody>
</table>

Use the following procedure to create a new resource type for this ProjectArea.

1. From the File menu, choose **ProjectArea Administration ➤ Resource Management ➤ Configuration**. The Resource Configuration dialog box appears.
2. Click the Types tab.
3. Click **New**. The Resource Type Properties dialog box appears.
4. Enter the information for the new resource type.

5. Click OK.

For more information about creating, editing, and deleting resource types, see ProjectArea Administration Help.

**Task 6: Define resource categories**

Each resource in the ProjectArea must be assigned to a resource category.


2. Click the Categories tab.


4. Type the name for the category.

5. Click OK.

For more information about creating, editing, and deleting resource categories, see ProjectArea Administration Help.
Creating resources

Once you have configured resource standards for the ProjectArea, you can begin to create individual resources for which supply and demand information can be specified.

A resource is a combination of a resource type, a resource category, and a Business Unit/location pair. For example, a Senior Engineer resource might have a resource type of “Human”, a resource category of “Development” and a Business Unit/location of “Connections Systems/Chicago”.

Use the following procedure to create new resources for the ProjectArea.

1. From the File menu, choose ProjectArea Administration ▶ Resource Management ▶ Resources. The ProjectArea Resources dialog box appears.

2. Click the Actions button and then choose New Resource. The Resource Properties dialog box appears.

3. Specify the information for the resources:
   - Give the resources a name
   - Select their resource type
   - Select their resource category
   - Give the resources a description
   - Select the Business Unit/location pairs for the resources that you want to create. Each Business Unit/location pair you add represents a separate resource for which supply and demand information can be entered.

4. When you are finished defining the resources, click OK.

For more information about managing resources, see ProjectArea Administration Help.
Defining resource supply

Supply information indicates how much of each resource is available across the entire ProjectArea. Resources that have an associated cost per unit allow you to specify a cost per unit in addition to the supply amount.

You can enter or edit resource supply information for a single resource or for multiple resources at once, as long as they are of the same resource type.

You can enter supply information for as many or as few planning units as you want. If you do not enter a supply value for a planning unit, the supply value for that planning unit is assumed to be 0.

If you do not enter a cost per unit (for resources that allow you to), the cost per unit is assumed to be the same as the cost per unit specified in the most recent prior planning unit. If cost per unit information has not been entered for any prior planning unit, the cost per unit is assumed to be the same as the cost per unit specified in the first future planning unit that has a cost per unit specified.

Although you can enter resource supply information by typing the information directly into the Resource Supply dialog box, you can also develop your resource supply information in a Microsoft Excel spreadsheet and then copy and paste that information into the Resource Supply dialog box.

Note: You can copy only numeric resource values from Excel to Centric Resource. You cannot copy resource names.

To enter supply information for resources

1. From the File menu, choose ProjectArea Administration > Resource Management > Resources. The ProjectArea Resources dialog box appears.

2. Select the resources for which you want to edit supply information.

   Note: To edit supply information for multiple resources at once, the resources must be of the same type.

3. Click the Actions button and then choose Edit Supply. The Resource Supply dialog box appears.

4. To change the displayed planning period range, enter the number of past and future planning units to display in the Display Range boxes and then click Update.

5. Enter or edit supply and cost per unit information (if applicable) for each resource:
- To enter a value in a column, click the column, type the value, and then press ENTER.
- To enter the same value in multiple cells at once, copy the value with CTRL+C, click and drag to select the cells into which you want to paste the value, and then press CTRL+V to paste the value into the selected cells.
- If the resource has supply and cost information associated with it, you can cut and paste both columns of information at the same time.
- To move the insertion point from one column or row to another, press the arrow or TAB keys.
- To delete a value, select its cell and then press DELETE.
- To edit a value, double-click an unselected cell to display the insertion pointer, then edit the value in the cell.
- To view columns or rows that are not displayed in the dialog box, use the vertical and horizontal scroll bars.
- To sort the table by a column, click the column’s heading. To reverse the sort, click the column’s heading again.

6. To save your changes at any time, click **Save**.

7. When you are finished editing supply information for these resources, click **Done**.

For more information about viewing or editing resource supply, see ProjectArea Administration Help.
Selecting resources for your project

In order to specify resource demand information for any project, the Project Manager or Assistants must first select the resources to use on the project. The resources that you can select for a project are those that are associated with the same Business Unit as is associated with the project.

Note: In order to select resources, the project must be associated with a Business Unit. To select the Business Unit for the project, edit the project’s properties. For more information, see Project Workspace Help.

Use the following procedure to select the resources you will use on your project.

1. If you are viewing My Dashboard, select the project for which you want to select resources.
2. From the File menu, choose Project Administration ➤ Resource Demand. The Project Resources dialog box appears.
3. Click Actions and then choose Select Resources. The Select Resources dialog box appears.
4. Select the resources that you want to add to this project.
5. Click OK.

For more information about selecting project resources, see Project Workspace Help.
Defining project resource demand

After you have selected the resources for the project, you can enter the demand your project requires per planning unit. For example, in April, your project may require 6 Developers, while in May your project requires 8 Developers.

Like resource supply information, you can specify resource demand information by typing the information directly into the Resource Demand dialog box, or you can develop your resource demand information in a Microsoft Excel spreadsheet and then copy and paste that information into the Resource Demand dialog box.

To enter demand information for project resources

1. If you are viewing My Dashboard, select the project for which you want to view or edit resource demand.

2. From the File menu, choose Project Administration » Resource Demand. The Project Resources dialog box appears.

3. Select the resources for which you want to view or edit demand information.

   Note: You can select multiple resources as long as they are of the same resource type.

4. Click Actions and then choose Edit Demand. The Resource Demand dialog box appears.

5. To change the displayed planning period range, enter the number of past and future planning units to display in the Display Range boxes and then click Update.

6. Enter or edit demand information for each resource:

   - To enter a value in a column, click the column, type the value, and then press ENTER.
   - To enter the same value in multiple cells at once, copy the value with CTRL+C, click and drag to select the cells into which you want to paste the value, and then press CTRL+V to paste the value into the selected cells.
   - If the resource has demand and cost information associated with it, you can cut and paste both columns of information at the same time.
   - To move the insertion point from one column or row to another, press the arrow or TAB keys.
   - To delete a value, select its cell and then press DELETE.
- To edit a value, double-click an unselected cell to display the insertion pointer, then edit the value in the cell.
- To view columns or rows that are not displayed in the dialog box, use the vertical and horizontal scroll bars.
- To sort the table by a column, click the column’s heading. To reverse the sort, click the column’s heading again.

7. To save your changes at any time, click Save.
8. When you are finished editing demand information for these resources, click Done.

For more information about viewing or editing project resource demand information, see Project Workspace Help.
Exporting and importing resource information

Once you have created resource standards and resources, you can export that information to make it available to other ProjectAreas. You can also import resource standards and resources from other ProjectAreas into this ProjectArea.

**Note:** To export resource demand information, you must archive the project and restore it to another ProjectArea.

Exporting resources

When you export resources, you can choose between exporting selected resources or all resource-related information in the ProjectArea.

- Exporting selected resources exports the resources and all their supporting resource information (planning unit, resource type, resource category, supply, etc.).
- Exporting all resource-related information in the ProjectArea exports all defined resource information, even if it has not been used to create resources. For example, if the ProjectArea includes a location, resource type, or resource category that has not yet been used to define a resource, that information is exported anyway.

Resource export files are saved in the processtemplates directory in your ProjectArea (with a file extension of .rda). Once you have created a resource export file, you can import it into another ProjectArea.

You can create an export file that contains only the resources you select or you can create one that contains all resources in the ProjectArea.

**To export selected resources**

1. From the File menu, choose **ProjectArea Administration ➤ Resource Management ➤ Resources**. The ProjectArea Resources dialog box appears.
2. Select the resources that you want to export.
   **Tip** To export all resources, select them all.
3. Click the **Actions** button and then choose **Export**. The Export Resources dialog box appears.
4. In the Name box, type the name that you want to give the export file.
5. Click **OK**.
ProjectArea Administration creates an export file from the selected resources and places it in the processtemplates folder in your ProjectArea.

When the export is complete, a message appears that lets you know the export was successful.

6. Click OK.

**To export all resource information in the ProjectArea**

1. From the File menu, choose **ProjectArea Administration ➤ Resource Management ➤ Export**. The Export Resources dialog box appears.

2. In the Name box, type the name that you want to give the export file.

3. Click OK.

ProjectArea Administration creates an export file that contains all ProjectArea resources and places it in the processtemplates folder in your ProjectArea.

When the export is complete, a message appears that lets you know the export was successful.

4. Click OK.

**Importing resources**

When you import resources that are based on the same standard planning unit as the planning unit specified for the ProjectArea, all information related to the resources are imported, including configuration information for the resources (types and categories) and any supply information already specified for the imported resources.

When the planning unit in the resources export file is different from that of this ProjectArea, however, the information that is imported depends on whether supply information has been specified for the resources in this ProjectArea:

If the resources in this ProjectArea do not have any supply information specified, the planning unit in this ProjectArea is changed to match the planning unit in the export file and all resource information (including configuration and supply information, if any) is imported into the ProjectArea.

If any of the resources in this ProjectArea have supply information specified, the planning unit is not changed and resources in the export file are imported with configuration information but not their supply
information (if any). You must re-enter their supply information using this ProjectArea’s standard planning unit.

If a resource in the import file matches a resource in the ProjectArea, the resource in the ProjectArea is not updated.

To import resources

1. If you are importing resources from another ProjectArea, use Windows Explorer to copy the appropriate export file (.rda) to the process templates directory in this ProjectArea.

2. From the File menu, choose ProjectArea Administration ➤ Resource Management ➤ Import.

   Note: You can also import definitions from the ProjectArea Resources dialog box by clicking the Actions button and then choosing Import.

   The Import Resources dialog box appears.

3. Select the export file that you want to import.

4. Click OK.
Centric Portfolio™ User Guide
Welcome to Centric Portfolio

In this chapter

What is Centric Portfolio? ......................................................... 166
The benefits of using Centric Portfolio ................................. 173
Who uses Centric Portfolio? .................................................. 175
System requirements ............................................................ 176
Using this guide ................................................................. 177
What is Centric Portfolio?

Centric Portfolio™ is a decision support solution that helps executives make critical product-planning decisions and meet strategic corporate objectives for growth and risk.

Portfolios allow you to group projects for the purpose of analysis and decision-making. Portfolios typically represent groups of projects that have profit/loss accountability. For example, all the projects in a Business Unit or division might be put in the same portfolio. You may also group together projects that are related by their resource demand requirements. You can then manage the projects within the portfolio to determine the best sequencing of the projects, and the most effective usage of the resources supplied by the portfolio.

If you are using the optional Portfolio Planning module, Portfolios also allow you to establish objectives against which all projects in the portfolio are to be measured. Establishing these objectives helps an organization to align to these objectives. Measuring the alignment through Centric Portfolio’s analysis tools ensures the alignment.

Once you have created a portfolio, you can quickly build a set of analytic portfolio reports that include sophisticated filtering and display logic. An intuitive user interface gives executives the single-click ability to generate accurate portfolio views derived from live data, to help them make better keep/kill and resource allocation decisions that support the strategic objectives and future success of their organizations.

As one part of the Centric Project family, Centric Portfolio seamlessly draws your team members into the coordinated project and minimizes the need for additional team training.

Because Centric Portfolio draws data from project processes running in a Centric Project project workspace, you should read the Centric Process User Guide in this manual and have good familiarity with Centric Project and ProjectArea Administration before you read this guide.

What is Portfolio Planning?

Portfolio Planning is an optional module that allows you to define Strategic Objectives and Strategic Metrics for your portfolios so that you can compare the portfolio’s performance to its goals.

Note: You can specify Strategic Objectives and Metrics for your portfolios only if the optional Portfolio Planning module is installed.
Strategic Objectives give you a qualitative way to define your portfolio. For example, you might define the following Strategic Objectives for a portfolio:

- Neutralize Competitor <xyz>’s threat in US
- Grow market share in Japan
- Maintain product competitiveness

A Portfolio’s Strategic Metrics are quantifiable values. Strategic Metrics are based on the same Metric definitions that are created for a ProjectArea and can be used in a project processes. For each Strategic Metric, you can define a target value, rank, category, and critical flag. This information appears in the Strategic Alignment report.

For more information, see “The benefits of using Portfolio Planning with Centric Portfolio” on page 174.

**What is a product portfolio?**

Most people manage their investments as a portfolio rather than making business decisions for each investment individually. By spreading risk across a population of investments, a portfolio lets you minimize the impact on your net investment outcome of any individual investment not performing as you expect. Just as importantly, portfolio methodologies let you balance risk versus reward. By mixing some high-risk and high-potential reward investments with other investments that have less risk and lower potential reward, you can achieve their desired net investment goals. Using portfolio concepts, you can implement an investment strategy that is most likely to achieve your investment goals.

The same concepts apply to a product portfolio as to an investment portfolio. Although many executives think of their company’s product offerings as a portfolio of products, applying formal portfolio methodologies to a product mix is relatively new. Portfolio methodologies offer the same benefits in managing investments in product development as they do in managing investments in financial instruments. Portfolio methodologies provide a tool for balancing risk versus reward that helps companies achieve strategic product goals.

A company’s strategic product objectives are not only monetary in nature. In addition to setting objectives for annual growth in sales, a company might also set other objectives, for example, for market share, new market penetration, or new product introduction. Each objective is typically described in terms of a measurable result, such as “sales dollars”, “percent of market share”, or “percent of revenue from new products”. These factors must be estimated or measured to determine a product’s expected or actual performance.
The investments that executives make in products are also not simply monetary in nature. Executives are responsible for the expenditure of all scarce corporate resources, such as manpower, manufacturing capacity, and marketing budget. Balancing the use of these resources is necessary and adds a great deal of complexity to product mix decision-making.

There are also many different risk factors that executives contend with in making product decisions, particularly those involving the decisions to develop new products. One product concept may have a high technical risk, while another might be well understood technically, but the reaction in the marketplace may be difficult to project. Another product might have a low technical and competitive risk, but the competitive risk might be high because another vendor may be developing a similar product, and the market might be such that the first to get to market might win the whole market, leaving nothing for second and third place entries, rendering their investments worthless.

A portfolio is a tool that helps executives group together projects based on a similar set of objectives and resource requirements to make investment decisions that balance risk and reward to achieve your strategic objectives. This is a complex multi-dimensional problem, so a portfolio tool can be critical to making good product decisions.

Finally, one of the most important investment decisions an executive can make is how to invest in new projects. For example, the cost of investment in a new product introduction is very high and the outcome of these decisions have a direct and critical impact on the company’s future. New product introduction has become a focus of product planning. By optimizing the investment in new products, an executive can have the greatest positive effect on the future health of his product portfolio and company.

**Portfolio report examples**

A product portfolio provides information and analysis to help answer key product planning questions. For example, a fundamental portfolio goal is to maximize revenue while minimizing cost and risk. When evaluating and comparing new product projects in a portfolio you will invariably ask, “What are my best new product projects with respect to cost, expected revenue, and risk”? The bubble graph below provides the answer to this question for a set of sample new product projects.
This graph makes it easy to determine that Delta is a high value project, but the probability of success is too low, whereas Epsilon has the second highest commercial value and is likely to be a success, and also that Zeta is a sure bet, but its revenue effect on the company will be minimal.

Another Strategic Objective might be to increase the investment in products that serve new and emerging markets. The stacked bar chart below shows the investment in these products, and would help an executive allocate scarce manufacturing capacity among competing product proposals.
Each of the reports shown above displays one or more key variables across a portfolio of new product introduction projects. Each can be used to answer a specific portfolio question, and provides information necessary to make good product portfolio tradeoff decisions.

If you are using the optional Portfolio Planning module, Strategic Objectives created for your portfolios appear in the Portfolio Summary report. This report forms the cornerstone for the definition of your project portfolio. The report shows a list of all the projects in the portfolio as well as user-selected Metrics for each project.
A portfolio’s Strategic Metrics appears in the Strategic Alignment report.

The first several columns of the Strategic Alignment report contain the rank, category, and target value of each Strategic Metric for the portfolio. Each project in the portfolio appears in its own column in the report, with the project’s values for each Strategic Metric. The project Metrics can easily be compared with the Strategic Metrics presented on the left side of the report.

Alternatively, if you want to determine how the sum of a Metric (such as Revenue) compares with a portfolio target, you can use the Aggregate Actual vs. Target report. This report displays two pairs of bars for each Metric. The right bar displays the portfolio’s target value.
for the Metric. The left bar displays the sum of the Metric for all projects in the analysis.
The benefits of using Centric Portfolio

Centric Portfolio allows you to create any number of portfolios within a ProjectArea. These portfolios allow you to apply a consistent set of objectives to all projects in the portfolio. Because Centric Portfolio is built on Centric Process, Centric Project, and Centric Resource, it gives executive decision makers a basis for making better product planning decisions based on actual, current data. It then provides the analysis tools to measure the actual values against the objectives for the portfolio.

Centric Portfolio gathers data directly from team members and project leaders, resulting in a degree of data currency and reliability that is unavailable in typical portfolio systems. Because Centric Portfolio data collection is through the Centric Portfolio and Centric Project solution modules, your project managers and team members use the same tools they are accustomed to, eliminating the need for any additional training.

Centric Portfolio is fully configurable, with the flexibility to support your specialized product planning process. With Centric Portfolio, you define the variables and reports you need to support your decision-making processes.

Centric Portfolio is built on the same process standardization system as Centric Process, facilitating clean apples-to-apples comparisons of projects in your portfolio.

Centric Portfolio is easy to use. The Portfolio Analysis tab in the My Dashboard window has been designed with the needs of executives in mind. The interface is intuitive and well suited to occasional executive users.

Centric Portfolio is easy to install and administer. Centric Portfolio shares the same system administration interface as the Centric Process and Centric Project business solution modules. A wide range of sophisticated report types can be quickly built using a three-screen wizard interface.

Centric Portfolio is fully extensible. Because Centric Portfolio is built on industry-standard Crystal Reports®, you can use Crystal Reports to add advanced capabilities to your reports. Contact Centric Software for more information on this.
The benefits of using Portfolio Planning with Centric Portfolio

The Portfolio Planning module extends the capabilities of Centric Portfolio by giving you the ability to proactively drive projects into alignment with Strategic Objectives and Metrics.

Portfolio Planning allows you to define Strategic Objectives to establish qualitative goals for your project. These objectives typically create a Centric Software within which the project team can guide their project and the portfolio manager can watch for projects that aren’t meeting the goals of the portfolio.

Objectives are simple, text statements that define the objectives of the portfolio. They can be used to express some of the qualitative objectives of the project, such as:

- Increase customer loyalty
- Lower engineering attrition
- Penetrate key international markets
- Maintain number one position
- Introduce market eclipsing technology

Strategic Metrics take Strategic Objectives a step further. They provide a quantitative way to measure how well each project in the portfolio performs relative to a Metric. Strategic Metrics are based on the same Metrics used by project processes. Strategic Metrics, like all Centric Project Metrics, are defined for the ProjectArea. When the Metric is added to a portfolio, it is assigned a target value. Each project in the portfolio can then be measured against this Metric’s target value.

If you have a large number of Strategic Metrics, you can group them into categories. For example you might want to put NPV, and IRR into a category called “Finance”, and Probability of Commercial Success, and Probability of Technical Success into a category called “Risk”.

174 Centric Portfolio User Guide
Who uses Centric Portfolio?

Executives are the primary users of Centric Portfolio. Executives are responsible for evaluating and making critical decisions about projects. Centric Portfolio draws accurate project information from Centric Process and Centric Project, facilitating better decision-making.

Administrators install and maintain Centric Portfolio. Administrators configure all the elements of a portfolio system, with the goal of developing portfolio reports to meet executive decision-making needs.
System requirements

To be able to use Centric Portfolio, Centric Project must be installed on your server and the Centric Process and Centric Portfolio modules must be enabled on the Centric Project server.

To be able to use Portfolio Planning, the Centric Portfolio and Portfolio Planning modules must be enabled on the Centric Project server. For more information about enabling application modules, refer to the *Centric Project Platform Administrator Guide*.

Complete Centric Project hardware and software requirements are included in the Centric Project Readme file (Readme.html), which is available on your Centric Project CD in the ProjectServer directory.
Using this guide

The *Centric Portfolio User Guide* includes the following chapters:

**Welcome to Centric Portfolio** provides an overview of Centric Portfolio, its features, benefits, and users.

**Designing your portfolio reports** provides design guidelines and considerations to keep in mind when designing your portfolio reports. It also includes descriptions of the component “building blocks” of a Centric Portfolio portfolio report.

**Using Centric Portfolio** explains how to set up and use Centric Portfolio. It describes the steps for creating portfolios and for creating and viewing portfolio reports.
Designing your portfolio reports

In this chapter

<table>
<thead>
<tr>
<th>Planning your portfolio reports</th>
<th>180</th>
</tr>
</thead>
<tbody>
<tr>
<td>The components of a Centric Portfolio portfolio report</td>
<td>182</td>
</tr>
</tbody>
</table>
Planning your portfolio reports

This chapter discusses some of the issues involved in defining a product portfolio system. We refer to Centric Portfolio as a system because it works closely in conjunction with Centric Process and Centric Project to provide coherent portfolio reports based on real project data. Each module must be configured with the others in mind to derive the greatest value.

Portfolio concepts are easy to understand, but the design of a portfolio system requires great care to achieve its goals. Whereas many companies have a good grasp of their gated process needs, fewer know how to apply portfolio concepts to their product planning process. Industry experts and business process consultants spend years studying the issues involved, and can be very helpful.

Excellent books are available that describe portfolio methodologies and offer guidelines for adapting them to your company’s particular needs. Of course, just as with gated processes, each business has different needs; there is no one-size-fits-all portfolio solution. We recommend these books and the use of business consultants to help you develop and tune your portfolio system.

Portfolio report design considerations

Some basic questions need to be answered when you design your portfolio system. These questions appear simple, but this is deceptive. The answers to these questions are often the result of extended discussion among executives.

What information do executives need?

This is the most fundamental question in designing your portfolio system. Put another way, what characteristics of your products and projects do executives need to make good product planning decisions? This information usually translates into the Metrics you include in your gated process templates. The list below gives several typical examples of Metrics that are important in making trade-offs when allocating scarce product introduction resources. The list of possible metrics is virtually inexhaustible, but most executives ultimately rely on a handful of key indicators in making product-planning decisions.

- **Estimated Commercial Value (ECV)** – Measured in dollars, ECV is the total value to your company of a particular product or product concept.
- **Probability of Technical Success (PTS)** – Scored on a scale of zero to one, PTS rates the probability that technical hurdles in a product introduction project can be overcome.

- **Probability of Commercial Success (PCS)** – Scored on a scale of zero to one, PCS rates the probability that a product will be accepted in the marketplace.

- **Estimated Project Cost** – This Metric is always an important factor in considering which projects to take on.

- **Cost to Complete** – This Metric is useful when deciding whether to continue a project.

**When should this information be updated?**

This question directly pertains to project methodology and the definition of project processes with Centric Process. When can this information be determined and when should it be updated? It really depends on the type of information. Estimated Commercial Value should be evaluated early in a project and can be re-evaluated several times throughout a project, whereas Probability of Technical Success has no pertinence after product development activities are complete.

**How do executives want to see this information?**

Executives often know how they want to see some information. They might want a pie chart showing penetration in different markets or a table showing Estimated Commercial Value, Market Segment and Probability of Commercial Success for each of their new product projects. The portfolio Report Type and Output Style determine how portfolio information is displayed.

**How do executives want to group or filter projects?**

Executives invariably want to compare groups of projects for analysis purpose. For example, they may want to group projects to show Estimated Commercial Value by industry segment or to show market penetration by product line. Executives also want to limit the projects in their reports to show, for example, the Cost to Complete for all of the North America projects. These groupings are what drive the categories you define in ProjectArea Administration and assign to projects in Project Administration.
The components of a Centric Portfolio portfolio report

Portfolio reports collect, process, and display project data. When you define a portfolio report, you need to define its type, style, variables, and filter. Once you have defined this information, you can run the report to capture the current data in your projects. The following sections describe the information you need to specify when defining a new portfolio report.

Report types and styles

The first step in defining a report is to select its type and style. The type of report defines the number of variables/data included in the report and their relationship to each other. For example, you might choose a “2 Values Graph” report (where the report includes two variables displayed in a graph or chart) or you might choose an “N Value List” report (where the report includes the values for as many variables as you select in a list format).

The report output style defines the way the data included in the report is formatted. The styles available here depend on the type of report you selected in the Report Type box. For example, for the “2 Values Graph” report, you can choose a Scatter Plot output. For the “N Value List” report, a List or Table format.

Report variables

Portfolio reports collect and display a wide range of project data, known collectively as report variables. The following table lists the available report variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Always used as a label to identify each project in a report</td>
</tr>
<tr>
<td>Project Description</td>
<td>The project’s description.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The name of the Project Manager for the project.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Data variables that describe product details that are usually of most interest to project team members. For example, a Parameter might be “Voltage”, “Length”, or “Unit Cost”.</td>
</tr>
<tr>
<td>Variable</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Meeting Dates</td>
<td>The date of any project meeting.</td>
</tr>
<tr>
<td>Milestone Dates</td>
<td>The date of any project milestone</td>
</tr>
<tr>
<td>Upstream and Downstream Dependencies</td>
<td>The names of the projects upon which the project depends and those that depend upon the project.</td>
</tr>
<tr>
<td>Tracked Activities</td>
<td>You use Activities to manage all approval or request for information activities that occur on your project.</td>
</tr>
<tr>
<td>Process Name</td>
<td>If you are using the optional Centric Process module, you can include process-related date in your portfolio reports, including the process’s name. Note: Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Process Description</td>
<td>The description of the process.</td>
</tr>
<tr>
<td></td>
<td>Note: Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Current Process State</td>
<td>The name of the process step that a process is currently in. For example, a project might be in the “Initial Investigation” Work Period, or in the “Product Release” Decision Point. Note: Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Current Process Status</td>
<td>A process may be “Not Started”, “In Process”, “On Hold”, “Finished”, or “Killed”. Each of these is a possible “Current Process Status” for the project’s process. Note: Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Process State Dates</td>
<td>The estimated or actual dates of states in the process. Note: Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Variable</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Late Flag</td>
<td>The late flag indicates that a project has not achieved a planned goal date. These goal dates are stored in the project’s process, and are called estimated dates. The late flag has true or false value.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Metrics</td>
<td>Metric values in the process. Metrics are the primary data values that portfolio reports gather. Metrics are “typed” project-level variables whose values are typically set and updated during the project at designated Work Periods and Decision Points.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Deliverables</td>
<td>Deliverables are defined for each Work Period in a project’s process. They can have status and a due date. They also have Information Items associated with them.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Process module.</td>
</tr>
<tr>
<td>Resource Demand</td>
<td>Resource demand values for a project, in units or cost.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Resource module.</td>
</tr>
<tr>
<td>Resource Supply</td>
<td>Project/Area resource supply values, in units or cost.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Resource module.</td>
</tr>
<tr>
<td>Resource Definitions</td>
<td>Resource definitions, including the resource’s name, type, category, Business Unit, and location.</td>
</tr>
<tr>
<td>Note:</td>
<td>Requires the optional Centric Resource module.</td>
</tr>
</tbody>
</table>
### Variable | Comments
--- | ---
Project Categories | Project categories allow projects to be grouped and then selected for inclusion in particular portfolio reports. As an example, you could define a category called “Market Region”. A project can be included in multiple categories. For example, in addition to specifying a “Market Region”, you might classify the “Market Type” as commercial, industrial, or OEM.

Portfolios | The name of the portfolio and the list of projects included in the portfolio.

Strategic Metrics | The value, critical flag, and rank for Strategic Metrics that are assigned to portfolios. Strategic Metrics are based on the same Metric definitions that are created for a Project Area and can be used in a project processes. Strategic Metrics appear in the Strategic Alignment report.

**Note:** Requires the optional Portfolio Planning module.

Strategic Objectives | Strategic Objectives are simple, text statements that define the objectives of the portfolio.

**Note:** Requires the optional Portfolio Planning module.

### Report filters

By default, a portfolio report automatically includes all projects that are associated with the same Business Unit as is associated with the portfolio. When the report is defined, the report’s creator can create a filter that selects a subset of those projects. For example, you can create a portfolio report with a project filter that includes only those projects run by a specific Project Manager or those using a specific project process template. This type of filter is part of the report’s definition and can be edited only by the person who created the report or the Project Area Administrator (for public reports). Any project user who views the report will see the same results based on the filter.
In addition, when you are viewing reports on the Portfolio Analysis tab, you can perform “what-if” analysis by using the **Select Included Projects** command to create a temporary filter for the report. This allows you to remove projects from the report or to add projects that either are assigned to the same Business Unit or have no Business Unit assigned. You are not limited to the projects that are selected based on the report’s original filter. The changes you make are temporary (for the current viewing only), do not affect any other project users, and do not affect the report’s definition.

You can use this type of “what-if” analysis to decide whether to accept a new project into a portfolio or to remove a project from a portfolio. To do this, view the portfolio report against all the projects in the portfolio, export the report to save a copy of it, filter the projects by selecting the projects you want in the report, and then compare the resulting report with the saved report.

**Crystal Reports**

Centric Portfolio uses Crystal Reports as the internal report generation engine. Crystal Reports is included in the Centric Process installation. Centric Portfolio users typically have no need to interact directly with Crystal Report unless they have needs for advanced report configuration. Please call Centric Software Technical Support for more information on using Crystal Reports to extend your portfolio reporting functionality.
Using Centric Portfolio

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating portfolios</td>
<td>188</td>
</tr>
<tr>
<td>Creating portfolio reports</td>
<td>194</td>
</tr>
<tr>
<td>Viewing portfolio reports</td>
<td>197</td>
</tr>
<tr>
<td>Exporting and importing portfolio reports</td>
<td>198</td>
</tr>
</tbody>
</table>
Creating portfolios

When you create a portfolio, you are grouping projects so that you can compare them to each other and measure them against the business objectives that are defined for the portfolio. A portfolio groups projects that share objectives.

If you are using the optional Centric Resource module, a portfolio also groups projects that share resources. A portfolio is tightly tied to resource supply information that has been entered for the Business Unit associated with the portfolio. For more information about resources, see the Centric Resource User Guide in this manual.

A portfolio should be tied to the projects in which you can make business decisions that will ultimately affect the bottom line. Typically, a discrete department, such as a twenty-person finance team, is too small and isolated to make the type of important profit and loss decisions that will really benefit the company. Portfolio-level project analysis is generally applied to larger departments, or cross-functional projects.

For example, an IT department may have many projects that could potentially generate more money or reduce costs for a company. Portfolio analysis can be used to help select the right projects given the income or cost-reduction objectives.

Business Units and portfolios

Each project in the ProjectArea can be associated with a Business Unit. In Centric Project, Business Units are the lowest level entity in your corporation that you want to refer to for report analysis and resource management.
Business Units allow you to organize projects into portfolios by associating each portfolio with one Business Unit. This allows you to generate reports across Business Units. If you are using the optional Centric Resource module, you manage and report on resource capacity and consumption across Business Units.

Each Business Unit can be associated with one or more locations, resulting in a set of Business Unit/location pairs. For example, the Consumer Products may have two locations (Boston and Chicago) while the Industrial Products Business Unit has one location (Boston). Portfolios refer to Business Units, but they do not refer to locations. Resources, however, are managed by Business Unit/location pairs.

Once you have determined the level in your organization at which to create portfolios (that is, the levels at which Business Units should be created), you are ready to create portfolios. Use the following procedures to create a portfolio.

**Task 1: Create Business Units**

Use ProjectArea Administration to create one or more Business Units. Each portfolio you create will be associated with (and named the same as) a Business Unit in the ProjectArea. The projects that are automatically included in the portfolio are those that are associated with the same Business Unit.

If you want to use portfolios in conjunction with Centric Resource, you also need to define locations and associate them with the Business Units. Resource supply and demand information is entered for Business Unit/location pairs.

- From the File menu, choose ProjectArea Administration ➔ Business Units and Locations.

For detailed instructions for creating Business Units and locations, see ProjectArea Administration Help.

**Task 2: Create ProjectArea Metrics**

Use ProjectArea Administration to create the Metrics that you want to include in your portfolios, processes, and portfolio reports.

- From the File menu, choose ProjectArea Administration ➔ Definitions.

For more information about defining Metrics, refer to the *Centric Process User Guide* in this manual and to ProjectArea Administration Help.
Task 3: Create a portfolio

Once you have defined at least one Business Unit, you can create a portfolio.

1. From the File menu, choose ProjectArea Administration ➤ Portfolios. The ProjectArea Portfolios dialog box appears.
2. Click the New button. The New Portfolio dialog box appears.
3. In the Business Unit box, select the Business Unit to be associated with the portfolio.
4. In the Description box, type a description for the portfolio.
5. Click OK.

For more information about creating and managing portfolios, refer to the Centric Process User Guide in this manual and to ProjectArea Administration Help.

Task 4: Select projects for the portfolio

You can add any project in the ProjectArea to the portfolio as long as the project is associated with the same Business Unit as the portfolio or the project is not associated with any Business Unit. If you add a project that is not associated with a Business Unit, it is automatically associated with the portfolio’s Business Unit.

Note: Project Authors select the Business Unit for their projects by editing a project’s properties with Project Administration. ProjectArea Administrators can also select the Business Unit for a project by viewing or editing the project’s properties with ProjectArea Administration.

Use the following procedures to add projects to the portfolio.

To add projects to a portfolio

1. From the File menu, choose ProjectArea Administration ➤ Portfolios. The ProjectArea Portfolios dialog box appears.
2. In the Portfolios list, select the portfolio for which you want to add projects.
3. Click the Properties button. The Portfolio Properties dialog box appears.
4. Click the General tab.
5. Under the Projects list, click Add. The Select Projects for Portfolio dialog box appears.
6. Select the projects that you want to add to the portfolio.

7. Click OK.

   If any of the projects you added have upstream dependencies, the Select Upstream Projects dialog box appears.

8. Select the upstream projects you also want to add to the portfolio.

9. Click OK.

   For more information about adding and removing projects for portfolios, refer to ProjectArea Administration Help.

**Task 5: Create Strategic Objectives for the portfolio**

Strategic objectives are simple text statements that define the qualitative goals for the portfolio. For example, you might create an objective statement called “Market Split” that says, “The market split should be 1/3 AEC and 2/3 PD.”

**Note:** You can define Strategic Objectives for portfolios only if the optional Portfolio Planning module is enabled for your Centric Project server.

**To create a Strategic Objective**

1. In the ProjectArea Portfolios dialog box, select the portfolio for which you want to create Strategic Objectives.

2. Click **Properties**. The Portfolio Properties dialog box appears.

3. Click the Strategic Objectives tab.

4. Click **New**. The New Strategic Objective dialog box appears.

5. Enter a name and statement for the Strategic Objective.

6. Click **OK**.

For more information about creating and managing Strategic Objectives, refer to ProjectArea Administration Help.
Task 6: Select Strategic Metrics for the portfolio

Strategic Metrics define the quantitative measures of the portfolio. To add a Strategic Metric to a portfolio, you must select a Metric that has already been defined for the ProjectArea. This ensures that the portfolio and its projects all use the same Metric definition.

When you add a Strategic Metric to a portfolio, you can specify its

- **Category** – For example you can create and assign Strategic Metrics like risk, finance, or market.
- Rank in relation to the portfolio’s other Strategic Metrics
- **Criticality** – Critical Metrics are grouped together in the Strategic Alignment report.
- **Target value** – The target defines a goal for the Metric. The Strategic Alignment report compares this value against the Metric values for the portfolio’s projects. The Strategic Value List report displays the sum of the Metric across all projects in the portfolio and compares those values with the target.

**Note:** You can add Strategic Metrics to your portfolio only if the optional Portfolio Planning module is enabled on your Centric Project server.

**To add a Strategic Metric to a portfolio**

1. In the ProjectArea Portfolios dialog box, select the portfolio to which you want to add a Strategic Metric.
2. Click **Properties**. The Portfolio Properties dialog box appears.
3. Click the Strategic Metrics tab.
4. Click **New**. The New Strategic Metric dialog box appears.
5. Click **Select** to choose a ProjectArea Metric for this portfolio. The Select Fields dialog box appears.
6. Select the Metric that you want to add as a Strategic Metric to this portfolio.
7. Click **OK**.
8. Fill out the rest of the information for the Strategic Metric.
9. Click **OK**.

For more information about creating and managing Strategic Metrics, refer to ProjectArea Administration Help.
Task 7: Give users access to the portfolio

A portfolio is available only to those users that are given access to the portfolio. There are two levels of access to a portfolio: Viewers and Managers.

From the My Dashboard window portfolio Viewers can
- Create private portfolio reports
- Import reports as private portfolio reports
- Export private portfolio reports
- View public and private portfolio reports

From the My Dashboard window, portfolio Managers can
- Edit the portfolio’s properties
- Create, edit, and delete public portfolio reports
- Create, edit, and delete private portfolio reports
- Import reports as public or private portfolio reports

Note: ProjectArea Administrators can edit or delete any portfolio in the ProjectArea (regardless of who created it), can create new portfolios, and can manage the public reports for all portfolios.

To give users access to a portfolio

1. In the ProjectArea Portfolios dialog box, select the portfolio to which you want to select users.
2. Click Properties. The Portfolio Properties dialog box appears.
3. Click the Permissions tab.
4. Under “Viewers”, click Select and choose the ProjectArea users who can have Viewer access to the portfolio.
5. Under “Managers”, click Select and choose the ProjectArea users who can have Manager access to the portfolio.
6. Click OK.

For more information about portfolio permissions, refer to ProjectArea Administration Help.
Creating portfolio reports

After you’ve created your portfolios and ProjectArea Metrics, use the following procedures to create reports for your portfolios.

Task 1: Add Metrics to your project processes

Add ProjectArea Metrics to your process templates in ProjectArea Administration or to your ongoing project processes in your projects.

- To edit process templates: From the File menu, choose ProjectArea Administration > Process Templates.
- To edit project processes: go the Process page on the Dashboard tab in your project workspace.

For more information about adding Metrics to process templates, see ProjectArea Administration Help. For more information about adding Metrics to project processes, see Project Workspace Help.

Task 2: Define portfolio reports

Centric Portfolio allows you to create two types of portfolio reports:

- **Public** reports are those that are available to all project users who have access to the portfolio.
- **Private** reports are those that a project user creates and are available only to that user.

ProjectArea Administrators define and maintain the public portfolio reports for a ProjectArea. Project users with access to the reports can view them and create “what-if” versions by selecting projects for them, but cannot alter the report. Project users can export public reports and then import them as private reports so that they can edit them.

Project users can edit their own private reports as much as they like. They can also export their private reports so that they can be imported as private or public reports.

ProjectArea Administrators create and maintain public reports and their own private reports with ProjectArea Administration. All project users view public and private reports and maintain their private reports on the Portfolio Analysis tab of the My Dashboard window.

**To define a public portfolio report**

1. From the File menu, choose ProjectArea Administration > Portfolios. The ProjectArea Portfolios dialog box appears.
2. Select the portfolio to which you want to add a report.
3. In the report dialog box, click Actions and then choose New.
   The Report wizard starts and displays the Report Properties page. Use this page to give the report a name, to select the type and style of the report you want to create, and to select whether you are creating a public or private report.
4. Specify the properties for the report.
5. Click Next. The Report Fields page appears. Use this page to select the data you want to include in the report.
6. Specify the data that you want to include in the report.
7. Click Next. The Report Filter page appears. Use this page to build a filter statement that defines which information to include in the report.
8. Define the filter statement you want to use (if any).

The report is now available to be viewed on the Portfolio Analysis tab of the My Dashboard window by project users who have access to it. For more information about creating and managing public portfolio reports, see ProjectArea Administration Help.

To define a private portfolio report
1. Open the My Dashboard window.
2. Click the Portfolio Analysis tab.
3. From the Actions menu, choose New (or click the Actions button and then choose New).
   The Report wizard starts and displays the Report Properties page. Use this page to specify the report’s name and description, its type and style, and whether it is a private or public report.
4. Specify the name, description, report type, and report style for the report.
   Note: If you are a ProjectArea Administrator, you can also select to make this a public report by selecting Public in the Report Viewing box.
5. Click Next. The Report Fields page appears. Use this page to select the data you want to include in the report.
6. Specify the fields that you want to include in the report.
7. Click **Next**. The Report Filter page appears. Use this page to build a filter statement that defines which information to include in the report.

8. Define the filter statement you want to use (if any).

9. Click **Finish**. The new report appears in the Reports list.

The report is now available to be viewed on the Portfolio Analysis tab of the My Dashboard window. For more information about creating and managing private portfolio reports, see Project Workspace Help.
Viewing portfolio reports

Once portfolio reports have been created, users with access to the Portfolio Analysis tab in the My Dashboard window can view, print, and download any public report and their own private reports.

Note: Only those users with access to the Portfolio Analysis tab in the My Dashboard window can view portfolio reports. You give a user access to Portfolio Analysis tab by giving them access to one or more portfolios in the Project Area.

When you are viewing a report, you can print it in HTML format; perform further project filtering to focus on selected projects for the report, download it, or open a copy of the report in PDF, Microsoft Word, RTF, or Microsoft Excel format. These formats are useful for sharing reports and including them in documents. If you open the report in Excel, you have the ability to analyze it further, and to experiment with alternate scenarios.

To view a portfolio report

1. Open the My Dashboard window.
2. Click the Portfolio Analysis tab.
3. In the Reports list, select the report that you want to view. The report appears in the window or page.
4. If the whole report doesn’t fit in the window or page, use the window’s scroll bars to see more of the report.

To print, download, filter, or open a report in a different format

1. In the Reports list at the top of the Portfolio Analysis tab, select the report that you want to print, download, or open in a different format.
2. From the Actions menu, choose the command that you want.
Exporting and importing portfolio reports

Centric Portfolio gives you the ability to export and import your portfolio reports. By using the export and import features, you can move reports to other ProjectAreas or share private reports with other project users.

When a ProjectArea Administrator imports a report into the ProjectArea Portfolio Reports dialog box in ProjectArea Administration, the report becomes a public report, available to any user with access to the portfolio. When project users import a report into the Portfolio Analysis tab of the My Dashboard window, the report becomes a private report, available only to the project user who imported it.

For example, if a user creates a private report on the Portfolio Analysis tab and then exports the report, it can be imported into the ProjectArea Portfolio Reports dialog box and made available to all project users with access to the portfolio into which it was imported.

To export a report from ProjectArea Administration

1. From the File menu, choose ProjectArea Administration &gt; Portfolios. The ProjectArea Portfolios dialog box appears.
2. Select the portfolio that contains the report you want to export.
3. In the Reports list, select the report that you want to export.
4. Click Actions and then choose Export. The Export Reports dialog box appears.
5. Select which reports to include in the export file:
   - To create an export file that contains all reports listed in the Reports list, select the Export All Reports option.
   - To create an export file for a single report, select the Export Selected Report option and then choose the report that you want to export.
6. In the Name box, type the name that you want to give the report export file.
7. Click OK.
   When the export file has been created, a message appears that lets you know the export was successful.
8. Click OK.
To export a report from the Portfolio Analysis tab

1. In the Reports list on the Portfolio Analysis tab, select the report that you want to export.
2. From the Actions menu, choose Export. The Export Reports dialog box appears.
3. Select which reports to include in the export file:
   - To create an export file that contains all reports in the Reports list, select the Export All Reports option.
   - To create an export file for a single listed report, select the Export Selected Report option and then choose the report that you want to export.
4. In the Name box, type the name that you want to give the report export file.
5. Click OK.
   When the export is complete, a message appears that lets you know the export was successful.
6. Click OK.

To import a report with ProjectArea Administration

1. If you are importing an exported report file from another ProjectArea, use Windows Explorer to copy the appropriate export file (.xml) to the correct sub directory in the rpt_templates directory in this ProjectArea.
2. From the File menu, choose ProjectArea Administration  Portfolios.
3. Select the portfolio that contains the reports that you want to export.
   Note: Private reports are imported into all portfolios.
4. Click Actions and then choose Import.
   The Import Reports dialog box appears and displays a list of the available export files.
5. Select the report file that you want to import.
6. Click Import.
   When the reported file has been imported, a message appears that lets you know the import was successful.
7. Click OK. The imported reports appear in the report dialog box.
To import a report into the Portfolio Analysis tab

1. If you are importing an exported report from another ProjectArea, use Windows Explorer to copy the appropriate export file (.xml)) to the correct sub directory in the rpt_templates directory in this ProjectArea.

2. Navigate to the Portfolio Analysis tab in the My Dashboard window.

3. From the Actions menu, choose Import. The Import Reports dialog box appears and displays a list of the available export files.

4. Select the report file that you want to import.

5. Click Import.
   When the import is complete, a message appears that lets you know the import was successful.

6. Click OK. The imported reports appear in the Reports list.
Centric Charter™ User Guide
Welcome to Centric Charter

In this chapter

- What is Centric Charter? 204
- How Centric Charter works with other Centric Software solutions 207
- Applications and benefits of Centric Charter 208
- Who uses Centric Charter? 211
- Understanding Centric Charter concepts 212
- Understanding Centric Charter permissions 219
- Charter design guidelines 221
- System requirements 222
- Using this guide 223
What is Centric Charter?

Companies need a standardized way to organize and capture fundamental information about their projects so that projects can be compared and evaluated. This information is usually developed in the early proposal phase of a project and forms the basis of a project charter, which defines the project’s scope and goals. A charter provides value throughout a project’s lifecycle, communicating the intent of the project to executives and team members alike, focusing attention on the project’s objectives, and aligning the team and management to meet those objectives.

Centric Charter™ brings the concept of a project charter into the Centric Project. Centric Charter is a software based project charter, designed to support your entire project and product lifecycle from initial proposal through product release or project completion. It helps you make better decisions in initial project selection and do a better job of executing projects against those objectives. With Centric Charter you can

- Quickly create consistent project proposals to improve your project proposal process and make better decisions in initial project selection.
- Gain a quick ‘lay of the land’ by capturing key information about ongoing projects.
- Provide executives with rapid access to key project information.
- Reduce the burden on the Project Managers of having to collect, calculate, and communicate project metrics
- Create a consistent set of project business/financial metrics and key objectives that direct business culture for maximum effectiveness.
- Guarantee consistent, dynamic calculation of key financial metrics as project information is updated by team members over the entire lifecycle of the project.
- Put the focus on objectives to align your team and to do a better job managing against those objectives.

Centric Charter follows a familiar spreadsheet metaphor that supports many of the features of spreadsheet applications like Microsoft Excel. Unlike a flat spreadsheet file, however, Centric Charter dynamically references a wide range of live project data (such as key dates, resource requirements, and financial parameters) that are mapped directly into charter cells. This powerful capability ensures that your charters display up-to-date information, freeing Project Managers from the time-consuming burden of manually collecting data and the error-prone
process of re-typing values. As project team members develop critical project metrics, their values are immediately available to Project Managers and executives through Centric Charter. Conversely, mapped project data can also be updated through Centric Charter, providing Project Managers with a unified interface for entering and maintaining a wide range of project information.

A project charter can also include formulas that dynamically derive and update project values from existing project data. This revolutionary concept extends the ability to establish formal data relationships and calculations to anyone with a working knowledge of spreadsheet formulas. For example, you can easily design a charter that determines the present value of a series of sales projections or that calculates the variance between target and actual project dates or cost measures. The applications of this powerful capability are nearly limitless.

This sample charter shows some of the types of information you can include in your charters.

Centric Charter provides a very effective interface for entering and displaying project information. It offers nearly complete flexibility in laying out a charter. Centric Charter has the look, feel, and
functionality of a spreadsheet document. If you are familiar with Microsoft® Excel, you will be comfortable with Centric Charter.

A charter can be defined as a ProjectArea template that can then be used to manage a set of projects with similar goals and objectives. The example above shows a charter for a new product introduction project. The template for this charter could be applied to many different new product introduction projects. Variants of this template could be created for different types of new product projects, such as a charter for new consumer products and a different charter for new OEM products. Charters are equally applicable in the building and construction trades, for example, as a means of capturing and tracking key commitments or of evaluating alternative facility improvement proposals.
How Centric Charter works with other Centric Software solutions

Centric Charter has a unique role in integrating project information from other Centric Project software solutions. A project charter can reference fundamental project information such as the project’s name and the categories to which the project belongs. A charter can also reference Centric Process information (such as key milestones and Metrics) and project resource information from Centric Resource. Centric Charter not only displays this aggregated information, but also serves as a unified interface for entering or updating this information and can even derive project data values through formulas.

Centric Charter is also an aggregator of data. As project team members develop financial projections, engineering specifications, resource requirements, etc., the information is automatically incorporated in the charter, avoiding wasteful double entry of data and ensuring that the charter reflects up-to-date information.

Centric Charter and Centric Process share an important relationship. The first phase of many project processes, often called Phase 0, involves the development of a project proposal, which is then evaluated at the succeeding Decision Point. A project charter, on the other hand, contains key data on which a project is judged. The synergy between these two solutions is obvious. As the project team executes Phase 0, critical project information is captured in the project charter. The same executive who makes the go/no-go decision about the project has access to the developing project charter, which provides him with a concise subset of proposal data, as well as a way to track the proposal’s progress.

Groups of charters can be analyzed and compared by using Centric Portfolio and Cross-Project Analytics. As mapped project data is entered in a charter, it immediately becomes available for use in analysis, providing the advantage of immediate reuse of live project information without re-keying. The Portfolio Summary Report in Centric Portfolio provides direct access to the charters for all projects in a portfolio, allowing side-by-side comparisons of project charters.
Applications and benefits of Centric Charter

Centric Charter is designed to address a wide range of business problems throughout the life of a project. This section describes how Centric Charter can help you develop a solid understanding of current project activities, make better decisions in initial project selection, and do a better job of executing projects against objectives.

Order from chaos

An incomplete understanding of current project activities challenges many companies. Centric Charter is an excellent means to collect critical project information and make “order from chaos”.

Using Centric Charter, you can quickly lay out a simple project charter that captures essential project information, including the project’s name, Project Manager, objectives, key dates, cost estimates, etc. This is information that your Project Managers already know, but that is often not well documented or is scattered across many project documents, making it hard to collect and even harder to use. To capture this information, you define a charter as a standard template that Project Managers use to summarize their projects.

Simply entering project information in a charter makes project and product managers’ knowledge instantly available to your executive team and accessible from other Centric Software solutions. This is the fastest way to take advantage of the powerful analysis capabilities of Centric Project.

Centric Charter automates the capture of key project information, offering you a rapid understanding of your project landscape and providing the information you need to evaluate each project’s alignment with corporate strategy, develop resource allocation strategies, manage project timelines, and identify critical risks. With no lengthy lead times and very little organizational change, you’ve made order from chaos.

Centric Charter combines the ease-of-use of the spreadsheet user paradigm with the roll-up facility of a centralized database. Both of these characteristics make the “order from chaos” solution feasible. Because Centric Charter is a spreadsheet application, it looks and feels familiar to a large percentage of business and project professionals. This deployment advantage reduces adoption risks and speeds acceptance. Unlike a typical spreadsheet file, however, Centric Charter is dynamically connected to an underlying database. Information entered in Centric Charter is instantly available to executives, enhancing their understanding of project activities.
**Project selection**

Once current activities are understood, the next step is to focus on new projects and the problems of project proposal and selection.

To select the right projects you must first collect the right information about each proposal, and then collect the information in a consistent format that supports apples-to-apples comparisons. If either aspect falls short, your ability to make optimal project selection decisions will be compromised. Centric Charter has been specifically designed to support these aspects of project selection.

Centric Charter templates standardize the project proposal process. By using charter templates, you help guarantee that the right information is captured and considered. Charter templates support the creation of a consistent set of Metrics to facilitate project comparison and to focus attention on those Metrics that are critical to managing your organization. With Centric Charter, you can define different templates to support different kinds of projects, providing variation where necessary, while supporting a core of common Metrics.

Centric Charter automates project proposal development and data collection. This allows effective evaluation of project proposals with reduced administrative data-gathering overhead and accelerated transition from proposal definition to project startup.

**Project monitoring**

After a project is proposed, selected, and started, Centric Charter can be used to facilitate its review based on a comparison of initial goals and actual performance.

Project goals are formally established when the project proposal is accepted. You can represent these goals in a charter as target values, each with a corresponding projected or actual (current) value field. You can easily create formulas that compare the target and projected/actual values, calculating a variance. Variance can be calculated for just about any type of metric including dollar amounts, dates, etc. Executives can examine these variance values to quickly ascertain the health of a project.

For example, if a project’s target completion date is 1/1/04, and the current projected completion date is 6/1/04, the variance would be calculated as 6-month slip. That variance would clearly stand out for any executive viewing the project’s current charter. Formulas can even be established that combine variances to determine a net project compliance to plan, providing yet another derived measure of project health.
Centric Charter does more than assist in project monitoring. By keeping project objectives at the forefront for the duration of a project, Centric Charter focuses your project team on achieving those goals, enhancing their success at achieving those goals. Centric Charter can be a valuable agent for cultural change, creating an environment in which results are expected and attained.

**Evolving to meet your requirements**

Centric Charter is a highly flexible tool that can evolve to meet the changing requirements of your projects and the increasing sophistication of your needs. You may start by using Centric Charter as a quick way to collect project data and evolve to its use as the hub of a system for data collection, data calculation, and performance monitoring that supports comprehensive data integration with other Centric Project modules and features.

For example, a preliminary charter can be set up initially to form the target, with key dates and Metrics as local values visible and changeable only in the charter itself. This allows the charter to be the primary tool for collaboration on the project during its early stages. As the project evolves toward full execution and delivery, those same key dates can be mapped to standard Centric Process steps, dates, and Metrics to define charter “Actuals”. Variances between project information actual vs. target values can be calculated as mathematical expressions. Full reporting and analysis for mapped values is available via Cross-Project Analytics and Centric Portfolio. The charter then becomes a monitoring tool for Project Managers, who can see a unified view of their projects and make changes in critical project objectives and milestones. Centric Charter snapshots can be used to track changes over the course of the project and facilitate and understanding of how and why the project got to its current state.
Who uses Centric Charter?

Project Managers use Centric Charter to capture, calculate, and communicate key project information during the processes of project proposal and project execution. Project managers and project manager assistants typically have primary responsibility for overseeing the entry and production of charter data.

Executives use Centric Charter to rapidly understand the scope, goals, and status of a project or project proposal.

Project team members use Centric Charter indirectly, by contributing project information that is incorporated in a charter.

ProjectArea Administrators are responsible for creating standard charter templates and for making the templates available for use on projects and project proposals.
Understanding Centric Charter concepts

This section describes the following Centric Charter concepts:

- The charter interface
- Mapped data
- Resource summaries
- Formulas
- Charter templates
- Linked processes
- Snapshots

Each of these concepts is described below.

The charter interface

Centric Charter is a spreadsheet-based application that supports many of the functions of Microsoft Excel.

To create a charter, you use the spreadsheet interface to lay out a charter design that includes labels, images, local data, mappings to live project data, and formulas. You can set row height and column width, merge cells, and use formatting options to determine the appearance of an individual cell or a range of cells. For more information about cell formatting options, see “Appendix C: Charter cell properties and formatting”, starting on page 251.

In addition to designing the charter completely in the charter interface, you can import an Excel 97 spreadsheet to create or update a charter layout. This allows you to design a charter that is based on a form your company already uses. For more information about Excel compatibility, see “Appendix B: Excel compatibility,” starting on page 249.

To create a finished charter, you can lock any cells that should not be modified by users when they update charter information.

Mapped data

A powerful capability of Centric Charter is the ability to incorporate live project data in the project charter by mapping charter cells to project information. A charter “aggregates” this project information, providing a unified interface to display and work with data that comes from a variety of sources and can be the work of various project team members.

The following project data can be mapped to charter cells:
- Project properties, including the project’s name, description, Project Manager, Assistants, and Business Unit
- Project Parameters
- Project process information, including the process’ current state, current status, Metrics, and Work Period estimated or actual dates (only if the optional Centric Process module is enabled)
- Project categories (only if the optional Centric Portfolio module is enabled)
- Resource information (only if the optional Centric Resource module is enabled)

For detailed information about the capabilities and restrictions of each of these types of data, see Appendix A: Mapped data capabilities and restrictions,” starting on page 247.

Project users with Reviewer or higher access to a worksheet in the charter can update mapped values from on that worksheet from within the Charter window, either by making edits directly in the charter cells or by making changes in the appropriate dialog boxes.

For mapped Metrics and Parameters, you update the values by entering new values directly in the charter cells. The actual project values are not updated until you save your changes to the charter. This gives you the opportunity to try alternate scenarios and save your work when you are satisfied with the results.

For other types of mapped data, you update the values by double-clicking the value in the charter and making your changes in the dialog box that appear. Changes you make this way are saved to the project and charter as soon as you click OK in the dialog box. For example, to update a mapped process date in the charter, you double-click the date and edit the date in the Edit Estimated Dates dialog box.

If a charter cell is mapped to a Parameter or Metric, you can lock the mapped cell so that its value can be updated only from within the charter, not from the project.

Resource summaries

A resource summary is a special mapped data function that automatically calculates aggregate values for resource information that meets specific criteria for the whole project or a specific span of planning periods. You create resource summaries for a specific charter and they are used only by that charter.

Resource summaries can be a collection of any resources of the same type. You can further refine them by selecting resources of a particular
category and/or location, or even by selecting the specific resources that you want to include.

After you create a resource summary, you can map a charter cell to it so that the cell displays the resource summary’s calculated value in aggregate units or aggregate cost (if unit cost is available for the resource type selected in the summary).

Formulas

A powerful feature of Centric Charter is the ability to define formulas that establish and calculate mathematical relationships between the cells of a charter. For example, you might define a formula to sum costs, to calculate a return on investment, or to calculate the time delta between a target and an actual completion date. Cells with formulas are automatically updated to reflect changes in referenced cells – even where there are complex interdependencies among cells. You can define a formula that uses one or more mapped data values to derive and update the value of another mapped item (for example, a mapped Parameter or Metric).

Charter formulas can calculate with numbers, text, logical values, cell references, and other formulas. You can easily calculate the sum of a series of cells, the total of values in a column, a minimum or maximum value within a range, the rounded result of another formula, or the absolute value of a cell entry. Formulas can express complex interdependencies among cells, and they can define constraints on the calculation, such as limits on acceptable values or specific conditions under which a calculation should take place.

Centric Charter supports most standard arithmetic, text, and logical operators:

- Arithmetic operators calculate numeric values
- Text operators act on strings of text
- Logical operators evaluate true/false conditions.

Centric Charter also supports a rich set of functions. These functions support mathematical operations such as ABS() and SIN(), statistics such as AVG() and COUNT(), string manipulation such as STRCAT() and STRLEN(), finance functions such as IRR() and PV(), and date functions such as HOUR(), and MINUTE(). If you import an Excel spreadsheet with functions in it, the functions will be correctly brought into Centric Charter. For a list of supported functions, see “Appendix D: Charter built-in functions,” starting on page 253.

- Formulas can contain any or all of the following types of values:
Numbers, such as 123, -123, 12.3
Addresses of single cells, such as A1, D5, Z100
Addresses of cell ranges such as B12..G29, A1..D5
Absolute cell references denoted with dollar signs before the fixed coordinate ($A$1, $A1,$ or A$1), which will not be updated when the referencing cell is moved or copied
Functions such as @SUM or @RADIANS, with their arguments
Text surrounded by double quotation marks, such as “The sum is “ or “Total”
User-defined cell names or cell range names, such as TOTALS or PROJECT1

The real power of formulas lies in their ability to calculate relationships among different cells in the spreadsheet by including row and column coordinates, or address.

A specific cell can be referenced by its grid address. For example, D5 references the cell in Row 5 Column D.

A range of cells can be referenced by specifying the address of the row and column coordinates of two cells in opposite corners of the block to be referenced, with two periods ( .. ) between the coordinates. For example, ‘A1..E5’ references the first five columns and the first five rows of the spreadsheet.

**Note:** This differs from Microsoft Excel. The equivalent Excel syntax is A1:A5.

The charter allows cells to be referenced as relative, absolute, and indirect (or current cell) addresses. It also supports computed cell references as the result of a function.

Display values for mapped cells are updated automatically. Any mapped values changed outside of the charter are automatically updated in the charter.

When editing the charter, if any errors occur while saving changes, the formula output values are not saved (other changes made to the charter are saved) and a message appears that indicates that the charter has errors. You can correct the errors by editing the formulas or by fixing referenced definitions that have been changed or removed. You can also close the charter window and fix the changes later.

Once entered in a cell, formulas are normally hidden behind the scenes, perform their work in the background, and display only the result of their calculation. To view a cell’s formula, click the cell. To view all
formulas in the charter, choose Show Formulas from the Charter’s View menu.

Formulas are not only executed when you update values in a charter. Formulas are also driven automatically by updates made to mapped data that occur outside of the charter. In this case, the formulas will execute, even if the charter not visible. The only exception to this is if an error occurs in a formula, in which case the Project Manager is notified and must fix the formula before calculations will resume.

Charter templates

Centric Charter allows you to create one or more charter templates for a ProjectArea. Although Project Managers can create their own charters from scratch for their projects, charter templates provide a way to ensure consistency across your projects and proposals.

The ProjectArea Administrator is responsible for creating and managing charter templates. The ProjectArea Administrator can edit, delete, enable, import, and export the ProjectArea’s charter templates.

When you create a charter template, you can specify as much or as little information as you want. You can design the charter’s design, map cells to project data, and even link the charter to a process template (if you use the optional Centric Process module) so that the associated process is added to the project along with the charter. As a ProjectArea Administrator, you can lock the charter template so that Project Managers cannot edit or delete the layout of a charter based on the template.

While you are working on a template, the template is “disabled”. When the template is complete and you are ready for project Authors to use it on their projects, you “enable” the template to make it available to project Authors. Once a template has been associated with a project, changes made to the template in ProjectArea Administration do not affect the instantiated charter.

You can import and export charter templates so that you can create them in one ProjectArea and use them in another.

The interface for creating and editing a charter template is the same as that for creating and modifying a charter in a project workspace, with one important exception. When you map a cell in a project charter, you map it to actual project data; when you map a cell in a charter template, you map it to ProjectArea definitions. You can enter temporary data in the mapped template cells to test calculations. This temporary data is saved with the template for use in future editing sessions, but is ignored when you apply the template to a project.
If the charter template you use to create a project charter is mapped to Parameters, any Parameters not already in the project are added to the project. If the Dashboard tab does not already include the Parameters feature, it is automatically added when you add the charter.

If a Parameter in the charter template has the same name but a different type as a Parameter already in the project, the Parameter in the charter is not added to the project and an invalid cell mapping is created in the charter.

Linked processes

If the optional Centric Process module is enabled, you can link a charter template to a process template. This allows you to map charter template cells to data in the process template, such as its Metrics and estimated or actual dates. Linking a charter template with a process template also allows you to easily add them both to a project when you add one feature or the other. Although each charter template can be linked to only one process template, several charter templates can be linked to the same process template. This allows you to implement a system where the same process is used on different types of projects, but each type of project has its own, unique charter.

Centric Project will always attempt to maintain the relationship between a charter template and its linked process template. When a charter template is applied to a project, if it has a linked process template, the process will also be added to the project unless a process is already present. If the project already has a process, you can choose to have the charter template’s mapped cells be remapped to the project’s existing process (if possible).

When you export a charter template that is linked to a process template, the linked process template will automatically be included in the export file. Conversely, when you import that charter template, the process template will automatically be imported with the link intact.

A charter template that does not have an associated process template can be applied to a project that already has a process. The project charter can then be edited manually so that cells originally using local values can be mapped to actual project process data.

Snapshots

Charter history is supported with the ability to create both manual and automatic charter “snapshots”. A snapshot captures a copy of the charter and its data as of the time the snapshot was saved. A time/day
stamp and a description identify each snapshot. You can view and print snapshots, but you cannot edit them.

Project users with Editor or higher access to the charter can create a snapshot at any time. If the optional Centric Process module is enabled, charter snapshots are automatically created when a process transition is made in the project.

Project users with Editor or higher access to the charter can select to view the current version of the charter or any snapshot.
Understanding Centric Charter permissions

Centric Charter users fall into three basic categories: those that need to view charter information, those that need to update charter information, and those that need to edit the layout of a charter. A Project Manager can assign the following levels of charter access to each worksheet in the charter. Some of the concepts are described later in this chapter.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Access</td>
<td>- The user has no other access to the worksheet.</td>
</tr>
</tbody>
</table>
| Viewer        | - The user can view all charter data on the worksheet for the current version of charter, including mapped information that the viewer might not have access to.  
               - Viewers can print the current version of the charter worksheets to which they have access. |
| Reviewer      | - In addition to having all of the privileges that Viewers have, the user can edit values on the charter worksheet, according to the permissions described in the following table. |
| Editor        | - The user can update values on all charter worksheets and can edit the charter’s layout.  
               **Note:** The Editor permission gives the user access to all worksheets in the charter.  
               Editors cannot edit the layout of the charter if the ProjectArea Administrator has locked the charter. |

Project Managers, project Assistants, and Authors always have Editor access to the charter.

Executives (portfolio viewers and Project Managers) can always view the charter for any project in their portfolios by clicking the charter link in the Portfolio Summary Report.

A project charter can incorporate project information that a charter user might not otherwise be authorized to view or update. Changes made to data outside the charter can update values within the charter that then propagate to mapped values outside of the charter, even if the user making the original change does not have access to the charter or the final mapped value.

The following table describes charter permissions by role (Author, Project Manager, and Assistant) and by explicit charter worksheet permission (No Access, Viewer, Reviewer, and Editor):
The following table summarizes the general administrative permissions associated with charter templates and project charters:

<table>
<thead>
<tr>
<th>Capability</th>
<th>Role/Permission Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and edit charter templates</td>
<td>ProjectArea Administrator</td>
</tr>
<tr>
<td>Add or remove a charter associated</td>
<td>Author, Project Manager</td>
</tr>
<tr>
<td>with a project</td>
<td></td>
</tr>
<tr>
<td>Lock or unlock a charter template</td>
<td>ProjectArea Administrator</td>
</tr>
<tr>
<td>or project charter for layout editing</td>
<td></td>
</tr>
<tr>
<td>Edit the layout of a locked project</td>
<td>Author or Project Manager who is also a ProjectArea Administrator</td>
</tr>
<tr>
<td>charter</td>
<td></td>
</tr>
<tr>
<td>Set charter access permissions</td>
<td>Author, Project Manager</td>
</tr>
<tr>
<td>(via the Project Administration)</td>
<td></td>
</tr>
</tbody>
</table>

1 Project Managers are always Authors.
2 Centric Charter displays the standard project editing dialog boxes to update mapped project properties and process dates.
3 Assistants always have Editor permissions for the charter as well as full permissions for the process.
4 Metrics and Parameter values are edited directly in the charter cells.
Charter design guidelines

Given the range of problems to which Centric Charter can be applied, the range of data that a charter can incorporate, and the degree to which Centric Charter is programmable, its obvious that the possibilities for charter design are enormous. If you had a specific application in mind when you purchased Centric Charter, you may already have a clear idea of what information you want to include. Still, some recommendations and usual caveats do apply.

First, start simple. Centric Charter is a very capable tool, and the temptation is always to take full advantage of the power as quickly as possible, but it makes more sense to start with a simple implementation and build on its success.

If this is the first time your company has attempted to use charters in the process of project proposal and evaluation, you should think in terms of essential data. What is the key information that an executive would need to evaluate in a proposal and what might he need to compare it to other proposals, or to projects that are already underway? What information is essential to capturing the goals and scope of a project? Will it help to clarify the understanding of the project? If the information won’t help in the decision making process, and if it isn’t essential to communicating the key facts of the project, it doesn’t belong on the charter.

Think about how you will use your charter. Who will have access and what worksheets will they have access to? When will the information be entered? When will it be viewed? When should snapshots be created? How does the charter fit into your overall process?

Think carefully about the form layout. It can be very helpful to sketch out your charter on a whiteboard before you take to the keyboard. List the key information, and then think about how you want to organize it. Develop a clean look for your charter. It can also help to include a graphic such as a company logo.
System requirements

To be able to use Centric Charter, Centric Project must be installed on your server and the Centric Charter module must be enabled on the Centric Project server.

To be able to link a charter template to a process template or map charter cells to project process information, the optional Centric Process module must be enabled.

To be able to map charter cells to resource summaries, the optional Centric Resource module must be enabled.

For more information about enabling application modules, refer to the Centric Project Platform Administrator Guide.

Complete Centric Project hardware and software requirements are included in the Centric Project Readme file (Readme.html), which is available on your Centric Project CD in the ProjectServer directory.
Using this guide

The *Centric Charter User Guide* includes the following chapters:

**Welcome to Centric Charter** provides an overview of Centric Charter. It includes discussions of Centric Charter’s features, benefits, concepts, and integration with other Centric Software solutions. It also describes the permission levels and editing capabilities for Centric Charter users.

**Using Centric Charter** explains how to use Centric Charter to create and edit charter templates, link a charter template to a process template, add a charter to a project, view the project charter, and print the project charter.

**Appendix A** is a table that indicates the capabilities and restrictions for mapped data in the charter.

**Appendix B** lists the features of Excel spreadsheets that are supported when imported into Centric Charter.

**Appendix C** describes the cell formatting capabilities that are supported in Centric Charter.

**Appendix D** provides a full reference for Centric Charter’s built-in functions.
Using Centric Charter

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Charter Template window and the Charter window</td>
<td>226</td>
</tr>
<tr>
<td>Creating charter templates</td>
<td>228</td>
</tr>
<tr>
<td>Editing charter templates</td>
<td>229</td>
</tr>
<tr>
<td>Linking a charter template to a process template</td>
<td>237</td>
</tr>
<tr>
<td>Making charter templates available to projects</td>
<td>239</td>
</tr>
<tr>
<td>Adding a charter to your project</td>
<td>240</td>
</tr>
<tr>
<td>Viewing a project charter</td>
<td>243</td>
</tr>
<tr>
<td>Viewing different versions</td>
<td>245</td>
</tr>
<tr>
<td>Printing a project charter</td>
<td>246</td>
</tr>
</tbody>
</table>
The Charter Template window and the Charter window

When you create charter templates with ProjectArea Administration, you use the Charter Template window. When you view or edit a project charter, you use the Charter window. Both these windows look and behave the same, although there are some commands that are available in each that are not available in the other.

This is an example of a blank Charter Template window.

The top of each window contains a menu bar, which gives you access to the commands you need for viewing and editing the charter or charter template, and a toolbar, which gives you tools for zooming the view and saving changes to the charter. If the window is in Edit Layout mode, the formula bar appears just above the column headings so that you can edit charter cell formulas. For complete descriptions of all menu and toolbar options, refer to Centric Project ProjectArea Administration Help and Centric Project Workspace Help.

Note: In addition to using the menu commands, you can access the commands for any cell in the charter by right-clicking the cell.
Immediately beneath the menu bar is the name of the version of the charter that you are viewing. If you are viewing a template, this area displays “Template” and the name of the charter template. If you are viewing the current version of a project charter, this area displays “Current Version”. If you are viewing a snapshot of a project charter, this area displays “Snapshot” and the date, time, and description for the snapshot.

The rest of the window displays the charter in a spreadsheet interface. You can remove the grid lines and change the zoom options by choosing commands from the View menu.

If you are a ProjectArea Administrator editing a project charter, or if you have permission to edit the project charter (as a charter Editor, Project Manager, Assistant, Author, or ProjectArea Administrator) and have turned on the Edit Layout mode, column and row headings appear on the sides of the spreadsheet grid and additional menus are enabled.
Creating charter templates

The first step to creating a new charter template is to add it to the list of charter templates defined for the Project Area by giving it a name and an optional description. Use the following procedure to add a new charter template to the list of defined charter templates for this Project Area. Once you have added the new charter template, you can edit it by adding or removing information, remove it, export it, link it with a process template, or make it available to be used with project workspaces.

To create a charter template

1. From the File menu, choose Project Area Administration ➤ Charter Templates. The Charter Templates dialog box appears.
2. Click Actions and then choose New. The New Charter Template dialog box appears.
3. Enter the name and description for the new charter template.
4. Click OK.

The new template appears in the list of templates at the top of the dialog box with a status of Disabled.

You can now edit the charter template by adding text and pictures, mapping cells to project information, and formatting the layout of the charter data. For more information, see “Editing charter templates,” on page 229.
Editing charter templates

Once a charter template is available in the list of templates in the Charter Template dialog box, you can edit the template by importing an Excel spreadsheet that contains the data you want, by adding worksheets, and by directly adding, formatting, and deleting text, data, formulas, and pictures in the Charter template window.

**Note:** For more information about editing charter templates, see ProjectArea Administration Help.

The following procedure describes how to open a charter template so that you can edit its design. The procedures on the next pages describe how to import an Excel spreadsheet, work with text and formulas in the charter template, map charter template cells to ProjectArea information, format charter template cells, and save your changes to the charter template.

**To edit a charter template**

1. From the File menu, choose ProjectArea Administration ▸ Charter Templates. The Charter Templates dialog box appears.
2. Select the Charter template that you want to edit.
3. Click Actions and then choose Edit. The Charter Template Editor window appears and displays the selected Charter template design. The Charter Template window’s editing menus and options are enabled.
4. Make the necessary edits. For more information, see the following pages and see “Editing Charter templates” in ProjectArea Administration Help.
5. To save your changes, from the File menu, choose Save to Server.
6. To close the Charter Template window, from the File menu, choose Close.
7. To make the template available for use as a project charter, you must change the template’s status from Disabled to Enabled. For more information, see “Making charter templates available to projects,” on page 239.
Importing an Excel spreadsheet

If you have already prepared an Excel spreadsheet that contains some or all of the charter layout or data, you can quickly create a charter by importing the Excel spreadsheet in Excel 97 format into the charter template.

**Note:** For information about how Centric Charter handles formatting and other features in the imported spreadsheet, see “Appendix B: Excel compatibility,” on page 249.

**To import an Excel spreadsheet into a charter template**

1. Drag and drop an Excel spreadsheet from Windows Explorer or your Windows desktop onto the Charter Template window.
   - or -
   From the Charter Template window’s File menu, choose Import Excel Spreadsheet. In the Open dialog box, browse for the spreadsheet that you want to import and then click Open.
   If the existing charter template has any mapped cells, a message appears that asks if you want to preserve the mapped cells.

2. To preserve the mapped cells, click Yes. To remove the mappings, click No. The Excel spreadsheet is imported into the Charter Template window.

3. To save your changes, from the File menu, choose Save to Server.

You can now edit the charter template by adding text and pictures, mapping cells to project information, and formatting the layout of the charter data.

Working with charter template worksheets

When you first create a charter template, it contains a single worksheet (named “Sheet 1”, by default). When you edit your template, you can add more worksheets, delete worksheets, rename worksheets, and change their order.

**To add a worksheet**

From the Charter Template window’s Insert menu, choose Sheet.
A new sheet is added as the last sheet in the charter template and given the default name "Sheet n" where "n" is the next sequential number.

To delete a worksheet
1. Select the sheet that you want to delete.
2. From the Edit menu, choose Delete Sheet (or right-click the sheet’s tab and then choose Delete). The sheet is deleted from the charter template.

To rename a worksheet
1. Select the sheet that you want to rename.
2. From the Edit menu, choose Rename Sheet (or right-click the sheet’s tab and then choose Rename). The sheet’s name is highlighted on the tab.
3. While the sheet's name is highlighted, type a new name.
4. Press ENTER.

To change the order of worksheets
1. Select the sheet that you want to move.
2. From the Edit menu, choose Move Left or Move Right (or right-click the sheet’s tab and then choose Move Left or Move Right).
3. The sheet moves one position to the left or right.

Working with charter template text

You can add text and numbers as labels, headings, and descriptive text anywhere in the charter template. The text you add to the charter template this way is not linked to any project information.

Use the following procedures to add, edit, format, or delete text from the charter template.

To add text to the charter template
Click in a charter cell and type the text you want to add.

To edit text in the charter template
1. Click the cell that contains the text that you want to edit. A single quote mark (‘) appears at the beginning of the text you selected.
Note: If the text spans multiple cells but the cells are not merged, you need to click in the first cell that contains the text in order to select all of the text for editing.

2. Click in the text or use the arrow keys to move the insertion point to the place where you want to make the edit.
3. Edit the text.
4. Click elsewhere in the charter to deselect the text.

To allow line breaks inside cells with text
1. Click the cell in which you want to be able to create line breaks.
2. From the Charter Template window’s Edit menu, choose Format.
   The Edit style dialog box appears.
3. Click the Align tab.
4. Clear the Allow Enter check box.
5. Select the Allow Enter check box again.
6. Click OK. You can now press the ENTER key in the cell to create a line break in the text.

To format text in the charter template
1. Click the cell that contains the text that you want to format. A single quote mark (‘) appears at the beginning of the text you selected.

   Note: If the text spans multiple cells but the cells are not merged, you need to click in the first cell that contains the text in order to select all of the text for editing.

2. From the Charter’s Edit menu, choose Format. The Edit style dialog box appears.
3. Select the formatting options you want to apply to the text.
4. Click OK.

To delete text from the charter template
1. Click the cell that contains the text that you want to edit. A single quote mark (‘) appears at the beginning of the text you selected.
Note: If the text spans multiple cells but the cells are not merged, you need to click in the first cell that contains the text in order to select all of the text for editing.

2. Select the text that you want to delete.
3. Press DELETE.

**Working with charter template formulas**

Use the following procedures to add, edit, format, or delete formulas in the charter template.

**To add a formula by editing in a cell**

1. Click the cell in which you want to enter the formula.
2. Type =.
3. Enter the formula.
4. Press ENTER or click elsewhere in the charter.

**To add a formula by using the formula bar**

1. Click the cell in which you want to enter the formula.
2. In the right-most box in the formula bar, type =.
3. Specify the formula you want:
   - To type a formula, type it immediately after the = sign.
   - To add a function, type the function in the formula box or click the function box (to the left of the formula box), select the function you want, and then click \( \text{function name} \) to add the function to the formula box.

   **Tip**
   - To quickly scroll to a function in the function box, type the first letter of the function you want in the function box or the formula box. The function box scrolls to display the first function that matches the text you entered.
   - To select a single cell or a range of cells to include in the formula, click \( \text{cell selection icon} \), then click and drag in the charter template grid to select one or more cells in the charter. When you release the mouse button, the cells you selected appear in the formula box.
   - To cancel the formula without adding it to the charter template, click \( \text{cancel icon} \).
4. When you are finished entering the formula, click ✓ (or press ENTER or TAB) to add the formula.

**Mapping charter template cells to ProjectArea information**

When you map a charter template cell to ProjectArea information, you create a link between that information and the charter template. When the charter template is used to create a project charter and the mapped information changes in the project, the change is reflected in the charter. When a user edits the mapped value in the charter, the corresponding information is also updated in the project.

For example, you can map a charter cell to a ProjectArea Parameter. If the template is used to create a project charter and the Parameter’s owner updates the Parameter on the Parameters page, the new value appears in the charter. If a charter Reviewer updates the Parameter’s value while viewing the charter, the value on the Parameters page is automatically updated.

The type of information that you can map to charter template cells depends on the information that is available in the ProjectArea. For example, if your ProjectArea does not contain any Parameter definitions, you cannot map to Parameters.

You can unmapped a mapped cell at any time. When you unmapped a cell, the link to the project information is removed.

If you map a cell to ProjectArea information that is later removed, the charter template displays an “Invalid Cell Mapping!” message at the top of the Charter Template window, displays the cell in the Invalid Cell style, and indicates which type of information it was previously linked to so that you can fix the link. You cannot use a template that contains invalid cell mappings to create a project charter.

**To map a cell to ProjectArea information**

1. Select the cell to which you want to map project information.
   
   **Note:** You can map ProjectArea information to only one cell at a time. You can map project information to a merged cell.

2. From the Charter Template window’s Insert menu, choose Map To and then select the type of information to which you want to map. The Map Cell dialog box appears.

3. Select the information that you want to map to the cell.

4. Click OK. The mapped cell is formatted to use the Mapped Cell style.
To unmap a cell from ProjectArea information

1. Select the mapped cell that you want to unmap.
2. From the Edit menu, choose Unmap. The cell is unmapped and is formatted to remove the Mapped Cell style.

To fix invalid cell mappings

1. Unmap the cell that has an invalid mapping.
2. Remap the cell to valid project information.

Formatting charter template cells

You can format any cell or group of cells in the charter template by changing a cell’s font, color, border, and alignment. For some cells, you can also specify the format (type) of data that can be entered in them.

Note: Format changes that you make do not override a cell’s style. For example, if you change the font for a particular cell and the style that is applied to the cell has a different font, the cell uses the style’s font.

To format cells in the charter

1. Select the cells that you want to format.
2. From the Charter Template window’s Edit menu, choose Format. The Edit styles dialog box appears.
3. Use the tabs to specify the font, color, borders, alignment, and format options for the selected cells.

Note: Changes you make on the Format tab do not apply to cells that are mapped to date, list, yes/no, or currency ProjectArea information.

4. When you are finished making changes, click OK. The cells are updated to reflect the formatting changes.

Saving charter template changes

When you have made changes to the charter template’s layout, you need to save your changes if you want to keep them.

The Charter Template window lets you know if there are changes to be saved by displaying the button in the Charter Template window’s toolbar.
To save changes to the charter template

- From the Charter Template window’s File menu, choose **Save to Server** (or click ![Save to Server](image) in the Charter Template window’s toolbar).
Linking a charter template to a process template

When you link a charter template with a process template, you can map cells in the charter template to information in the process template. For example, you can map charter cells to process dates, the current process state, or the process status.

Linking a charter template with a process template also allows you to easily add them both to a project when you add one feature or the other. For more information about adding a charter or process to a project, see Centric Project Project Workspace Help.

You can link some or all charter templates to process templates. You can link each charter template to the same process template or to different process templates.

Once a charter and process template are linked, you can link a different process template to the charter template. If the charter template has mappings to the old process template, Centric Charter will attempt to remap the cells to information in the new process template by matching mapped data names and types.

To link a charter template to a process template

1. From the File menu, choose Project Area Administration » Charter Templates. The Charter Templates dialog box appears.
2. Select the template that you want to link to a process template.
3. Click Actions and then choose Link to Process. The Select Process Template dialog box appears.
4. Select the process template that you want to link to the charter template.
5. Click OK. The process template’s name appears in the Linked Process column for the charter template in the Charter Templates dialog box.

To link a charter template to a different process template

1. From the File menu, choose Project Area Administration » Charter Templates. The Charter Templates dialog box appears.
2. Select the template that you want to link to a different process template.
3. Click Actions and then choose Link to Different Process. The Select Process Template dialog box appears.
4. Select the process template that you want to link to the charter template.

5. Click OK. The process template’s name appears in the Linked Process column for the charter template in the Charter Templates dialog box.

To unlink a charter template from a process template
1. From the File menu, choose Project Area Administration  Charter Templates. The Charter Templates dialog box appears.

2. Select the template that you want to unlink from a process template.

3. Click Actions and then choose Unlink from Process. A message appears that warns you that all mappings made from the charter template to the process template information will be removed from the charter template.

4. To unlink the templates, click OK.
Making charter templates available to projects

Project Authors can use a charter template to create a project charter when the template has a status of Enabled. When you first create a template, it has a status of Disabled. You can keep the status Disabled as long as you want. When you have finished editing the template and it is ready for use in a project, change its status to Enabled. If you want to work on a template later and not have it available to project Authors, you can change the template's status back to Disabled.

You can see the status of any charter template by looking at the Enabled column for the template in the Charter Templates dialog box.

**Note:** You do not have to change a template's status to Disabled in order to edit it. You can edit a template regardless of its status and regardless of its current usage in project workspaces.

**To enable a charter template to make it available to projects**

1. From the File menu, choose **Project Area Administration** ➔ **Charter Templates**. The Charter Templates dialog box appears.
2. Select the template that you want to make available to projects.
3. Click **Actions** and then choose **Enable**. The template’s status is changed to Enabled and is available to project Authors.

**To disable a charter template**

1. From the File menu, choose **Project Area Administration** ➔ **Charter Templates**. The Charter Templates dialog box appears.
2. Select the template that you want to disable.
3. Click **Actions** and then choose **Disable**. The template’s status is changed to Disabled and is no longer available to project Authors.
Adding a charter to your project

Once you have created a charter template, you must enable it to make it available to projects and then you can add it to your project.

You add a charter to your project by adding the Charter feature to your project’s Dashboard tab. If your project doesn’t already include a Dashboard tab, add it first, and then use the following procedure to add the Charter feature to the Dashboard tab.

**Note:** To use this procedure, the optional Centric Charter module must be installed on your Centric Project server, you must have Author access to the project, and the Edit Layout mode must be turned on.

**To enable a charter template to make it available to projects**

1. From the File menu, choose **Project Area Administration ➤ Charter Templates**. The Charter Templates dialog box appears.
2. Select the template that you want to make available to projects.
3. Click **Actions** and then choose **Enable**. The template’s status is changed to Enabled and is available to project Authors.

**To add the Charter page to the Dashboard tab**

1. Navigate to the Dashboard tab.
2. From the Layout menu, choose **Dashboard Feature ➤ Insert Feature ➤ Charter** (or right-click the left-frame of the Dashboard tab and then choose **Insert Feature ➤ Charter**). The Template Browser dialog box appears.
3. Select the template you want to use to create the charter. If no charter templates have been defined for the Project Area, or if you want to create a charter from scratch, select **<Blank Charter>**.

**Note:** If the template you want doesn’t appear here, it may not have been enabled for applying to projects. For more information, see “To enable a charter template to make it available to projects,” above.

4. Click **OK**.

If the charter template you chose is linked to a process template, a message appears that asks if you want to add the linked process template to the project.
Note: If the charter template you chose is linked to a process template and the project already has a process, a message appears that asks if you want to cancel adding the charter, add the charter and remove any mappings to process information, or add the charter and attempt to map its mapped cells to the project’s process. If you choose the last option, charter cells that are mapped to Metrics of the same name and type in the project’s process will be mapped. Charter cells that are mapped to Metrics that do not have the same name and type as the project’s process will result in invalid charter cell mappings.

5. Choose whether you want to also add the linked process to the project:
   - To add a linked process along with the charter, click **OK**.
   - To add the charter without its linked process, click **Cancel**.

Centric Project adds the charter (and the process, if you chose to add it) to the Dashboard tab.

Notes: To add the Process feature, the Dashboard tab must also include the Calendar feature. If the Dashboard tab does not already include the Calendar feature, it is automatically added when you add the charter and process.

If the template you chose is mapped to Parameters, any Parameters not already in the project are added to the project. If the Dashboard tab does not already include the Parameters feature, it is automatically added when you add the charter.

If a Parameter in the charter template has the same name but a different type as a Parameter already in the project, the Parameter in the charter is not added to the project and an invalid cell mapping is created in the charter.

If the template that you chose has any invalid cell mappings, a message appears that tells you that you cannot add the charter to the project until the mappings are fixed by the ProjectArea Administrator.

The Set Permissions dialog box appears so that you can set user permissions for the new features.

Note: The Set Permissions dialog box does not appear if you selected the **Don’t ask again in this browser**
session check box in the Set Permissions dialog box anytime during this browser session.

The Charter page displays a charter based on the template you selected.

Once you have added the Charter page, you can edit the charter by adding, deleting, and formatting text, data, formulas, and pictures, and you can map project information to it. The procedures you use for editing a charter are the same as those you use for editing a charter template. For more information, see “Editing charter templates,” starting on page 229 or refer to *Centric Project Project Workspace Help*.

**Note:** If the charter is based on a template that is locked, you cannot edit the charter unless you have Administrator rights to the ProjectArea.
Viewing a project charter

If you have access to view any worksheet in the project’s charter, you can view it from any of the following locations:

- From the Projects tab in My Dashboard
- From the project's View menu
- On the project's Dashboard tab

Once you are viewing the charter, you can view any worksheet in the charter to which you have been given access.

If you view the charter from the Projects tab or the View menu, the charter appears in a separate window. If you view the charter on the Dashboard tab, the charter displays as a Dashboard tab page. You can undock the charter from the Dashboard tab so that you can move it as an independent window as you work.

The following procedures describe how to view the charter, how to view a different worksheet in the charter, and how to dock or undock the Charter window.

To view the project charter from My Dashboard

1. On the Projects tab in My Dashboard, select the project for which you want to view the charter.
2. From the My Dashboard’s View menu, choose Charter (or click the icon to the left of the project’s name). The Charter window appears and displays the first worksheet to which you have access in the current version of the charter.

To view the project charter from the project's View menu

- From the project’s View menu, choose Charter. The Charter window appears and displays the first worksheet to which you have access in the current version of the charter.

To view the project charter on the Dashboard tab

- On the Dashboard tab, click the Charter button (or, from the View menu, choose Tab > Dashboard > Charter). The Charter window appears, docked in the right side of the Dashboard tab, and displays the first worksheet of the current version of the charter. You can undock the charter to have it appear in a separate window (see below).
To view a different worksheet

- At the bottom of the Charter window, click the tab for the worksheet that you want to view.

To dock or undock the Charter window on the Dashboard tab

- To undock the Charter window, click in the upper-right corner of the Charter window.
- To dock it again, click in the upper-right corner of the Charter window.
Viewing different charter versions

If you are a Project Manager, Assistant, Author, or project user with Editor access to the charter, you can view any "snapshot" versions of the charter that have been created. A snapshot preserves the values in the charter as they were at the time the snapshot was created.

When you first view the charter, the current version is displayed. Use the following procedure to view a snapshot version or to return to viewing the current version of the charter.

To view a different charter version

1. From the Charter window’s View menu, choose Charter Version. The Select Snapshot dialog box appears.
2. Select the version that you want to view.
3. Click OK.
Printing a project charter

Use the following procedures to print the charter and to view and adjust the charter’s page breaks for printing.

**To print the charter**

1. View the charter.
2. From the Charter window’s File menu, choose **Print**. The Print dialog box appears.
3. Select the print options that you want to use.
4. Click **OK**.

**To view or adjust the charter’s page breaks**

1. From the Charter window’s File menu, choose **Page Break Setup**. Page break lines appear in the Charter window to indicate the margins of each page of the charter.
2. To adjust a page break, click and drag the page break line to a new location.
## Appendix A: Mapped data capabilities and restrictions

<table>
<thead>
<tr>
<th>Cell Value</th>
<th>License Required</th>
<th>Editable in Charter</th>
<th>Editable By</th>
<th>Value can be Derived by Formula</th>
<th>Lockable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>None</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Project Description</td>
<td>None</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Project Manager</td>
<td>None</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Assistants</td>
<td>None</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Project Business Unit</td>
<td>None</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Parameter</td>
<td>None</td>
<td>Yes (if not formula), via –in-place editing</td>
<td>Author, Charter Editor, Charter Reviewer</td>
<td>Yes</td>
<td>Yes†</td>
</tr>
<tr>
<td>Current Process Step</td>
<td>Centric Process</td>
<td>No</td>
<td>N/A</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Current Process Status</td>
<td>Centric Process</td>
<td>No</td>
<td>N/A</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

† This indicates a specific behavior that is not directly visible through the interface, requiring manual intervention or a specific action.
<table>
<thead>
<tr>
<th>Cell Value</th>
<th>License Required</th>
<th>Editable in Charter</th>
<th>Editable By</th>
<th>Value can be Derived by Formula</th>
<th>Lockable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Step Date</td>
<td>Centric Process</td>
<td>Yes, via the Edit Estimated Dates dialog box</td>
<td>Project Manager or PM Assistant</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Metric</td>
<td>Centric Process</td>
<td>Yes, via in-place editing</td>
<td>Author, Charter Editor, Charter Reviewer, Project Manager, or PM Assistant</td>
<td>Yes</td>
<td>Yes¹</td>
</tr>
<tr>
<td>Resource Summary</td>
<td>Centric Resource</td>
<td>No</td>
<td>N/A</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Project Category</td>
<td>Centric Portfolio</td>
<td>Yes, via Project Properties dialog box</td>
<td>Author or Project Manager</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

¹ Mapped cell values that are lockable can be locked either by using the **Lock Mapped Output** command (available on the Charter window’s Edit menu) or are automatically locked if they are the output of a charter formula.
Appendix B: Excel compatibility

This appendix describes which features in an Excel spreadsheet are preserved when it is imported into Centric Charter charter.

File versions

- Excel 97 format files are supported. Excel 2000 officially saves as Excel 97 (it's referred to as Excel 97/2000) format, with some minor extensions, which may not work.
- Excel 2000 files should mostly import properly.
- Excel XP format files are not supported but can be optionally exported as Excel 97/2000 format file.
- Versions of Excel files prior to Excel 97 are not supported.

Functions and formula support

Almost all standard Excel 97 functions and formulas are supported; see table in section IV for full list. There are some small syntax differences (for example, ranges in Excel look like this: A3:B3. Ranges in Centric Charter look like this: A3…B3). The import process handles convert to the needed syntax automatically. Note that macros and imbedded VBScript are not supported.

Cell formatting support

- Fonts, colors, fills, font styles, and other cell formats (size, borders, alignment, text wrap) are supported; Cell protection is not supported.
- Merged cells are supported.
- Hidden cells are not supported; will be imported as visible.
- Conditional formatting (based on cell value) is not supported.
- Most Excel cell value display formats are supported or have equivalents (which are converted during the import process), including number (with precision), currency, date, time, percent, scientific, text. The fractions format is not supported.
**Overwriting of existing charter data on import**

Importing an Excel spreadsheet file completely resets the current charter (all cells are cleared). When you import an Excel file, you are given the option of preserving any mapped cells in the charter. If you select to preserve the mapped cells, the spreadsheet is imported and all originally mapped cells replace the exact same cells in the imported file.

Importing an Excel spreadsheet file deletes all existing worksheets in the charter template and adds a new worksheet named “Sheet 1”. You can rename the worksheet.

**Other advanced Excel features that are not supported**

- Macros and embedded VBScript
- Imbedded objects of any kind (for example, embedded Word or Visio objects)
- Embedded pictures
- Multiple worksheets (if multiple worksheets exist in the Excel file, only the first worksheet, hidden or visible, is imported)
- Graphing/charting functions
- Cell level locking
- Auto Filters
- Pivot tables
- Cell references to other worksheets and external objects
- Named cells and ranges
Appendix C: Charter cell properties and formatting

The following cell formatting capabilities are supported in Centric Charter:

**Cell size**
- Cell height and width

**Cell borders**
- Can individually specify borders for cell top, bottom, left and right
- Border color
- Border line width and style

**Cell value display alignment**
- Vertical alignment support for standard, top, center, bottom
- Horizontal Alignment support for standard, left, center, right
- Options for text wrap and auto size

**Cell value text properties**
- Font
- Font size
- Font style
- Font color

**Cell value format**
- Can specify selectable display formats for a cells value including numerous text, number, date, and currency formats
- Numeric formats can specify number precision (decimal places shown)
Cell colors

- Foreground and background colors can be set for any cell
- Supports optional 3D effects including inset and raised styles

In addition, Centric Charter supports the notion of merging cells, similarly to Excel, where you can make a range of cells act like a single cell for additional formatting flexibility.

Centric Charter also allows a cell to be filled with a raster image, which can be from any import file as long as it’s in PNG format.

Any cell in a Charter that is not mapped to other Centric Project data (a local value), can be set to allow for runtime editing. If a cell is enabled for runtime edit, its value can be changed and saved by users with the proper permissions. This is disabled by default.
Appendix D: Charter built-in functions

Centric Charter provides a wide array of functions that perform certain tasks. Functions can be used alone or in conjunction with formulas and other functions. The Charter grid provides many specialized functions in addition to those that are found in typical financial spreadsheets.

Charter functions are predefined formulas supplied with the program that perform the work of many formulas or perform special functions that cannot be achieved by formulas, such as manipulating text strings. They offer a shortcut approach to accomplishing the work of long, complex formulas. Mathematical and statistical functions are often used to sum a column of numbers, compute an average, determine a minimum or maximum value, or round the results of a formula. Other functions are used for more specialized purposes such as computing the future value of an investment or the product of multiplying one cell range by another range. Some functions perform calculations that arithmetic operators cannot handle such as text-string manipulations.

In this chapter

<table>
<thead>
<tr>
<th>Mathematical functions</th>
<th>254</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistical functions</td>
<td>256</td>
</tr>
<tr>
<td>Conditional statistical functions</td>
<td>259</td>
</tr>
<tr>
<td>String functions</td>
<td>260</td>
</tr>
<tr>
<td>Logic functions</td>
<td>262</td>
</tr>
<tr>
<td>Financial functions</td>
<td>263</td>
</tr>
<tr>
<td>Date and time functions</td>
<td>266</td>
</tr>
<tr>
<td>Miscellaneous functions</td>
<td>268</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@ABS(X)</td>
<td>The absolute value of X.</td>
</tr>
<tr>
<td>@ACOS(X)</td>
<td>The arc cosine of X.</td>
</tr>
<tr>
<td>@ASIN(X)</td>
<td>The arc sine of X.</td>
</tr>
<tr>
<td>@ATAN(X)</td>
<td>The 2-quadrant arc tangent of X.</td>
</tr>
<tr>
<td>@ATAN2(X, Y)</td>
<td>The 4-quadrant arc tangent of Y/X.</td>
</tr>
<tr>
<td>@CEIL(X)</td>
<td>The smallest integer greater than or equal to X.</td>
</tr>
<tr>
<td>@COS(X)</td>
<td>The cosine of X.</td>
</tr>
<tr>
<td>@COSH(X)</td>
<td>The hyperbolic cosine of X.</td>
</tr>
<tr>
<td>@DEGREES(X)</td>
<td>Converts the angle expressed in radians to degrees (°).</td>
</tr>
<tr>
<td>@DET(M)</td>
<td>The determinant of the matrix range M, which must be a square matrix.</td>
</tr>
<tr>
<td>@DOT(R1, R2)</td>
<td>The dot product of the vectors R1 and R2.</td>
</tr>
<tr>
<td>@EXP(X)</td>
<td>$e$ raised to the $X$ power.</td>
</tr>
<tr>
<td>@FACT(N)</td>
<td>The value of $N!$.</td>
</tr>
<tr>
<td>@FLOOR(X)</td>
<td>The largest integer less than or equal to X.</td>
</tr>
<tr>
<td>@FRAC(X)</td>
<td>The fractional portion of X.</td>
</tr>
<tr>
<td>@GAMMA(X)</td>
<td>The value of the gamma function evaluated at X.</td>
</tr>
<tr>
<td>@GRAND</td>
<td>A 12th-degree binomial approximation to a Gaussian random number with zero mean and unit variance.</td>
</tr>
<tr>
<td>@INT(X)</td>
<td>The integer portion of X.</td>
</tr>
<tr>
<td>@LN(X)</td>
<td>The natural log (base $e$) of X.</td>
</tr>
<tr>
<td>@LNGAMMA(X)</td>
<td>The log base $e$ of the gamma function evaluated at X.</td>
</tr>
</tbody>
</table>
### Mathematical functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@LOG(X)</td>
<td>The log base 10 of X.</td>
</tr>
<tr>
<td>@LOG10(X)</td>
<td>The log base 10 of X.</td>
</tr>
<tr>
<td>@LOG2(X)</td>
<td>The log base 2 of X.</td>
</tr>
<tr>
<td>@MOD(X, Y)</td>
<td>The remainder of X/Y.</td>
</tr>
<tr>
<td>@MODULUS(X, Y)</td>
<td>The modulus of X/Y.</td>
</tr>
<tr>
<td>@PI</td>
<td>The value of pi.</td>
</tr>
<tr>
<td>@POLY(X, ...)</td>
<td>The value of an Nth-degree polynomial in X.</td>
</tr>
<tr>
<td>@PRODUCT(X, ...)</td>
<td>The product of all the numeric values in the argument list.</td>
</tr>
<tr>
<td>@RADIANS(X)</td>
<td>Converts the angle expressed in degrees to radians ( ).</td>
</tr>
<tr>
<td>@RAND</td>
<td>A uniform random number on the interval (0,1).</td>
</tr>
<tr>
<td>@ROUND(X, n)</td>
<td>X rounded to n number of decimal places (0 to 15).</td>
</tr>
<tr>
<td>@SIGMOID(X)</td>
<td>The value of the sigmoid function.</td>
</tr>
<tr>
<td>@SIN(X)</td>
<td>The sine of X.</td>
</tr>
<tr>
<td>@SINH(X)</td>
<td>The hyperbolic sine of X.</td>
</tr>
<tr>
<td>@SQRT(X)</td>
<td>The positive square root of X.</td>
</tr>
<tr>
<td>@SUMPRODUCT(R1, R2)</td>
<td>The dot product of the vectors R1 and R2, where R1 and R2 are of equal dimension.</td>
</tr>
<tr>
<td>@TAN(X)</td>
<td>The tangent of X.</td>
</tr>
<tr>
<td>@TANH(X)</td>
<td>The hyperbolic tangent of X.</td>
</tr>
<tr>
<td>@TRANSPOSE(M)</td>
<td>The transpose of matrix M.</td>
</tr>
<tr>
<td>@VECLEN(...)</td>
<td>The square root of the sum of squares of its arguments.</td>
</tr>
</tbody>
</table>
## Statistical functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@AVG(...)</td>
<td>The average (arithmetic mean) of its arguments.</td>
</tr>
<tr>
<td>@CORR(R1, R2)</td>
<td>Pearson’s product-moment correlation coefficient for the paired data in ranges R1 and R2.</td>
</tr>
<tr>
<td>@COUNT(...)</td>
<td>A count of its non-blank arguments.</td>
</tr>
<tr>
<td>@F(M, N, F)</td>
<td>The integral of Snedecor’s F-distribution with M and N degrees of freedom from minus infinity to F.</td>
</tr>
<tr>
<td>@ERF(L[, U])</td>
<td>Error function integrated between 0 and L; if U specified, between L and U.</td>
</tr>
<tr>
<td>@ERFC(L)</td>
<td>Complementary error function integrated between L and infinity.</td>
</tr>
<tr>
<td>@FORECAST(...)</td>
<td>Predicted Y values for given X.</td>
</tr>
<tr>
<td>@FTEST(R1, R2)</td>
<td>The significance level ( ) of the two-sided F-test on the variances of the data specified by ranges R1 and R2.</td>
</tr>
<tr>
<td>@GMEAN(...)</td>
<td>The geometric mean of its arguments.</td>
</tr>
<tr>
<td>@HMEAN(...)</td>
<td>The harmonic mean of its arguments.</td>
</tr>
<tr>
<td>@LARGE(R, N)</td>
<td>The Nth largest value in range R.</td>
</tr>
<tr>
<td>@MAX(...)</td>
<td>The maximum of its arguments.</td>
</tr>
<tr>
<td>@MEDIAN(...)</td>
<td>The median (middle value) of the range R1.</td>
</tr>
<tr>
<td>@MIN(...)</td>
<td>The minimum of its arguments.</td>
</tr>
<tr>
<td>@MODE(...)</td>
<td>The mode or most frequently occurring value.</td>
</tr>
<tr>
<td>@MSQ(...)</td>
<td>The mean of the squares of its arguments.</td>
</tr>
<tr>
<td>@PERCENTILE(R, N)</td>
<td>The value from the range R that is at the Nth percentile in R.</td>
</tr>
</tbody>
</table>
### Statistical functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@PERCENTRANK(R, N)</td>
<td>The percentile rank of the number N among the values in range R.</td>
</tr>
<tr>
<td>@PERMUT(S, T)</td>
<td>The number of T objects that can be chosen from the set S, where order is significant.</td>
</tr>
<tr>
<td>@PTTEST(R1, R2)</td>
<td>The significance level (( \alpha )) of the two-sided T-test for the paired samples contained in ranges R1 and R2.</td>
</tr>
<tr>
<td>@QUARTILE(R, Q)</td>
<td>The quartile Q of the data in range R.</td>
</tr>
<tr>
<td>@RANK(E, R[, O])</td>
<td>The rank of a numeric argument E in the range R.</td>
</tr>
<tr>
<td>@SSQ(...)</td>
<td>The sum of squares of its arguments.</td>
</tr>
<tr>
<td>@RMS(...)</td>
<td>The root of the mean of squares of its arguments.</td>
</tr>
<tr>
<td>@SMALL(R, N)</td>
<td>The Nth smallest number in range R.</td>
</tr>
<tr>
<td>@SSE(...)</td>
<td>The sum squared error of its arguments. It is equivalent to @VAR(...) @COUNT(...).</td>
</tr>
<tr>
<td>@STD(...)</td>
<td>The population standard deviation (N weighting) of its arguments.</td>
</tr>
<tr>
<td>@STDS(...)</td>
<td>The sample standard deviation (N-1 weighting) of its arguments.</td>
</tr>
<tr>
<td>@SUM(...)</td>
<td>The sum of its arguments.</td>
</tr>
<tr>
<td>@T(N, T)</td>
<td>The integral of Student’s T-distribution with N degrees of freedom from minus infinity to T.</td>
</tr>
<tr>
<td>@TTEST(R, X)</td>
<td>The significance level of the two-sided single population T-test for the population samples contained in range R.</td>
</tr>
</tbody>
</table>
### Statistical functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@TTEST2EV(R1, R2)</td>
<td>The significance level (( \alpha )) of the two-sided dual population T-test for ranges R1 and R2, where the population variances are equal.</td>
</tr>
<tr>
<td>@TTEST2UV(R1, R2)</td>
<td>The significance level (( \alpha )) of the two-sided dual population T-test for ranges R1 and R2, where the population variances are not equal.</td>
</tr>
<tr>
<td>@VAR(...)</td>
<td>The sample variance (N weighting) of its arguments.</td>
</tr>
<tr>
<td>@VARS(...)</td>
<td>The sample variance (N-1 weighting) of its arguments.</td>
</tr>
<tr>
<td>@VSUM(...)</td>
<td>The visual sum of its arguments, using precision and rounding of formatted cell values.</td>
</tr>
</tbody>
</table>
## Conditional statistical functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@CAVG(...)</td>
<td>Conditional average.</td>
</tr>
<tr>
<td>@CCOUN(...)</td>
<td>Conditional count.</td>
</tr>
<tr>
<td>@CMAX(...)</td>
<td>Conditional maximum.</td>
</tr>
<tr>
<td>@CMIN(...)</td>
<td>Conditional minimum.</td>
</tr>
<tr>
<td>@CSTD(...)</td>
<td>Conditional sample standard deviation (N weighting).</td>
</tr>
<tr>
<td>@CSTDS(...)</td>
<td>Conditional sample standard deviation (N-1 weighting).</td>
</tr>
<tr>
<td>@CSUM(...)</td>
<td>Conditional sum.</td>
</tr>
<tr>
<td>@CVAR(...)</td>
<td>Conditional population variance (N weighting).</td>
</tr>
<tr>
<td>@CVARS(...)</td>
<td>Conditional population variance (N-1 weighting).</td>
</tr>
</tbody>
</table>
## String functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@CHAR(N)</td>
<td>The character represented by the code N.</td>
</tr>
<tr>
<td>@CLEAN(S)</td>
<td>The string formed by removing all non-printing characters from the string S.</td>
</tr>
<tr>
<td>@CODE(S)</td>
<td>The ASCII code for the first character in string S.</td>
</tr>
<tr>
<td>@EXACT(S1, S2)</td>
<td>Returns true (1) if string S1 exactly matches string S2, otherwise returns 0.</td>
</tr>
<tr>
<td>@FIND(S1, S2, N)</td>
<td>The index of the first occurrence of S1 in S2.</td>
</tr>
<tr>
<td>@HEXTONUM(S)</td>
<td>The numeric value for the hexadecimal interpretation of S.</td>
</tr>
<tr>
<td>@LEFT(S, N)</td>
<td>The string composed of the leftmost N characters of S.</td>
</tr>
<tr>
<td>@LENGTH(S)</td>
<td>The number of characters in S.</td>
</tr>
<tr>
<td>@LOWER(S)</td>
<td>S converted to lower case.</td>
</tr>
<tr>
<td>@MID(S, N1, N2)</td>
<td>The string of length N2 that starts at position N1 in S.</td>
</tr>
<tr>
<td>NUMTOHEX(X)</td>
<td>The hexadecimal representation of the integer portion of X.</td>
</tr>
<tr>
<td>@PROPER(S)</td>
<td>The string S with the first letter of each word capitalized.</td>
</tr>
<tr>
<td>@REGEX(S1, S2)</td>
<td>Returns true (1) if string S1 exactly matches string S2; otherwise returns false (0). Allows “wildcard” comparisons by interpreting S1 as a regular expression.</td>
</tr>
<tr>
<td>@REPEAT(S, N)</td>
<td>The string S repeated N times.</td>
</tr>
<tr>
<td>@REPLACE(S1, N1, N2, S2)</td>
<td>The string formed by replacing the N2 characters starting at position N1 in S1 with string S2.</td>
</tr>
<tr>
<td>@RIGHT(S, N)</td>
<td>The string composed of the rightmost N characters of S.</td>
</tr>
<tr>
<td>@STRING(...)</td>
<td>The concatenation of all its arguments.</td>
</tr>
<tr>
<td>@STRING(X, N)</td>
<td>The string representing the numeric value of X, to N decimal places.</td>
</tr>
</tbody>
</table>
## String functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@STRLEN(...)</td>
<td>The total length of all strings in its arguments.</td>
</tr>
<tr>
<td>@TRIM(S)</td>
<td>The string formed by removing spaces from the string S.</td>
</tr>
<tr>
<td>@UPPER(S)</td>
<td>The string S converted to upper case.</td>
</tr>
<tr>
<td>@VALUE(S)</td>
<td>The numeric value represented by the string S; otherwise 0 if S does not represent a number.</td>
</tr>
</tbody>
</table>
### Logic functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>@FALSE</td>
<td>The logical value 0.</td>
</tr>
<tr>
<td>@FILEEXISTS(S)</td>
<td>1 if file S can be opened for reading; otherwise 0.</td>
</tr>
<tr>
<td>@IF(X, T, F)</td>
<td>The value of T if X evaluates to 1, or F if X evaluates to 0.</td>
</tr>
<tr>
<td>@ISERROR(X)</td>
<td>Returns 1 if X “contains” an error, otherwise 0.</td>
</tr>
<tr>
<td>@ISNUMBER(X)</td>
<td>1 if X is a numeric value; otherwise 0.</td>
</tr>
<tr>
<td>@ISSTRING(X)</td>
<td>1 if X is a string value; otherwise 0.</td>
</tr>
<tr>
<td>@TRUE</td>
<td>The logical value 1.</td>
</tr>
<tr>
<td>@AND(...)</td>
<td>0 if any arguments are 0; 1 if all arguments are 1; otherwise -1.</td>
</tr>
<tr>
<td>@NAND(...)</td>
<td>0 if all arguments are 1; 1 if any arguments are 0; otherwise -1.</td>
</tr>
<tr>
<td>@NOR(...)</td>
<td>0 if any arguments are 1; 1 if all arguments are 0; otherwise -1.</td>
</tr>
<tr>
<td>@NOT(X)</td>
<td>0 if X=1; 1 if X=0; otherwise -1.</td>
</tr>
<tr>
<td>@OR(...)</td>
<td>0 if all arguments are 0; 1 if any arguments are 1; otherwise -1.</td>
</tr>
<tr>
<td>@XOR(...)</td>
<td>-1 if any of the arguments are not 0 or 1; otherwise 0 if the total number of arguments with the value 1 is even; 1 if the total number of arguments with the value 1 is odd.</td>
</tr>
</tbody>
</table>
## Financial functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@COUPDAYBS(S, M, F[, B])</td>
<td>The number of days between the beginning of the coupon period to the settlement date.</td>
</tr>
<tr>
<td>@ACCRINT(I, Ft, S, R, P, F[, B])</td>
<td>Accrued interest for a security that pays periodic interest.</td>
</tr>
<tr>
<td>@ACCRINTM(I, S, R, P[, B])</td>
<td>Accrued interest for a security that pays interest at maturity.</td>
</tr>
<tr>
<td>@COUPDAYS(S, M, F[, B])</td>
<td>The number of days in the coupon period that the settlement date is in.</td>
</tr>
<tr>
<td>@COUPDAYSNC(S, M, F[, B])</td>
<td>The number of days between the settlement date and the next coupon date.</td>
</tr>
<tr>
<td>@COUPNCD(S, M, F[, B])</td>
<td>The next coupon date after the settlement date.</td>
</tr>
<tr>
<td>@COUPNUM(S, M, F[, B])</td>
<td>The number of coupon payments between the settlement date and maturity date.</td>
</tr>
<tr>
<td>@COUPPCD(S, M, F[, B])</td>
<td>The previous (most recent) coupon date before the settlement date.</td>
</tr>
<tr>
<td>@CTERM(R, FV, PV)</td>
<td>The number of compounding periods for an investment.</td>
</tr>
<tr>
<td>@CUMIPMT(R, NP, PV, S, E, T)</td>
<td>The cumulative interest on a loan between start period S and end period E.</td>
</tr>
<tr>
<td>@CUMPRINC(R, NP, PV, S, E, T)</td>
<td>The cumulative principal paid on a loan between start period S and end period E.</td>
</tr>
<tr>
<td>@DB(C, S, L, P[, M])</td>
<td>Fixed-declining depreciation allowance.</td>
</tr>
<tr>
<td>@DDB(C, S, L, N)</td>
<td>Double-declining depreciation allowance.</td>
</tr>
<tr>
<td>@DISC(S, M, P, R[, B])</td>
<td>The discount rate for a security.</td>
</tr>
<tr>
<td>@DOLLARDE(FD, F)</td>
<td>Converts a dollar amount expressed as a fraction form into a decimal form.</td>
</tr>
</tbody>
</table>
### Financial functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>@DOLLARFR(DD, F)</code></td>
<td>Converts a dollar amount expressed as a decimal form into a fraction form.</td>
</tr>
<tr>
<td><code>@DURATION(S, M, R, Y, F[, B])</code></td>
<td>The Macaulay duration of a security assuming $100 face value.</td>
</tr>
<tr>
<td><code>@EFFECT(NR, NP)</code></td>
<td>Returns the effective annual interest rate.</td>
</tr>
<tr>
<td><code>@FV(P, R, N)</code></td>
<td>Future value of an annuity.</td>
</tr>
<tr>
<td><code>@FVSCHEDULE(P, S)</code></td>
<td>The future value of an initial investment after compounding a series of interest rates.</td>
</tr>
<tr>
<td><code>@INTRATE(S, M, I[, B])</code></td>
<td>The interest rate for a fully invested security.</td>
</tr>
<tr>
<td><code>@IPMT(R, P, NP, PV, FV[, T])</code></td>
<td>The interest payment for a specific period for an investment based on periodic, constant payments, and a constant interest rate.</td>
</tr>
<tr>
<td><code>@IRR(G, F)</code></td>
<td>The internal rate of return on an investment.</td>
</tr>
<tr>
<td><code>@MDURATION(S, M, R, Y, F[, B])</code></td>
<td>The modified Macaulay duration of a security assuming $100 face value.</td>
</tr>
<tr>
<td><code>@MIRR(CF, FR, RR)</code></td>
<td>The modified internal rate of return for a series of periodic cash flows.</td>
</tr>
<tr>
<td><code>@NOMINAL(ER, NP)</code></td>
<td>The nominal annual interest rate.</td>
</tr>
<tr>
<td><code>@ODDFPRICE(S, M, I, FC, R, Y, RD, F[, B])</code></td>
<td>The price per $100 face value of a security with an odd (short or long) first period.</td>
</tr>
<tr>
<td><code>@ODDFYIELD(S, M, I, FC, R, PR, RD, F[, B])</code></td>
<td>The yield per of a security with an odd (short or long) first period.</td>
</tr>
<tr>
<td><code>@PMT(PV, R, N)</code></td>
<td>The periodic payment for a loan.</td>
</tr>
<tr>
<td><code>@PPMT(R, P, NP, PV, FV, T)</code></td>
<td>The payment on the principal for a specific period for an investment based on periodic, constant payments, and a constant interest rate.</td>
</tr>
</tbody>
</table>
## Financial functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@PRICE(S, M, R, Y, RD, F[, B])</td>
<td>The price per $100 face value of a security that pays periodic interest.</td>
</tr>
<tr>
<td>@PRICEDISC(S, M, D, RD[, B])</td>
<td>The price per $100 face value of a discounted security.</td>
</tr>
<tr>
<td>@PRICEMAT(S, M, I, R, Y[, B])</td>
<td>The price per $100 face value of a security that pays interest at maturity.</td>
</tr>
<tr>
<td>@PV(P, R, N)</td>
<td>The present value of an annuity</td>
</tr>
<tr>
<td>@RATE(FV, PV, N)</td>
<td>The interest rate required to reach future value FV.</td>
</tr>
<tr>
<td>@RECEIVED(S, M, I, D[, , B])</td>
<td>The amount received at maturity for a fully vested security.</td>
</tr>
<tr>
<td>@SLN(C, S, L)</td>
<td>The straight-line depreciation allowance.</td>
</tr>
<tr>
<td>@SYD(C, S, L, N)</td>
<td>The “sum-of-years-digits” depreciation allowance.</td>
</tr>
<tr>
<td>@TBILLEQ(S, M, D)</td>
<td>The bond-equivalent yield (BEY) for a Treasury Bill.</td>
</tr>
<tr>
<td>@TBILLYIELD(S, M, D)</td>
<td>The yield on a Treasury bill.</td>
</tr>
<tr>
<td>@TERM(P, R, FV)</td>
<td>The number of payment periods for an investment.</td>
</tr>
<tr>
<td>@VDB(C, S, L, S, E)</td>
<td>Fixed-declining depreciation allowance between two periods.</td>
</tr>
<tr>
<td>@XIRR(G, V, D)</td>
<td>Internal rate of return for a series of cash flows with variable intervals.</td>
</tr>
<tr>
<td>@XNPV(R, V, D)</td>
<td>Returns the net present value for a series of cash flows with variable intervals.</td>
</tr>
<tr>
<td>@YIELD(S, M, R, PR, RD, F[, B])</td>
<td>Yield of a security that pays periodic interest.</td>
</tr>
<tr>
<td>@YIELDMAT(S, M, I, R, PR[, , B])</td>
<td>Annual yield of a security which pays interest at maturity.</td>
</tr>
</tbody>
</table>
## Date and time functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@DATE(Y, M, D)</td>
<td>The date value for year Y, month M, and day D.</td>
</tr>
<tr>
<td>@DATEVALUE(S)</td>
<td>The corresponding date value for a given string S.</td>
</tr>
<tr>
<td>@DAYS360(S, E)</td>
<td>The number of days between two dates, based on a 30/360 day count system.</td>
</tr>
<tr>
<td>@DAY(DT)</td>
<td>The day number in the date/time value DT.</td>
</tr>
<tr>
<td>@EDATE(S, M)</td>
<td>The date/time value representing number of months (M) before or after start (S).</td>
</tr>
<tr>
<td>@EOMONTH(S, M)</td>
<td>The date/time value representing the last day of the month M months after S, if M is positive, or M months before if M is negative.</td>
</tr>
<tr>
<td>@HOUR(DT)</td>
<td>The hour value (0-23) of date/time value DT.</td>
</tr>
<tr>
<td>@MINUTE(DT)</td>
<td>The minute value (0-59) of date/time value DT.</td>
</tr>
<tr>
<td>@MONTH(DT)</td>
<td>The number of the month in date/time value DT.</td>
</tr>
<tr>
<td>@NETWORKDAYS(S, E[, H])</td>
<td>The number of whole working days, starting at S and going to E, excluding weekends and holidays.</td>
</tr>
<tr>
<td>@NOW</td>
<td>The date/time value of the current system date and time.</td>
</tr>
<tr>
<td>@SECOND(DT)</td>
<td>The seconds value (0-59) of the date/time value DT.</td>
</tr>
<tr>
<td>@TIME(H, M, S)</td>
<td>The time value for hour H, minute M, and second S.</td>
</tr>
<tr>
<td>@TIMEVALUE(S)</td>
<td>The corresponding time value for a given string value S.</td>
</tr>
<tr>
<td>@TODAY</td>
<td>The date value of the current system date.</td>
</tr>
<tr>
<td>@WEEKDAY(D)</td>
<td>The integer representing the day of the week on which the day D falls. 1 is Sunday, 7 is Saturday.</td>
</tr>
</tbody>
</table>
### Date and time functions continued

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@WORKDAY(S, D[, H])</td>
<td>The day that is D working days after S, if D is positive, or before S, if D is negative, excluding weekends and all holidays specified as dates in range H.</td>
</tr>
<tr>
<td>@YEAR(DT)</td>
<td>The year value of date/time value DT.</td>
</tr>
<tr>
<td>@YEARFRAC(S, E[, B])</td>
<td>The portion of the year represented by the number of days between start date (S) and end date (E).</td>
</tr>
<tr>
<td>Function</td>
<td>Purpose</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@CELLREF(N1, N2)</td>
<td>A reference to the cell in column N1 and row N2.</td>
</tr>
<tr>
<td>@CHOOSE(N, ...)</td>
<td>The Nth argument from the list.</td>
</tr>
<tr>
<td>@COL(C)</td>
<td>The column address of the cell referenced by C.</td>
</tr>
<tr>
<td>@COLS(R)</td>
<td>The number of columns in the specified range R.</td>
</tr>
<tr>
<td>@HLOOKUP(X, S, R)</td>
<td>The value of the cell in range S that is R number of rows beneath X.</td>
</tr>
<tr>
<td>@INIT(X1, X2)</td>
<td>The first argument on the first recalculation pass and the second argument on all subsequent recalculation passes when Objective Grid is performing iterative calculations.</td>
</tr>
<tr>
<td>@INTERP2D(R1, R2, N)</td>
<td>The interpolation value for a 2-dimensional vector.</td>
</tr>
<tr>
<td>@INTERP3D(R, X, Y)</td>
<td>The interpolation value for a 3-dimensional vector.</td>
</tr>
<tr>
<td>@MATCH(V, R[, T])</td>
<td>The relative position in range R of value V based on positioning criteria T.</td>
</tr>
<tr>
<td>@N(R)</td>
<td>The numeric value of the top left cell in range R.</td>
</tr>
<tr>
<td>@RANGEREF(N1, N2, N3, N4)</td>
<td>A reference to the range defined by coordinates N1 through N4.</td>
</tr>
<tr>
<td>@ROW(C)</td>
<td>The row address of the cell referenced by C.</td>
</tr>
<tr>
<td>@ROWS(R)</td>
<td>The number of rows in the specified range R.</td>
</tr>
<tr>
<td>@S(R)</td>
<td>The string value of the top left cell in range R.</td>
</tr>
<tr>
<td>@SHEET(S, C)</td>
<td>The value in the cell located on the sheet and cell referenced by S and C.</td>
</tr>
<tr>
<td>@VLOOKUP(X, S, C)</td>
<td>The value of the cell in range S that is C number of columns to the right of X.</td>
</tr>
</tbody>
</table>
Glossary of terms
Glossary of terms

**Centric Project Server**

Centric Project Server dynamically manages project workspaces. Centric Project Server Administration manages the Centric Project Server.

**Centric Project Server Administration**

Runs in the Microsoft Management Console (MMC) and allows you to administer Centric Project Server. The Centric Project Server “snap-in” is an individual component of the Microsoft Management Console (MMC) that is loaded into the console as a tool to help you administer Centric Project Server and ProjectAreas.

**Activity**

See *Tracked Activity*.

**Assistant**

A project user who acts on behalf of the Project Manager. Assistants can do everything that the Project Manager can do; however, they must be project Authors to add, remove, or move states in the project process.

**Authentication**

The process of verifying the identity of a user.

**Author**

A project user who can edit the layout of a project workspace by adding and removing tabs, Project Elements, and Dashboard features. Authors have access to all information and features in a project workspace.
Browser
Software running on a client machine that interprets HTML files posted on the World Wide Web, formats them into Web pages, and displays them to the user.

Business Unit
The lowest level business entity in your corporation that you want to refer to for report analysis and resource management. Each project in the ProjectArea can be associated with a Business Unit. Each portfolio must be associated with a Business Unit.

Charter
An online document that captures key information required for a project proposal, such as project goals and objectives, strategic alignment, resources required, proposed time line, and critical risks. The charter can be linked to (and updated by) project information. If the project has a process, the charter can also be linked to the process.

Client computer
A computer that is connected to a server to send and receive information. It is equivalent to the user’s computer or PC.

Decision Criterion
Process definitions that are applied to Decision Points. Decision Criteria often take the form of Yes/No questions that the Project Manager and Decision Makers must answer at each Decision Point before the project can proceed to the next state in the process.

Decision Maker
A project user who helps decide whether a process should continue at each Decision Point in the process. Each Decision Point can have a different set of Decision Makers.

Decision Point
Points of formal review in a gated process where the Deliverables of the previous Work Period are evaluated and the overall merits of the project are re-assessed to determine whether the project should
continue as planned. Decision Points are also called project “Reviews,” or “Gates.”

**Definition**

A customizable variable that is used to record data during in the project. Definitions allow you to create standard variables that can be used in templates and projects throughout the ProjectArea. You can create four types of definitions: Parameters, User Fields, Metrics (Centric Process only), and Decision Criteria (Centric Process only).

**Deliverable**

The top-level task in a gated process. Each Work Period typically contains two to eight Deliverables. Deliverables are often the responsibility of a discipline lead, like an engineering or manufacturing manager. This person is called the responsible user. The responsible user is responsible for updating the Deliverable status and attaching any supporting documents or information to the Deliverable.

**Demand (resource)**

The amount of a resource that is needed for a particular project. Project Managers and Assistants enter the resource demand their projects require per planning period. For example, a project may require the equivalent of 5 Senior Engineer resources for one month and 6 for the next.

**Host**

A computer that is attached to a network or the Internet. Hosts allow users on client machines to connect and share files or transfer information. Individual users communicate with hosts by using client application programs.

**Information Item**

A file that a project Author, tab Editor, or Publisher publishes, views, and maintains with the Centric Project project workspace. Information Items can be documents, links to web pages, CAD drawings, pictures, video files, sound files, or any other data files that are published to the workspace.
Linked process

A project process (or process template) that is linked to a project charter (or charter template). When a process is linked to a charter, the charter can have cells that are mapped to information in the process (for example, Metrics, Project Manager name, and process estimated and actual dates). When a process template is linked to a charter template, the linked process can also be automatically added to a project when the charter is added to the project.

Location

A physical place that has a supply of resources with an associated cost. Each location can be associated with a Business Unit. Each Business Unit/location can have resource supply and demand information associated with it.

Mapped information

Project information that is linked to a project charter (or ProjectArea information that is linked to a charter template). When project information is mapped to a charter, changes in that project information are automatically reflected in the charter. In addition, users with Reviewer or higher access can update mapped project information directly from within the charter.

Metric

A definition whose value is typically set and updated during a project process at designated Work Periods and Decision Points. Examples of Metrics include “Estimated Commercial Value,” “Cost to Complete,” and “Probability of Technical Success.” Each of these Metrics measures some aspect of the entire project rather than a technical characteristic of the product.

Network

A computer network is a data communications system that interconnects computer systems at various different sites.
Ownership

When you publish an Information Item to the project workspace, you become its owner. If you own an Information Item, you can republish it, edit its properties, transfer it to a new owner, remove it, or move it.

Parameter

Pieces of information about a project that need to be shared by members of a project. For example, you can use Parameters to communicate the most recent price for a part, the earliest possible date for delivery of a part, or the maximum building height. Project Parameters are added, viewed, and maintained on the Parameters page of a project's Dashboard tab.

Portfolio

A group of projects for the purpose of analysis and decision-making. Portfolios typically represent groups of projects that have profit/loss accountability. For example, all the projects in a Business Unit or division might be put in the same portfolio. You may also group together projects that are related by their resource demand requirements. You can then manage the projects within the portfolio to determine the best sequencing of the projects, and the most effective usage of the resources supplied by the portfolio.

Project Administration

 Allows project Authors to manage project-wide properties and settings. With Project Administration, Authors can specify project properties (for example, the project’s description), select the color scheme that the project uses, specify which users have access to the project, subscribe users and groups to project information, and select the access permissions for project users.

Project category

Allows project Authors to identify and group together projects that are related in some way. Project categories can be used when creating portfolio reports to select which types of projects should be included in the reports. For example, you may create a category called "Market Region" and, within that category, specify values such as "North America," "Europe," and "South America". With Centric Portfolio, you
can then define a report that includes only those projects that have been assigned a Market Region category value of "South America".

**Project Element**

An area in a project workspace where you can organize, publish, and view the project’s Information Items. Each standard tab in a project can have one or more Project Elements.

**Project workspace**

An interface that gives project users access to all project-related information in a single place. The project workspace centralizes project information, provides structure for managing that information, and allows users to easily share that information with other project users both inside and outside your organization. In the project workspace, project users can view documents, add comments and markups to documents, send e-mail communications to project users, and track progress on project activities.

**ProjectArea**

A "container" of data managed by Centric Project Server. A server can have one or more ProjectAreas. Each ProjectArea can contain one or more project workspaces. Each ProjectArea is a separate subset of the server and does not communicate, share data, or share users with other ProjectAreas.

**ProjectArea Administration**

Gives ProjectArea Administrators the ability to manage ProjectArea-wide information, such as user and group accounts, color schemes, license allocations, and other settings.

**Publisher**

A project user who can publish an Information Item to a project tab and then modify or remove it.

**Publishing**

The process of adding files (Information Items) to a project workspace. Published Information Items are available to all team members. Project users can view, download, markup, and comment on it using a browser.
(given the appropriate level of access to the tab on which the information is published).

**Resource**

A combination of a resource type, a resource category, and a Business Unit/location pair for which supply and demand information can be entered. For example, a Senior Engineer resource might have a resource type of “Human”, a resource category of “Development” and a Business Unit/location of “Consumer Products/Chicago”.

**Resource category**

Allows you to group resource types together so that project users can generate reports across sets of resources. For example, executives can generate portfolio reports that show demand versus supply for all resources in the “Manufacturing” resource category.

**Resource summary**

A special mapped data function that automatically calculates aggregate values for resource demand information that meets specific criteria for the whole project or a specific span of planning periods. After a resource summary has been created, you can map a charter cell to it so that the cell displays the resource summary’ calculated value in aggregate units or aggregate cost (if unit cost is available for the resource type selected in the summary).

**Resource type**

Defines how resources are planned and allocated on projects. Resource types describe very general classifications of resources. They also specify the units for the resource (for example, FTE, $, or Gallons) and whether or not there is an associated cost per unit for the resource definitions assigned to the type. For example, you may define a resource type of “Human”, which has a unit of “FTEs” and has an associated cost per unit (cost per FTE).

**Resource unit**

A simple text string that describe the units for a resource type. For example, you could declare “mm” or “km” as units. You could also allocate resource salary expenses in thousands of dollars and use a unit of “K” on a currency resource type.
Reviewer

A project user who can view Information Items on a tab and can add comments and markups to the Information Item.

Server computer

A computer that is accessed from multiple clients and runs server software.

Snapshot

A saved version of the project charter that preserves the values in the charter as they were at the time the snapshot was created. Project users with Viewer or higher access to the charter can select to view and print any snapshot version.

Standard planning unit

Defines the minimum time span for which you want to allocate supply and demand for your resources. For example, a standard planning unit could be days, weeks, months, quarters, or years.

State

A point (or step) in a project process at which new work begins. Each Work Period and Decision Point in the process is a state, as are the Start and End points of the process. To move from state to state, the Project Manager makes process transitions.

Strategic Metric

Defines the quantitative measures of a portfolio. Each portfolio can have one or more Strategic Metrics. Strategic Metrics are based on the same Metric definitions that are created for a ProjectArea and can be used in a project processes. For each Strategic Metric, you can define a target value, rank, category, and critical flag.

Strategic Objective

A text statement that defines an objective of a portfolio and that gives you a qualitative way to define the portfolio. For example, “Increase customer loyalty,” Lower engineering attrition,” and “Penetrate key international markets” are all possible Strategic Objectives.
Subscribing

When you subscribe to project information (for example, a Project Element, an Information Item, or a Parameter), you receive an e-mail notification when the information is changed. For example, if you are subscribed to a Project Element, you are notified when new Information Items are published to the Project Element. If you are published to an Information Item, you are notified when the Information Item is republished, transferred, or removed.

Supply (resource)

The amount of a resource that is available for the ProjectArea for each planning unit. For example, you may have the equivalent of 10 Senior Engineer resources available for one month and 15 for the next. Resources that have an associated cost per unit allow you to specify a cost per unit in addition to the supply amount.

Tab

A page in the project window that is used to structure a project. The project tabs contain the information for the project, including Project Elements, Information Items, Activity Log pages, a Project Calendar, or other features that you add to the project.

Template (Activity, process, charter)

Templates provide a way for your company to standardize Tracked Activities, project process execution methodologies, and project charters by allowing you to create one or more standard templates that can be used in any project in your company. Although project Authors can create their own Activities, processes, and charters in their projects, creating and using ProjectArea templates encourages standardization of project information, makes it easier to create reports across multiple projects, and makes it easier to change current standard processes for future projects.

Tracked Activity (Activity)

Also called an Activity. Customized online forms that allow project users to request and communicate information about a project. You can use Activities as a special type of e-mail message to communicate information about your project to all interested project users. You can
also use Activities to define and enforce a formal process for completing a particular task or project.

Transition

The Project Manager (or Assistant) uses transitions to move from one state to the next in a project process. For example, to start a process, the Process Manager makes a Proceed transition from the process Start to the process’ first Work Period or Decision Point.

User Field

A definition that can be added to Tracked Activity definitions, project’s status report definitions, or Word Periods and Deliverables in a project process. User Fields allow project users to enter and view additional information about an Activity, status report, Work Period, or Deliverable. For example, a User Field might contain status information, price information, a date, or a description.

Viewer

A project user who can view or download an Information on the tab but cannot perform any other actions with the Information Item.

Work Period

A state in a project process during which one or more Deliverables must be completed. Work Periods are used to organize Deliverables into a logical sequence of work. Work Periods are also called project “Steps,” “Phases,” or “Stages.”

Web conference

Allows you to collaborate with other project users through an online conference that includes real-time viewing and shared commenting and markup of project information. With Centric Project, you can use WebEx to host and participate in web conferences.

WebEx

An online application that provides web conferencing support for the RealTime Review module. To host a web conference with WebEx, you need to create or link to a WebEx account.
Index
Index

A
Activities, 17
  creating from a project workspace, 68
  responding to, 69
  updating, 69
Add File command, 60
Add-in for Microsoft Office, 30
Add-in for Microsoft Outlook, 30
Add-in for Microsoft Project, 30
Administrators, Centric Project, 115
Assistants, project, 114
Authors, 23
Authors, project, 23

B
browsers
  checking version of, 27
  configuring, 28–29
  supported, 27
Business Unit/location pairs, 124
Business Units, 124, 178
  associating with locations, 139
  creating, 179
  specifying term for, 138

C
calendar
  viewing, 75
categories, resource, 128
Centric Charter, 10, 194
  benefits of, 198
  built-in functions for, 243
  concepts, 202
Excel spreadsheet capabilities and restrictions in, 239
hardware and software requirements for, 212
integration with other modules, 197
permissions, 209
who uses, 201
Centric Portfolio, 10, 156
  benefits of, 163
  hardware and software requirements for, 166
  who uses, 165
Centric Process, 9, 80
  benefits of, 82
  configuring, 96
  hardware and software requirements for, 84
  who uses, 83
Centric Product, 8
Centric Project, 8
Centric Resource, 9, 120
  benefits of, 121
  concepts, 124
  hardware and software requirements for, 135
  who uses, 123
chart interface, 202
Chart Template window, 216
chart templates, 206
creating, 218
editing, 219
formatting cells in, 225
formulas in, 223
linking to process templates, 227
mapping cells in, 224
saving changes in, 225
text in, 221
worksheets, 220
Charter window, 216
docking, 234
undocking, 234
charters, 204
adding to projects, 230
built-in functions for, 243
  cell properties and formatting in, 241
design guidelines for, 211
mapped data in, 202
printing, 236
resource summaries in, 203
snapshots, 207
viewing, 233
viewing snapshots, 235
viewing versions of, 235
commands, Centric Process, 106
comments, 18
adding and replying to, 63
viewing, 63
conditional statistical charter functions, 249
Configure for Web Conference link, 31
configuring
browsers, 28–29
Internet Explorer, 28
Microsoft Outlook, 29
resource standards, 138
Contributors, Deliverable, 115
Cross-Project Analytics, 9
Crystal Reports, 176

D
Dashboard tab, adding Process feature to, 102
date and time charter functions, 256
dates, setting estimated process, 107
Decision Criteria, 92
creating, 98
Decision Criteria lock, 101
Decision Makers, 114
Decision Points, 92
selecting, 105
definitions, creating process, 98
Deliverables, 91
assigning and tracking, 108
Contributors for, 115
due dates for, 108
Responsible Users for, 115
Deliverables lock, 101
demand, resource, 130
docking and undocking the Charter window, 234
Drop Box, publishing with, 58

E
Editors, 22

e-mail, configuring to send with
Microsoft Outlook, 29
End, process, 109
ePrint, 31
estimated dates, process, 107
Excel spreadsheets
capabilities and restrictions in Centric Charter, 239
importing into Centric Charter, 220
exiting from projects, 42
exporting portfolio reports, 188, 189
resources, 149
Extensions for Windows Explorer, 30

F
Favorite Projects list, 51
File Drop Box. See Drop Box
filters, report, 175
financial charter functions, 253
formatting charter cells, 225
formulas charter, 204
in charter templates, 223
functions, charter, 243
conditional statistical, 249
date and time, 256
financial, 253
logic, 252
mathematical, 244
miscellaneous, 258
statistical, 246
string, 250

G
gated process, 80
components of, 90
design guidelines, 88
example of, 81
planning the design for, 88

H
hardware requirements, 84, 135, 166, 212
Hold transition, 112
Centric Portfolio, 183
Centric Process, 104, 114
Information Item, 22
Parameter, 23
portfolio Managers, 183
Portfolio Planning, 10, 156
benefits of, 164
hardware and software requirements for, 166
portfolio reports
components of, 172
creating, 184
defining, 184
defining, 158
exporting, 188, 189
importing, 188, 189, 190
planning, 170
private, 185
public, 184
portfolio Viewers, 183
portfolios, 157
and Business Units, 178
creating, 178, 180
creating Strategic Objectives for, 181
giving users access to, 183
selecting projects for, 180
selecting Strategic Metrics for, 182
private reports, 185
Proceed transition, 111
process
permissions and roles for, 114
process dates, setting estimated, 107
Process feature, adding, 102
process flow diagram, 105
selecting in, 105
Process Journal, 110
Process lock, 101
process templates, 90
creating, 99
linking to charter templates, 207, 227
locks, 100
process viewers, 115
processes
adding to projects, 102
configurable terms for, 97
creating definitions for, 98
running, 105–9
schedules for, 116
setting user permissions for, 104
transitions for, 111
product portfolios, 157
project calendar, viewing, 75
Project Elements, 16
Project Managers, 114
project permissions, 22
project toolbar, 44
project workspace window, 43
project workspaces
creating Activities from, 68
defined, 16
exiting from, 42
logging in to, 34
users of, 115
ProjectAreas
exiting from, 42
projects
adding a charter to, 230
creating Favorite list of, 51
navigating in, 45
selecting for portfolios, 180
selecting resources for, 146
public reports, 184
Publishers
Information Item, 22
Parameter, 23
publishing Information Items, 20, 58, 60
R
Recycle transition, 112
Reviewers
Information Item, 22
Parameter, 23
report filters, 175
reports. See portfolio reports
resource categories, 128
defining, 142
resource demand, 130
defining, 147
resource standards, configuring, 138
resource summaries, 205
resource supply, 130
defining, 144
resource types, 127
defining, 141
resource units, 128
resource value types, 128
resources, 129
analyzing, 131
creating, 143
exporting, 149
importing, 150
selecting for a project, 146
Responsible Users, 115
Resume transition, 113
roles, Centric Process, 114

S
saving charter changes, 225
schedules, process, 116
Search, 40
searching for Information Items, 65
Skip transition, 112
snapshots, charter, 207
viewing, 235
software requirements, 84, 135, 166, 212
standard planning unit, 126
defining, 141
Start, process, 105
states, process. See Work Periods or Decision Points
statistical charter functions, 246
Strategic Metrics, selecting for portfolios, 182
Strategic Objectives, creating, 181
string charter functions, 250
styles, report, 172
subscribing to project information, 20
supply, resource, 130

T
tabs
My Dashboard, 40
templates, charter
creating, 218
editing, 219
formatting cells in, 225
formulas in, 223
linking to process templates, 227
mapping cells in in, 224
saving changes in, 225
text in, 221
templates, process, 90
creating, 99
terminology, specifying for processes, 97
text, in charter templates, 221
toolbars
My Dashboard, 39
project, 44
tab scroll, 44
Tracked Activities. See Activities transitions, process, 111
types, report, 172

U
units, resource, 128
URL, using to log in to project workspaces, 36
User Fields, 91
creating, 98
user information, viewing or editing, 49
user preferences, setting, 48
User Tools, 30
installing, 31
users
giving access to portfolios, 183
setting process permissions for, 104

V
value types, resource, 128
variables, report, 172
View Process permission, 104
Viewers
Information Item, 22
Parameter, 23
portfolio, 183
process, 115
viewing Information Items, 55

W
web conferencing, link to configure for, 31
web templates, 103
Windows Explorer, Extensions for, 30
Work Periods, 90
selecting, 105
setting estimated dates for, 107
worksheets, charter template, 220
workspaces. See project workspaces